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WARRANTY DISCLAIMER

This Documentation and the Sterling Commerce Software it describes are licensed either 
"AS IS" or with a limited warranty, as set forth in the Sterling Commerce license 
agreement. Other than any limited warranties provided, NO OTHER WARRANTY IS 
EXPRESSED AND NONE SHALL BE IMPLIED, INCLUDING THE WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR USE OR FOR A PARTICULAR PURPOSE. Without 
limitation to the foregoing, Sterling Commerce does not warrant or represent that use of 
this software will ensure compliance with the U.S. Department of Transportation's (DOT) 
Hazardous Materials Regulations (HMR) found in Title 49 of the Code of Federal Regulations 
(49 CFR) or any other legal requirements, and users of this software should consult 
independent legal counsel and technical support to ensure compliance with the HMR and 
other legal requirements. The applicable Sterling Commerce entity reserves the right to 
revise this publication from time to time and to make changes in the content hereof without 
the obligation to notify any person or entity of such revisions or changes.

These terms of use shall be governed by the laws of the state of Ohio, USA, without regard 
to its conflict of laws provisions. If you are accessing the Sterling Commerce Software 
under an executed agreement, then nothing in these terms and conditions supersedes or 
modifies the executed agreement.

Third-Party Materials

Third-Party Links

The Sterling Commerce Software may include links or references to internet web sites and 
resources operated or offered by third parties. Such links are provided to facilitate your 
acquisition of third-party software products or services which may enable or otherwise 
enhance your use of the Sterling Commerce Software. Sterling Commerce makes no 
representations, warranties, or other commitments whatsoever about any such web sites or 
third-party resources. You are solely responsible for any transaction, download, installation 
and use of any software product or services made available via such third-party web sites 
or resources, and for compliance with any and all terms applicable to such third-party 
software products or services. Accordingly, Sterling Commerce is not responsible for the 
availability of such third-party web sites or resources, and is not responsible for any use of, 
or reliance on, any such content, products, services, or other materials on, or available 
through, such web sites or resources.

Third-Party Software

The Sterling Commerce Software may be distributed with or otherwise rely upon other 
Sterling Commerce software which may be distributed on the same storage media with 
products, ("Third-Party Software") offered by third parties ("Third-Party Licensors").   
Third-Party Software information for such additional components of the Sterling Commerce 
Software is located at: <INSTALL_DIR>/ReadMe.htm
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Preface

This manual describes the reports that can be generated using the 
Sterling Warehouse Management System.

Intended Audience
This manual provides information for warehouse managers who are 
responsible for tracking inventory, inbound, outbound, and other 
operations in the warehouse, using the Sterling Warehouse Management 
System.

Structure
This document contains the following chapters:

Chapter 1, "Introduction"
This chapter introduces the reports provided with Sterling Warehouse 
Management System.

Chapter 2, "Inbound Reports"
This chapter explains the inbound reports provided with Sterling 
Warehouse Management System.

Chapter 3, "Returns Reports"
This chapter explains the returns reports provided with Sterling 
Warehouse Management System.
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Chapter 4, "Inventory Reports"
This chapter explains the inventory reports provided with Sterling 
Warehouse Management System.

Chapter 5, "VAS Reports"

This chapter explains the Value Added Services (VAS) reports provided 
with Sterling Warehouse Management System.

Chapter 6, "  Outbound Reports"

This chapter explains the outbound reports provided with Sterling 
Warehouse Management System.

Chapter 7, "Task Reports"

This chapter explains the task reports provided with Sterling Warehouse 
Management System.

Chapter 8, "Billing Activity Reporting Engine Reports"

This chapter explains the billing activity reports generated using Sterling 
Warehouse Management System

Appendix A, "Sterling Warehouse Management System Report 
Samples"
This appendix provides samples of the various reports that can be 
generated using Sterling Warehouse Management System.

Appendix B, "Using Report Studio"
This appendix provides information for using the Cognos Report Studio, 
utilizing Sterling Warehouse Management System reports and 
customizing those reports for your application.

Documentation
For more information about the Sterling Warehouse Management 
SystemTM components, see the following manuals:

Sterling Warehouse Management System: Release Notes

Sterling Warehouse Management System: Installation Guide

Sterling Warehouse Management System: Overview

Sterling Warehouse Management System: Implementation Guide



   xxix

Sterling Warehouse Management System: Reports Guide

Sterling Warehouse Management System: Business Intelligence 
Guide

Sterling Warehouse Management System: Printed Documents Guide

Sterling Warehouse Management System: Billing Activity Reporting 
Engine Guide

Sterling Warehouse Management System: Upgrade Guide

Sterling Warehouse Management System: Voxware Integration Guide

Sterling Warehouse Management System: Javadocs 

For more information about the Selling and Fulfillment Foundation 
components, see the following manuals:

Selling and Fulfillment Foundation: Release Notes

Selling and Fulfillment Foundation: Installation Guide

Selling and Fulfillment Foundation: Upgrade Guide

Selling and Fulfillment Foundation: Configuration Deployment Tool 
Guide

Selling and Fulfillment Foundation: Performance Management Guide

Selling and Fulfillment Foundation: High Availability Guide

Selling and Fulfillment Foundation: System Management Guide

Selling and Fulfillment Foundation: Localization Guide

Selling and Fulfillment Foundation: Customization Basics Guide

Selling and Fulfillment Foundation: Customizing APIs Guide

Selling and Fulfillment Foundation: Customizing Console JSP Interface 
for End User Guide

Selling and Fulfillment Foundation: Customizing the RCP Interface 
Guide

Selling and Fulfillment Foundation: Customizing User Interfaces for 
Mobile Devices Guide

Selling and Fulfillment Foundation: Customizing Web UI Framework 
Guide
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Selling and Fulfillment Foundation: Customizing Swing Interface 
Guide

Selling and Fulfillment Foundation: Extending the Condition Builder 
Guide

Selling and Fulfillment Foundation: Extending the Database Guide

Selling and Fulfillment Foundation: Extending Transactions Guide

Selling and Fulfillment Foundation: Using Sterling RCP Extensibility 
Tool Guide

Selling and Fulfillment Foundation: Integration Guide

Selling and Fulfillment Foundation: Product Concepts Guide

Sterling Warehouse ManagementTM System: Concepts Guide

Selling and Fulfillment Foundation: Application Platform Configuration 
Guide

Sterling Distributed Order ManagementTM: Configuration Guide

Sterling Supply Collaboration: Configuration Guide

Sterling Global Inventory VisibilityTM: Configuration Guide

Sterling Catalog ManagementTM: Configuration Guide

Sterling Logistics Management: Configuration Guide

Sterling Reverse LogisticsTM: Configuration Guide

Sterling Warehouse Management System: Configuration Guide

Selling and Fulfillment Foundation: Application Platform User Guide

Sterling Distributed Order Management: User Guide

Sterling Supply Collaboration: User Guide

Sterling Global Inventory Visibility: User Guide

Sterling Logistics Management: User Guide

Sterling Reverse Logistics: User Guide

Sterling Warehouse Management System: User Guide

Selling and Fulfillment Foundation: Mobile Application User Guide

Selling and Fulfillment Foundation: Business Intelligence Guide
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Selling and Fulfillment Foundation: Javadocs

Sterling Selling and Fulfillment Suite: Glossary

Parcel Carrier: Adapter Guide

Selling and Fulfillment Foundation: Multitenant Enterprise Guide

Selling and Fulfillment Foundation: Password Policy Management 
Guide

Selling and Fulfillment Foundation: Properties Guide

Selling and Fulfillment Foundation: Item Concepts Guide

Selling and Fulfillment Foundation: Pricing Concepts Guide

Business Center: Item Administration Guide

Business Center: Pricing Administration Guide

Business Center: Customization Guide

Business Center: Localization Guide

Conventions
The following conventions may be used in this manual:

Convention Meaning

. . . Ellipsis represents information that has been 
omitted.

< > Angle brackets indicate user-supplied input.

mono-spaced text Mono-spaced text indicates a file name, directory 
path, attribute name, or an inline code example or 
command.

/ or \ Slashes and backslashes are file separators for the 
Windows, UNIX, and LINUX operating systems. The 
file separator for the Windows operating system is 
"\" and the file separator for UNIX and Linux systems 
is "/". The UNIX convention is used unless otherwise 
mentioned.

<YANTRA_HOME_OLD> User-supplied location of the  installation directory 
for previously installed releases. This is only 
applicable for Releases 7.7, 7.9, and 7.11.
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Note: The Selling and Fulfillment Foundation documentation set uses the 
following conventions in the context of the product name:

Yantra is used for Release 7.7 and earlier.

Sterling Supply Chain Applications is used for Releases 7.9 and 7.11.

Sterling Multi-Channel Fulfillment Solution is used for Releases 8.0 
and 8.2.

Selling and Fulfillment Foundation for Release 8.5.

<YFS_HOME_OLD> This is the <YANTRA_HOME>/Runtime directory of 
previously installed releases. This is only applicable 
for Releases 7.7, 7.9, and 7.11.

<INSTALL_DIR> User-supplied location of the Selling and Fulfillment 
Foundation installation directory. This is applicable 
for Release 8.0.

Convention Meaning
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1
Introduction

The Sterling Warehouse Management System helps you manage 
operations in mid-sized Finished Goods distribution centers (DCs). 
Shipments may be shipped to consumers, retailers or distributors, or 
mom- and pop- stores.

To aid warehouse managers who are responsible for tracking inventory, 
and inbound, outbound, and other operations in the warehouse, Sterling 
Warehouse Management System provides the capability to generate 
many reports. Access to these reports is controlled, based on the group 
to which the user belongs.

The Sterling Warehouse Management System reports can also be used by 
enterprise users for tracking inventory across nodes. These reports aid 
enterprise users in better decision making by providing complete visibility 
to the inventory across all the nodes.

Sterling Warehouse Management System integrates reports with the 
Application Console user interface. The dynamic menus of this user 
interface enable you to access reports from the appropriate consoles. The 
reports displayed in the menu are based upon your user group. For 
example, you can view the Order Billing Report and the Shipment Billing 
Report in your menu only if you belong to the group representing 
warehouse managers. Data security is maintained in the reports by 
allowing only users with appropriate permissions to access the 
information.

Once you navigate to the criteria screen of a specific report, you can 
enter the criteria for generating the report into the criteria screen. Based 
upon this criteria, Sterling Warehouse Management System displays the 
appropriate report.
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User Groups

Sterling Warehouse Management System also enables you to save 
reports as favorites. These reports are available to you as links in the 
Favorites area of your Home page. Click the link to a particular report to 
view the criteria screen for that reports. Click Generate Report to view 
the report.

1.1 Integration with Cognos 8 BI 8.4
Sterling Warehouse Management System integrates with Cognos 8 BI 8.4 
to generate reports. The report criteria is entered in the Application 
Console and posted to the Cognos URL. This provides the flexibility to 
control the reports based on your user group permissions.

1.1.1 Users
Users are set up in Sterling Warehouse Management System and need 
not be set up separately in Cognos 8 BI 8.4.

Reports can be accessed by Sterling Warehouse Management System 
console users. You can access only those reports for which your user 
groups have permission.

For more information about defining Users and User Groups, see the 
Selling and Fulfillment Foundation: Application Platform Configuration 
Guide.

1.1.2 User Groups
User groups are a collection of users who perform similar tasks. For 
example, a group of inventory supervisors might be put in an Inventory 
Supervisor user group. Users can belong to multiple user groups. These 
user groups are assigned permissions that applicable to all users in the 
user group.

Each organization has its own user groups. User groups can only contain 
users for the same organization for which the user was created, except in 
the case of a user group created by the Hub organization, which can 
contain users of any organization.

For more information about defining Users and User Groups see the 
Selling and Fulfillment Foundation: Application Platform Configuration 
Guide.
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1.1.3 Dynamic Menus
Integrating with Cognos 8 BI 8.4 enables Sterling Warehouse 
Management System to provide data to the user interface for generating 
reports. Dynamic menus enable users to access reports from the 
appropriate consoles. The reports displayed in these menus are based 
upon the user group to which the user belongs.

For example, let us consider the differences in the menu displayed to 
users belonging to the group representing inventory supervisors and the 
menu displayed to users belonging to the group representing shipping 
supervisors:

Users belonging to the group representing shipping supervisors can 
view the Alerts, Inventory, Outbound, Task, and Configuration options 
in their menu, whereas users belonging to the group representing 
inventory supervisors can view the Alerts, Inventory, Task, VAS, and 
Configuration options in their menu.

Users belonging to the group representing shipping supervisors can, 
view all the Outbound Reports under their Outbound menu, whereas 
users belonging to the group representing inventory supervisors 
cannot even view the Outbound menu option.

Figure 1–1 displays the menu bar that is available to users belonging 
to the group representing shipping supervisors.

Figure 1–3 displays the menu bar that is available to users belonging 
to the group representing inventory supervisors.

Users belonging to the group representing shipping supervisors can 
view only the Dedicated Locations Report, Item Tag Number Report, 
and Participant List Report under their Inventory menu, whereas 
users belonging to the group representing inventory supervisors can 
view all the Inventory Reports under their Inventory menu.

Figure 1–2 displays the Inventory reports that is available to users 
belonging to the group representing shipping supervisors.

Figure 1–3 displays the Inventory reports that is available to users 
belonging to the group representing inventory supervisors.
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Dynamic Menus

Figure 1–1 Outbound Menu Options for Shipping Supervisors

Figure 1–2 Inventory Menu Options for Shipping Supervisors
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Figure 1–3 Inventory Menu Options for Inventory Supervisors

1.1.4 Permissions
Permissions are assigned to user groups. These permissions apply to all 
users in that user group. You can administer the permissions that a user 
group has throughout the Application Consoles and Applications Manager 
applications.

You can allow or disallow permissions for the reports that are displayed 
to various user groups. For example, Inventory supervisors may have 
access to all Inventory Reports, but may not have access to Outbound 
Reports. Shipping Supervisors may access all Outbound Reports, but may 
have only limited access to Inventory Reports.

A user who belongs to multiple user groups retains the least restrictive 
set of permissions defined by the groups to which they belong. For 
example, if a user belongs to a user group that permits them to access 
the Inventory Reports and they also belong to a user group that only 
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Permissions

permits them to access the Outbound Reports, the user has access to 
both Inventory and Outbound Reports.

For more information about administering user group permissions, see 
the Selling and Fulfillment Foundation: Application Platform Configuration 
Guide.

1.1.4.1 Reports Accessible to Enterprise Users
Table 1–1 specifies reports that the enterprise users can access.

1.1.4.2 Reports Accessible to Warehouse Users
Table 1–2 specifies reports that the various warehouse users can access.

Table 1–1 Reports for Enterprise Users

Module Report

Order Container Volume Monthly Report

Order Cycle Time Report

On Time Shipment Report

Order Billing Summary Report

Shipment Billing Summary Report

Inventory Inventory Balance Report

Item Inventory across Nodes Report

Node Inventory Valuation Report

Cycle Count Variance Daily Report

Cycle Count Variance Weekly Report

Cycle Count Variance Monthly Report

Participant List Report

Supply Order Billing Summary Report

Shipment Billing Summary Report

Reverse Logistics Returns by Reason Code Report
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Table 1–2 Reports for Warehouse User Groups

Module Report
Warehouse 
Manager

Inbound 
Supervisor

Inventory 
Supervisor

Outbound 
Supervisor

Inbound Dock to Stock Cycle 
Time KPI Report

Y Y N N

Await Material 
Report

Y Y N N

Inbound Labor 
Requirements 
Report

Y Y N N

Item Attribute 
Setup Report

Y Y N N

Receipt Discrepancy 
Report

Y Y N N

Receipt Detail 
Report

Y Y N N

Receipt Summary 
Report

Y Y N N 

Shipment Billing 
Summary Report

Y Y N N

Returns Returns by Reason 
Code Report 

Y Y N N
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Permissions

Inventory Inventory Aging 
Report

Y N Y N

Inventory Audit 
Report

Y N Y N

Inventory Balance 
Report

Y N Y N

Inventory Hold 
Report

Y N Y N

Node Inventory 
Valuation Report

Y N Y N

Location Inventory 
Detail Report

Y N Y N

Location Inventory 
Summary Report

Y N Y N

Item Inventory 
Report

Y N Y N

Container Not 
Having Standard 
Quantity Report

Y N Y N

Cycle Count 
Variance Daily 
Report

Y N Y N

Cycle Count 
Variance Weekly 
Report

Y N Y N

Cycle Count 
Variance Monthly 
Report

Y N Y N

Table 1–2 Reports for Warehouse User Groups

Module Report
Warehouse 
Manager

Inbound 
Supervisor

Inventory 
Supervisor

Outbound 
Supervisor
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Inventory Dedicated Locations 
Usage Report

Y Y Y Y

Dedicated Locations 
Activity Report

Y Y Y Y

Item Tag Number 
Report

Y Y Y Y

Item Velocity 
Report

Y N Y N

Location/SKU 
Velocity Mismatch 
Report

Y N Y N

Participants List 
Report

Y Y Y Y

Space Consolidation 
Report

Y N Y N

Space Utilization 
Report

Y N Y N

Empty Location 
report

Y N Y N

VAS Work Orders Report Y N Y N

Outbound Container Volume 
Monthly Report

Y N N Y

Order Cycle Time 
KPI Report

Y N N Y

On Time Shipment 
Report

Y N N Y

Daily Shipment 
Report

Y N N Y

Generic Shipper 
Report

Y N N Y

Same Day Pick Pack 
Ship Percentage 
Report

Y N N Y

Table 1–2 Reports for Warehouse User Groups

Module Report
Warehouse 
Manager

Inbound 
Supervisor

Inventory 
Supervisor

Outbound 
Supervisor
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Permissions

Outbound Pack and Hold 
Shipment Report

Y N N Y

Order Shipment 
Report

Y N N Y

Outbound Labor 
Requirements 
Report

Y N N Y

Hot Inventory 
Report

Y N N Y

Replenishment 
Status Report

Y N Y Y

Parcel Manifest 
Report

Y N N Y

BOL Total Weights 
Report

Y N N Y

Shipment Billing 
Summary Report

Y N Y Y

Shipment Fill Rate 
Monthly Report

Y N Y Y

Shipment Shortage 
Report

Y N N Y

Shipments Near / 
Past Cancel Date

Y N N Y

Staging Locations 
Report

Y N N Y

Table 1–2 Reports for Warehouse User Groups

Module Report
Warehouse 
Manager

Inbound 
Supervisor

Inventory 
Supervisor

Outbound 
Supervisor
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1.1.5 Data Security
Users have restricted access to a specific set of enterprises based on the 
Data Security Group to which they belong. Sterling Warehouse 
Management System maintains data security in reports by allowing users 
to access enterprise-specific information in reports only if they belong to 
the Data Security Group for that enterprise.

Figure 1–4 illustrates the Inventory Balance Report criteria screen for 
user E1. User E1 is restricted to access information pertinent to 
enterprise E1 only. Hence, user E1 is not provided with a drop-down list 
of enterprises from which to search.

Also, because user E1 is restricted to access information pertinent to 
enterprise E1 only, even when user E1 selects Across Enterprises, the 
search results only display information pertinent to enterprise E1.

Figure 1–5 illustrates the Inventory Balance Report criteria screen for 
user dc1mgr. User dc1mgr is a node user who participates in enterprises 
DEFAULT and E1. Hence, user dc1mgr is provided with a drop-down list 
of these enterprises from which to choose the appropriate enterprise.

Tasks In-Progress 
Shipment Summary 
Report

Y Y Y Y

In-Progress 
Container Summary 
Report

Y Y Y Y

Warehouse 
Activity 
Completion 
Report

Y Y Y Y

User Productivity 
Daily Report

Y Y Y Y

User Productivity 
Weekly Report

Y Y Y Y

User Productivity 
Monthly Report

Y Y Y Y

Table 1–2 Reports for Warehouse User Groups

Module Report
Warehouse 
Manager

Inbound 
Supervisor

Inventory 
Supervisor

Outbound 
Supervisor
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Data Security

Also, because user dc1mgr is restricted to access information pertinent 
to enterprises DEFAULT and E1, when user dc1mgr selects Across 
Enterprises, the search results display information pertinent to both 
DEFAULT and E1.

Figure 1–4 Inventory Balance Report Criteria Screen for Enterprise 
Users Restricted to Enterprise E1
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Figure 1–5 Inventory Balance Report Criteria Screen for Node Users 
Participating in DEFAULT and E1

For more information about defining Data Security Groups, see the 
Selling and Fulfillment Foundation: Application Platform Configuration 
Guide.

1.2 Why Cognos 8 BI 8.4
There are various advantages to integrating with Cognos 8 BI 8.4 for 
generating reports. Some of these are:

Lower costs—reduces maintenance due to complete report coverage 
and a zero-footprint environment.

Faster results—shortens reporting time due to seamless integration 
and adaptive authoring.

Improved decision making—reports and dashboards present data in 
easily-understood formats. 

Adaptive authoring automatically adjusts report layout when objects 
are added, moved, or removed.

Ability to work with data using familiar business terms.
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Report Body Layout

Ability to use a variety of charts—crosstabs, bar or 3D bar, pie or 
doughnut, line, gauge, funnel, scatter, dot density, waterfall, and so 
forth.

Ability to create complex, multi-page layouts using different data 
sources.

High performance data access across all sources.

Complete connectivity regardless of environment.

Open architecture that leverages XML, SOAP, and WSDL. 

Multiple export formats—Excel, Portable Document Format (PDF), 
Extensible Markup Language (XML), Hypertext Markup Language 
(HTML), and Comma Separated Value (CSV). 

Multilingual capabilities automatically deliver reports in the users' 
working language. 

Ability to integrate seamlessly with the Selling and Fulfillment 
Foundation, without the user having to log in to the application again.

1.3 Sterling Warehouse Management System 
Report Layout

The Sterling Warehouse Management System reports consist of various 
sections. Depending upon the number of rows, reports may span across 
multiple pages. In the case of multi-page reports, the header and criteria 
information appear on the first page only and are not repeated on 
subsequent pages.

1.3.1 Report Body Layout
This section describes the layout of a report in Sterling Warehouse 
Management System.
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Figure 1–6 Report Body Layout
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Search Parameters
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Report Header

        Report Title
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Summary Totals       

Link To
Detailed Reports
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Report Body Layout

Figure 1–7 Detailed Report
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Report Header
The report header displays the date on which the report is generated, the 
time on which the report is generated, and the report title.

The report header is printed only on the first page for each report and is 
not repeated on the subsequent pages.

User Information
This area displays the information of the user.

The user information is printed only on the first page for each report, and 
is not repeated on the subsequent pages.

Node User
In the case of a node user, this area displays the user ID, user name, 
warehouse ID, and warehouse name.

Figure 1–8 User Information for Node User

Enterprise User
In the case of an enterprise user, this area displays the user ID, user 
name, enterprise ID, and enterprise name.

Figure 1–9 User Information for Enterprise User
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Report Body Layout

Search Parameters
This area displays the search parameters entered by the user.

The search parameter is printed only on the first page for each report 
and is not repeated on the subsequent pages.

Page Break Criteria
This area displays the criteria for the page break. Based upon this 
criteria, the report is printed on a new page. For example, if the page 
break criteria is enterprise, the report is printed on a new page for each 
new enterprise.

The page break criteria is printed only once for each occurrence of the 
criteria and is not repeated in the subsequent pages of the report for the 
same criteria. For example, for enterprise E1, the page break criteria E1 
is printed once at the top of the table that contains the information for 
E1. If this table spans across multiple pages, the page break criteria E1 
is not printed on the subsequent pages. However, if the information for 
enterprise E2 is also printed in the same report, the table containing this 
information is printed on a new page and is preceded by the page break 
criteria E2.

Report Data
This area displays the requested report information, in a tabular format.

In any column, if a value repeats consecutively for more than one row, 
the value is printed only once and is not repeated for each of the 
successive rows in which the column value is the same.

Group Totals
This area displays the totals for a group. For example, in the figure, this 
area displays the totals for enterprise E1.

Summary Totals
This area displays a summary of the totals for all groups.

Note: The report displays only those enterprises that 
have some data.
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Links to Detailed Reports
These links enable you to view detailed reports. These links are typically 
present for reports that contain summarized information. Click these 
links to view detailed reports that provide more information about a 
particular aspect of the main report.

For example, in Figure 1–6, clicking the link in the No. of Outbound 
Orderlines column displays the Outbound Order Lines Billing Detail 
Report (Figure 1–7), which provides detailed information about the 
outbound orders and their order lines.

1.3.2 Cognos 8 BI 8.4 Toolbar
This section describes the Cognos 8 BI 8.4 toolbar that appears in a 
Sterling Warehouse Management System report.

Figure 1–10 Cognos 8 BI 8.4 Toolbar

The Cognos 8 BI 8.4 toolbar that appears in a Sterling Warehouse 
Management System report contains the following icons:

View in HTML format

Click the View in HTML format icon  to view the report in Hypertext 
Markup Language format.

The Sterling Warehouse Management System reports are displayed in 
HTML format by default.

View in PDF format
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Customizing the Cognos 8 BI 8.4 Toolbar

Click the View in PDF format icon  to view the report in Portable 
Document Format.

1.3.3 Customizing the Cognos 8 BI 8.4 Toolbar
The default Cognos 8 BI 8.4 toolbar provides multiple icons.

Figure 1–11 Default Cognos 8 BI 8.4 Toolbar

 

You can customize the Cognos 8 BI 8.4 toolbar to hide icons that are 
currently visible or to view icons that have been hidden.

To hide currently visible icons:

1. Open the file <YNW_ANALYTICS_HOME>/Custom/custom_system.xml

2. Uncomment the relevant instruction to hide the icon

To view additional icons:

1. Open the file <YNW_ANALYTICS_HOME>/Custom/custom_system.xml

2. Comment the relevant instruction to display the icon

Note: The Cognos Toolbar is displayed in the reports that 
are generated using the Sterling Warehouse Management 
System. However, you can use only the  button in the 
toolbar.
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For example:

To view the Send Report as Email icon , comment the instruction

<RV_TOOLBAR_BUTTONS_Send />

To hide the View in PDF format icon , uncomment the instruction

<RV_TOOLBAR_BUTTONS_PDF/>

1.3.4 Changing the View Option for Drill-Through Reports
In the Sterling Warehouse Management System, it is not possible to 
navigate from a drill-through report to the parent report. 

However, Cognos enables you to configure the drill-through reports to 
open in a new window when accessed through the Sterling Warehouse 
Management System. 

Perform the following steps to open a drill-through report in a new 
window: 

1. Launch Report Studio from the Cognos console.

2. The Report Studio window is displayed with a list of reports. Click a 
report. The corresponding report is displayed in the work area. 
Right-click the data item in the report that you want to open in a new 
window and select Drill-Through Definitions.

3. In the Drill-Through Definitions window that is displayed, select the 
Open in new window check box, and click Save.

After this configuration is performed, it is possible to open a drill-through 
report in a new window.

For detailed information about accessing the Cognos Console and 
performing the subsequent steps, refer to ug_cr_rptstd.pdf.

1.4 Sterling Warehouse Management System 
Reports

The reports provided with the Sterling Warehouse Management System 
are grouped into the following menu classifications:

Billing Activity Reporting Engine Reports

Inbound Reports
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Inbound Reports

Returns Reports

Inventory Reports

VAS Reports

Outbound Reports

Task Reports

1.4.1 Billing Activity Reporting Engine Reports
The Billing Activity Reporting Engine aids warehouse managers to view 
information about the various activities performed in the warehouse.

For more information about billing activity reporting engine reports, see 
the Sterling Warehouse Management System: Reports Guide.

The different billing activity reporting engine reports provided with the 
Sterling Warehouse Management System are:

Billing Activity Report

The Billing Activity Report shows the billable activities performed in 
the warehouse for an Enterprise, as captured by the Billing Activity 
Reporting Engine.

1.4.2 Inbound Reports
Inbound reports provide visibility to receipts. These reports help 
receiving supervisors to plan receipts and labor requirements for 
receipts, as well as to manage discrepancies. The warehouse manager 
can also see information on receipts that are expected shortly, so as to 
make the dock doors available for these receipts.

For more information about inbound reports, see Chapter 2, "Inbound 
Reports".

The inbound reports provided with Sterling Warehouse Management 
System are:

Await Material Report

This report shows the summary of the items that are waiting for 
material. This report helps the warehouse manager to identify items 
that are unavailable and to prioritize inbound shipments that can 
reduce the awaiting items in this report.
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Dock to Stock Cycle Time KPI Report

This report is used to measure the Dock to Stock cycle time on all 
inbound shipments or receipts. Cycle time is defined as the time that 
elapses from the start of the receipt to the time that Putaway is 
completed. 

Inbound Labor Requirements Report

This report is used to determine labor requirements for receiving 
activities. The labor required is calculated based on the Standard 
Allowable Minutes defined.

Item Attribute Setup Report

This report lists all items in the warehouse that do not have their 
attributes completely defined. This report is useful to identify items 
that have incomplete setup, as this information is required to execute 
warehouse operations.

Receipt Discrepancy Report

This report is used to track the receipt discrepancy details between 
the expected and received quantities for a particular day or date 
range. The report displays the discrepancy as Short Receipt, Over 
Receipt, or Damaged.

Receipt Detail Report

This report lists the details of the shipments received for the selected 
shipment, Purchase Order (PO), or date range. It provides details at 
the item and quantity level.

Receipt Summary Report

This report lists the receipts for the selected shipment, PO, or date 
range. It provides summary receipt information at the shipment level.

Shipment Billing Summary Report

This report displays the number of shipments and shipment lines 
shipped, and the number of receipts and receipt lines received. This 
report also provides the transaction details for the transactions in the 
details report.

Vendor Non-Compliance Report
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Inventory Reports

The Vendor Non-Compliance Report displays the non-compliant 
shipments observed during the inbound process. This report helps the 
warehouse to identify the vendors shipping non-compliant shipments.

1.4.3 Returns Reports
Returns reports help warehouse managers to view information about 
inventory returns.

For more information about returns reports, see Chapter 3, "Returns 
Reports".

The returns report provided with the Sterling Warehouse Management 
System is:

Returns By Reason Code Report

This report lists all shipments based on the return reason code 
entered during the return process. This report can also be generated 
for specific selected reason codes.

1.4.4 Inventory Reports
Inventory reports help inventory supervisors to manage inventory, track 
the movement of inventory within the warehouse, and get visibility on 
the different categories of inventory, such as, inventory that are on hold. 
These reports can also be used to categorize inventory based on cost.

For more information about inventory reports, see Chapter 4, "Inventory 
Reports".

The inventory reports provided with Sterling Warehouse Management 
System are:

Containers Not Having Standard Quantity Report

This report lists all cartons stored in the warehouse that have less 
than the standard case or pallet quantity. This report can be used to 
identify opportunities for consolidation.

Cycle Count Variance Daily Report

This report provides the cycle count variance information, on a daily 
basis, for a given date range.
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Cycle Count Variance Monthly Report

This report provides the cycle count variance information, on a 
monthly basis, for a given date range.

Cycle Count Variance Weekly Report

This report provides the cycle count variance information, on a 
weekly basis, for a given date range.

Dedicated Locations Usage Report

This report provides visibility into locations that are dedicated to 
certain Stock Keeping Units (SKUs). This usage report shows 
locations that have remained unused in various time buckets.

Dedicated Locations Activity Report

This report provides visibility into locations that are dedicated to 
certain Stock Keeping Units (SKUs). The activity report categorizes 
the locations based on the number of times the location is 
replenished.

Empty Location Report

This report provides a list of empty locations in the warehouse. This 
report can also be accessed as a sub-report of the Space 
Consolidation Report.

Inventory Aging Report

This report provides the inventory age identified by its receipt date. 
In case the receipt date information is lost, the inventory age cannot 
be ascertained and is therefore classified as "Inventory with Unknown 
Age".

Inventory Audit Report

This report is used to track inventory changes resulting from the 
execution of tasks in the warehouse. This report can help in tracking 
changes to item or location inventory, inventory changes done by a 
user, or a combination of these.

Inventory Balance Report

This report is used to balance the opening and closing quantity of 
inventory for an item within a date range.
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Inventory Reports

Inventory Hold Report

This report lists the item and location details for all items that are on 
hold due to Quality Control activities, Count variances, and locations 
that are frozen for Picking or Putaway.

Item Inventory Across Nodes Report

This report is used to track the inventory of items across nodes for 
either all or selected enterprises. The report can be generated only 
for those enterprises to which the user has access.

Item Inventory Report

This report lists the details of the item inventory at the node. You can 
drill down to location level and container level reports from this 
report. 

Item Tag No. Report

This report lists all item transactions for the given tag number. The 
report displays the transactions in three categories: Inbound, 
Inventory, and Outbound.

Item Velocity Report

Due to changes in demand, seasonal variations, and product life cycle 
characteristics, item velocity changes over time. This report captures 
the item velocity, as measured by the number of shipments that the 
item features in during the selected date range.

Location/SKU Velocity Mismatch Report

This report matches the Location Velocity to the Item Velocity to 
identify locations that have a mismatch. The warehouse can use this 
report to reorganize item locations to optimize the utilization of 
locations.

Node Inventory Valuation Report

This report lists the item, quantity, and valuation details for a node. 
This report is useful in determining the inventory valuation in a node.

Participant List Report

This report lists the number of participants defined in the Selling and 
Fulfillment Foundation Participant Model with role details.
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Space Consolidation Report

This report provides item-wise information about the location capacity 
utilization. This helps in identifying space consolidation opportunities.

Space Utilization Report

This report provides information on location capacity utilization in 
terms of percentage. 

Location Inventory Detail Report

This report is used to track the inventory of items and locations in the 
warehouse at the item, case, pallet, status, and other item attributes 
levels.

Location Inventory Summary Report

This report is used to track the inventory of items and locations in the 
warehouse at the item or location level.

1.4.5 VAS Reports
Value Added Services (VAS) reports help warehouse managers to view 
information about work orders to perform Value Added Services on the 
inventory.

For more information about VAS reports, see Chapter 5, "VAS Reports".

The VAS report provided with the Sterling Warehouse Management 
System is:

Work Order Report

This report displays all the work orders for the node, in different 
stages of completion. This report is used to review open work orders.

1.4.6 Outbound Reports
Outbound reports help shipping supervisors to see information on order 
billing and shipment billing. These reports can also be used to get 
visibility to outbound labor requirements, on-time shipments, and so on.

For more information about outbound reports, see Chapter 6, "  
Outbound Reports".
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Outbound Reports

The outbound reports provided with Sterling Warehouse Management 
System are:

BOL Total Weights Report

This report lists the number of cartons or pallets, and the total weight 
details against each Bill Of Lading (BOL). This report lists all details 
for BOLs shipped for the selected carrier or date range.

Container Volume Monthly Report

This report shows the number of containers shipped each month. For 
the current month, it only shows the total number of cartons shipped 
till date.

Daily Shipment Report

This report provides high-level visibility into shipment activity in the 
warehouse, on a daily basis, for a specified date range. This report 
provides daily information on new shipments awaiting shipping on the 
day, shipments shipped on the day, shipment pending from previous 
days, and shipments carried over to the next day.

Generic Shipper Report

This report gives details of shipments that are either to be shipped or 
were shipped using each carrier that the warehouse uses. The 
warehouse can use this report to understand the carrier usage 
patterns.

Hot Inventory Report

This report helps to identify the inbound shipments that should be 
unloaded based on the hot items in the trailer or container. These 
items are on backorder for the warehouse, and available in the 
expected shipments.

On Time Shipment Report

This report captures the number of shipments shipped at the 
scheduled time. It also categorizes the delayed shipments into 
buckets of delays by one, two, or more days.

Order Billing Summary Report

This report lists the transaction details for all types of orders handled 
by the warehouse. This report helps to track metrics, such as the 
number of orders or order lines shipped or received.
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Order Cycle Time KPI Report

This report is used to measure the turnaround cycle time on all 
outbound shipments or orders. Cycle time is defined as the time that 
elapses from when an order is released to a warehouse until the time 
it is shipped.

Order Shipment Report

This report shows the details of shipments against orders. It also 
shows the quantity ordered and shipped at the item level.

Outbound Labor Requirements Report

This report is used to determine the labor requirements for waves or 
shipments that are to be picked, packed, and shipped on a future 
date. This report is useful to plan resource requirements for outbound 
activities.

Pack and Hold Shipment Report

This report lists all shipments that are currently in the ‘pack and hold’ 
status, along with their location and shipper details. This report is 
useful to the warehouse supervisor to review pack and hold 
shipments. 

Parcel Manifest Report

This report lists the Parcel manifest details in terms of shipment 
details, number of containers, weight, and other details for the 
selected manifest number or carrier and service.

Replenishment Status Report

This report helps the monitoring of replenishment activities in the 
warehouse. The report provides information about the replenishment 
status and highlights shortages or overages of replenishment 
quantities.

Same Day Pick Pack Ship Percentage Report

This report gives a measure of the number of shipments picked, 
packed, and shipped on the same day. The criterion for any shipment 
to be counted is that the pick date is the same as the actual ship 
date.
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Task Reports

Shipment Billing Summary Report

This report displays the number of shipments and shipment lines 
shipped, and the number of receipts and receipt lines received. This 
report also lists the transaction details for the transactions in the 
details report.

Shipment Fill Rate Monthly Report

This report shows the percentage of complete shipments shipped by 
the warehouse. The percentage is calculated as the ratio of the 
complete shipments shipped to the total number of shipments 
shipped by the node.

Shipments Near or Past Cancel Date Report

This report lists unshipped shipments that are near or past the 
selected order cancel date range. This report is useful to track the 
shipments that are due and manage resources to generate the same.

Shipment Shortage Report

This report lists all shipments that have item shortages and aids 
warehouse managers in managing exceptions.

Staging Locations Report

Warehouses have limited staging locations. Therefore, they can 
become a bottleneck if not managed properly. This report provides a 
means to identify locations that might be occupying space by having 
shipments that are either not loaded or awaiting containers.

1.4.7 Task Reports
Task reports help warehouse managers to view information about the 
various tasks performed in the warehouse.

For more information about task reports, see Chapter 7, "Task Reports".

The task reports provided with Sterling Warehouse Management System 
are:

In-Progress Container Summary Report

This report shows the current status of the pick-pack-ship process. 
The default container dashboard view shows two graphs: Number of 
containers by statuses and Number of Containers by Carriers.
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In-Progress Shipment Summary Report

This report shows the current status of the pick-pack-ship process. 
The default dashboard view shows these two graphs: Number of 
Shipments and Cartons Across All Carriers, and Number of Shipments 
and Cartons by Carrier.

User Productivity Daily Report

This report provides user productivity information, on a daily basis, 
for a given date range.

User Productivity Weekly Report

This report provides user productivity information, on a weekly basis, 
for a given date range.

User Productivity Monthly Report

This report provides user productivity information, on a monthly 
basis, for a given date range.

Warehouse Activity Completion Report

This report provides a summary of the various warehouse tasks that 
are in "Completed" status. The numbers change as more tasks enter 
the "Completed" status. The user can also select only a specific set of 
task types to populate the activity report.

1.5 Printing the Sterling Warehouse Management 
System Reports

To print the Sterling Warehouse Management System reports:

1. Generate the report you want to print.

2. Click  to view the report in Portable Document Format (PDF).

3. Click  in the PDF view to print the report.
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Printing the Sterling Warehouse Management System Reports
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2
Inbound Reports

The following inbound reports can be generated using Sterling 
Warehouse Management System:

Await Material Report

Delivery Dock Schedule Report

Dock to Stock Cycle Time KPI Report

Inbound Labor Requirements Report

Item Attribute Setup Report

Receipt Discrepancy Report

Receipt Detail Report

Receipt Summary Report

Shipment Billing Summary Report

Vendor Non-Compliance Report
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Report Criteria

2.1 Await Material Report
The Await Material Report shows the summary of the items that are 
waiting for material. This report helps the warehouse to identify items 
that are unavailable and to prioritize inbound shipments that can reduce 
the awaiting items in this report.

Intended Audience
Warehouse managers and inbound supervisors use this report to identify 
the inbound shipments that needs to be received. The user can also see 
the total requirements for a SKU or see the material requirements for 
each individual shipment.

2.1.1 Generating the Report
To generate the Await Material Report:

1. Navigate to Inbound > Await Material Report. The Await Material 
Report criteria screen appears. For more information about the Await 
Material Report criteria screen, see Section 2.1.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Await Material Report appears. For more information about the 
Await Material Report, Shipment layout, see Section 2.1.3.1, "Report 
Layout" and for more information about Await Material Report, 
Shipment Details layout, see Section 2.1.4.1, "Report Layout".

2.1.2 Report Criteria
The Await Material Report criteria screen enables you to enter the criteria 
for which the Await Material Report generates.
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Figure 2–1 Await Material Report Criteria Screen

Table 2–1 Await Material Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For this report, the 
document types displayed 
are Transfer Order and 
Sales Order. 

Sales Order. Yes

Node The node for which the 
report is generated.

Current node 
of the user.

No
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Report Criteria

Table 2–1 Await Material Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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2.1.3 Await Material Report, Shipment Details
This report gives a detailed information about the shipments requested 
on a particular ship date.

Report Level

Expected Ship 
Date

Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes

Table 2–1 Await Material Report Criteria Screen

Field Description Default Value Mandatory

Shipment 
Details

Choose this to 
view the Await 
Material 
Report, 
Shipment 
Details which 
reports the 
details of the 
shipments for 
a specific item, 
within a 
specific 
enterprise. 

Not Selected. No

Item 
Details

Choose this to 
view the Await 
Material 
Report, Item 
Details which 
reports the 
details of the 
items, within a 
specific 
enterprise.

Selected. No
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Await Material Report, Shipment Details

2.1.3.1 Report Layout
This section describes the report layout of the Await Material Report, 
Shipment details.

Figure 2–2 Await Material Report, Shipment Details 
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The Await Material Report for Shipment Details appears in portrait layout.

2.1.3.2 Group and Sort Criteria
The Await Material Report for Shipment Details is grouped by Enterprise 
Code, Ship Date, Shipment No., Buyer, and Item ID.

Enterprise Code, Shipment No., and Item ID are sorted in ascending 
order. The Expected Ship Date is sorted in descending order.

2.1.3.3 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

2.1.3.4 Additional Setup Required
There is no additional setup required to generate this report.

2.1.4 Await Material Report, Item Details
This report gives a detailed information about the items within a 
particular shipment.

Table 2–2 Await Material Report, Shipment Details

Field Description

Ship Date The date on which the shipment is shipped.

Shipment No. The number assigned to a specific shipment.

Seller The organization from where the items are shipped.

Buyer The organization to which the items are shipped.

Item ID The identifier assigned to the item.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Ordered Quantity The quantity ordered.

Shortage Quantity The quantity in shortage for that order.
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Await Material Report, Item Details

2.1.4.1 Report Layout
This section describes the report layout of the Await Material Report, 
Item Details.
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Figure 2–3 Await Material Report, Item Details 
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Delivery Dock Schedule Report

 

The Await Material Item Details Report appears in portrait layout.

2.1.4.2 Group and Sort Criteria
The Await Material Item Details Report is grouped by Enterprise code and 
Item ID.

Enterprise code and Item ID are sorted in ascending order.

2.1.4.3 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

2.1.4.4 Additional Setup Required
There is no additional setup required to generate this report.

2.2 Delivery Dock Schedule Report
The Delivery Dock Schedule Report provides visibility into appointments 
taken for one or more receiving dock locations, for a range of dates.

Intended Audience
Warehouse managers and inbound supervisors use this report to keep 
track of dock appointments.

Table 2–3 Await Material Report, Item Details 

Field Description

Item ID The identifier assigned to the item.

Click this to view the Await Material Report, Shipment 
Details, which gives details of all shipments.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Shortage Quantity The quantity in shortage for that order.
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2.2.1 Generating the Report
To generate the Delivery Dock Schedule Report:

1. Navigate to Inbound > Delivery Dock Schedule Report. The Dock 
Schedule Report criteria screen displays. For more information about 
the Dock Schedule Report criteria screen, see Section 2.2.2, "Report 
Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Dock Schedule Report displays. For more information about the 
Dock Schedule Report layout, see Section 2.2.3, "Report Layout".

2.2.2 Report Criteria
The Dock Schedule Report criteria screen enables you to enter the 
criteria for which the Dock Schedule Report generates.

For field value descriptions, see Table 2–4.



44   Reports Guide

Report Criteria

Figure 2–4 Dock Schedule Report Criteria Screen

Table 2–4 Dock Schedule Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current node 
of the user.

No

Carrier Select the name of the 
carrier for which the report is 
generated.

None. No
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Docks You can generate reports for a range of dock locations. 

Table 2–4 Dock Schedule Report Criteria Screen

Field Description Default Value Mandatory

From Enter the initial 
dock location.

You can also click 
 to select the 

dock location.

None. No

To Enter the final 
dock location.

You can also click 
 to select the 

dock location.

None. No
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Report Layout

2.2.3 Report Layout
This section describes the layout of the Dock Schedule Report.

Appointment 
Date

Enter the start date and the 
end date for which the report 
is generated.

You can also click the  
icon to choose the date 
range.

The current date. Yes.

Appointment 
Type

Table 2–4 Dock Schedule Report Criteria Screen

Field Description Default Value Mandatory

Inbound 
Delivery

Choose this 
option to view 
the report for 
inbound 
deliveries.

Selected, if you are 
entering the search 
criteria for the 
Delivery Dock 
Schedule Report.

Not Selected, if you 
are entering the 
search criteria for 
the Dock Pickup 
Schedule Report.

No

Outbound 
Pickup

Choose this 
option to view 
the report for 
outbound 
pickups.

Selected, if you are 
entering the search 
criteria for the 
Dock Pickup 
Schedule Report.

Not Selected, if you 
are entering the 
search criteria for 
the Delivery Dock 
Schedule Report.

No

Both Choose this 
option to view 
the report for 
both inbound 
deliveries and 
outbound 
pickups.

Not selected. No
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Figure 2–5 Dock Schedule Report
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Page Break Criteria

Table 2–5 Dock Schedule Report

2.2.4 Group and Sort Criteria
The Dock Schedule Report is grouped by Location and Date.

The Location, Date, and Time Slot are sorted in ascending order.

2.2.5 Page Break Criteria
For each dock location, the report starts in a new table on another page. 
The name of the dock location is printed at the top of the table.

Field Description

Date The appointment date for which the report is 
generated.

Time Slot The time slot for which a dock appointment is taken.

Appointment No The appointment number of the appointment.

Appointment Type The type of appointment.

Carrier The carrier used for the shipment or load.

Trailer No The trailer number for the shipment or load.

PRO No The PRO number assigned by the carrier to track 
the shipment.

The PRO number is used if an LTL carrier hauls 
the shipment.

BOL No The Bill of Lading number associated with the load. 

Load No The load number for the expected load.

The load number does not appear in the report if the 
appointments are taken for order number or shipment 
number.

Shipment No The shipment number for the expected shipment.

The shipment number does not appear in the report if 
the appointments are taken for the load number.

Order No The order number for the expected order.

The shipment number does not appear in the report if 
the appointments are taken for the load number.
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2.2.6 Additional Setup Required
There is no additional setup required to generate the DeliveryDock 
Schedule Report.
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2.3 Dock to Stock Cycle Time KPI Report
The Dock to Stock Cycle Time KPI Report is used to measure the Dock to 
Stock cycle time on all inbound shipments or receipts. Cycle Time is 
defined as the time that elapses from the start of a receipt to the time 
that Putaway completes.

Intended Audience
Warehouse managers and inbound supervisors use the Dock to Stock 
Cycle Time KPI Report to track the performance of inbound activities. The 
report is generated at the end of the day.

2.3.1 Generating the Report
To generate the Dock to Stock Cycle Time KPI Report:

1. Navigate to Inbound > Dock to Stock Cycle Time KPI Report. The 
Dock to Stock Cycle Time KPI Report criteria screen appears. For more 
information about the Dock to Stock Cycle Time KPI Report criteria 
screen, see Section 2.3.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Dock to Stock Cycle Time KPI Report appears. For more 
information about the Dock to Stock Cycle Time KPI Report layout, 
see Section 2.3.3, "Report Layout".

2.3.2 Report Criteria
The Dock to Stock Cycle Time KPI Report criteria screen enables you to 
enter the criteria for which the Dock to Stock Cycle Time KPI Report 
generates.
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Figure 2–6 Dock to Stock Cycle Time KPI Report Criteria Screen

Table 2–6 Dock to Stock Cycle Time KPI Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For this report, the 
document types displayed 
are Blind Return, Blind 
Order, Transfer Order, 
and Purchase Order. 

Purchase 
Order.

Yes

Node The node for which the 
report is generated.

Current node 
of the user.

No
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Report Layout

2.3.3 Report Layout
This section describes the layout of the Dock to Stock Cycle Time KPI 
Report.

Receipt Date Enter the start date and 
the end date for which 
the report is generated.

You can click the  icons 
to choose the date range.

The current 
date.

Yes

Putaway Cycle 
Time (in Hrs)

Enter the time elapsed 
from when the receipt 
starts to the time 
Putaway completes.

4 Yes

Table 2–6 Dock to Stock Cycle Time KPI Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from 
the drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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Figure 2–7 Dock to Stock Cycle Time KPI Report
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Report Layout

Table 2–7 Dock to Stock Cycle Time KPI Report, Table

Field Description

Receipt Date The date on which the inbound shipment is received.

Total Shipments The total count of the inbound shipments for which the 
receipt is generated.

Click this to view the Shipments Detail Report For Total 
Shipments, which shows the list of all inbound 
shipments.

Putaway in X Hrs The number of shipments put away in less than cycle 
time. Here, X Hrs indicates the cycle time.

Click this to view the Shipments Detail Report For 
Putaway in X Hrs, which shows the list of shipments 
for Putaway in X Hrs.

Putaway in 2X Hrs The number of shipments put away in more than cycle 
time and less than twice the cycle time. Here, X Hrs 
indicates the cycle time.

Click this to view the Shipments Detail Report For 
Putaway in 2X Hrs, which shows the list of shipments 
for Putaway in 2X Hrs.

Putaway Beyond 2X 
Hrs

Number of shipments put away in more than twice the 
cycle time. Here X Hrs indicates cycle time.

Click this to view the Shipments Detail Report For 
Putaway Beyond 2X Hrs, which shows the list of 
shipments for Putaway Beyond 2X Hrs.

Table 2–8 Dock to Stock Cycle Time KPI Report, Graph

Field Description

Receipt Date, Enterprise 
Code

The date on which the inbound shipment is 
received.

This is grouped by enterprise code.
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The Dock to Stock Cycle Time KPI Report appears in portrait layout.

2.3.4 Group and Sort Criteria
The Dock to Stock Cycle Time KPI Report is grouped by Enterprise Code 
and Receipt Date.

The Enterprise Code is sorted in ascending order and Receipt Date is 
sorted in descending order. 

2.3.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

2.3.6 Additional Setup Required
To obtain the data required for the Dock to Stock Cycle Time KPI Report, 
schedule the PUTAWAY_COMPLETE agent to execute at the end of each 
day.

No. of Shipments The total count of the inbound shipments for which 
the receipt is generated.

Table 2–8 Dock to Stock Cycle Time KPI Report, Graph

Field Description

Regions of this color indicate the total number of 
shipments for a particular date.

Regions of this color indicate the number of 
shipments putaway in less than cycle time for the 
specified date.

Regions of this color indicate the number of 
shipments putaway in more than cycle time and 
less than twice the cycle time for a particular date.

Regions of this color indicate the number of 
shipments putaway in more than twice the cycle 
time for a particular date.
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Shipments Detail Report For Total Shipments

The PUTAWAY_COMPLETE agent mines the data required for the Dock to 
Stock Cycle Time KPI Report from the Receiving Details and Putaway 
Tasks transactions.

2.3.7 Shipments Detail Report For Total Shipments
The Shipments Detail Report for total shipments provides a list of all the 
inbound shipments and their details.

2.3.7.1 Report Layout
This section describes the layout of the Shipments Detail Report.

Note: The value of Time Interval indicates the time taken 
to put away inbound shipments.

For Shipments Detail Report for Total Shipments, the value 
of Time Interval is All.
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Figure 2–8 Shipments Detail Report
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Shipments Detail Report For Putaway in X Hrs

The Shipments Detail Report appears in portrait layout.

2.3.7.2 Group and Sort Criteria
The Shipments Detail Report is grouped by Shipment Number.

The Shipment Number is sorted in ascending order.

2.3.7.3 Page Break Criteria
The Shipments Detail Report has no page break criteria.

2.3.8 Shipments Detail Report For Putaway in X Hrs
The Shipments Detail Report for putaway in X hrs gives the list of all the 
inbound shipments putaway in less than cycle time.

The fields, layout, group and sort criteria, and page break criteria of this 
report are similar to the Shipments Detail Report For Total Shipments.

Table 2–9 Shipments Detail Report

Field Description

Shipment No. The identifier number of the shipment received.

Seller The organization from where the items are shipped.

Receipt No. The receipt number of the shipment.

Receipt Date The date on which the shipment is received.

Time Taken for 
Putaway

The putaway time of the shipment.

Note: The value of Time Interval indicates the time taken 
to putaway inbound shipments.

For Shipments Detail Report for Putaway in X Hrs, the 
value of Time Interval is considered for Putaway In Cycle 
Time.
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2.3.9 Shipments Detail Report For Putaway in 2X Hrs
The Shipments Detail Report for putaway in 2X hrs gives the list of all the 
inbound shipments putaway in less than twice the cycle time.

The fields, layout, group and sort criteria, and page break criteria of this 
report are similar to the Shipments Detail Report For Total Shipments.

2.3.10 Shipments Detail Report For Putaway Beyond 2X 
Hrs

The Shipments Detail Report for putaway in 2X hrs gives the list of all the 
inbound shipments putaway beyond twice the cycle time.

The fields, layout, group and sort criteria, and page break criteria of this 
report are similar to the Shipments Detail Report For Total Shipments.

Note: The value of Time Interval indicates the time taken 
to putaway inbound shipments.

For Shipments Detail Report for Putaway in 2X Hrs, the 
value of Time Interval is considered for Putaway 
InTwiceCycleTime.

Note: The value of Time Interval indicates the time taken 
to putaway inbound shipments.

For Shipments Detail Report for Putaway Beyond 2X Hrs, 
the value of Time Interval is considered for putaway 
BeyondTwiceCycleTime.
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2.4 Inbound Labor Requirements Report
The Inbound Labor Requirements Report is used to determine labor 
requirements for receiving activities. The labor required is calculated 
based on the Standard Allowable Minutes defined.

Intended Audience
Warehouse managers and inbound supervisors use this report to plan 
resource requirements for receiving and putaway.This report also helps 
them to decide whether to reduce shipments, move people from other 
operations, or add more shipments when resources are available.

2.4.1 Generating the Report
To generate the Inbound Labor Requirements Report:

1. Navigate to Inbound > Inbound Labor Requirements Report. The 
Inbound Labor Requirements Report criteria screen appears. For more 
information about the Inbound Labor Requirements Report criteria 
screen. See Section 2.4.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Inbound Labor Requirements Report appears. For more 
information about the Inbound Labor Requirements Report layout, 
see Section 2.4.3, "Report Layout".

2.4.2 Report Criteria
The Inbound Labor Requirements Report criteria screen enables you to 
enter the criteria for which the Inbound Labor Requirements Report 
generates.
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Figure 2–9 Inbound Labor Requirements Report Criteria Screen

Table 2–10 Inbound Labor Requirements Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For this report, the 
document types displayed 
are Blind Return, Blind 
Order, Transfer order and 
Purchase Order. 

Purchase 
Order.

Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No



62   Reports Guide

Report Layout

2.4.3 Report Layout
This section describes the report layout of the Inbound Labor 
Requirements Report.

Date Range Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes

Table 2–10 Inbound Labor Requirements Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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Figure 2–10 Inbound Labor Requirements Report
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Page Break Criteria

The Inbound Labor Requirements Report appears in portrait layout.

2.4.4 Group and Sort Criteria
The Inbound Labor Requirements is grouped by the Expected Delivery 
Date.

Expected Delivery Date is sorted in descending order.

2.4.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

Table 2–11 Inbound Labor Requirements Report

Field Description

Expected Delivery Date The date on which the delivery of the shipment is 
expected.

No. of Shipments Total number of shipments expected on a particular 
date.

No. of Shipment Lines Total number of shipment lines for all the expected 
shipments.

No. of Units Total number of units expected for all shipments on a 
particular date.

No. of Cases Total number of cases expected for all shipments on a 
particular date.

Person Hours Reqd The person hours required for delivering all shipments, 
with expected delivery date listed against the person 
hours.

Person Hours Reqd is calculated as follows:

Person Hours Reqd = [(No. of Shipments * 
SAM Per Productivity Batch) + (No. of 
Shipment Lines * SAM per Item) + (No. of 
Units * SAM per Unit) + (No. of Cases * 
SAM per Case)] / 60



Additional Setup Required

Inbound Reports   65

2.4.6 Additional Setup Required
To compute the Person Hours Required, the Inbound Labor Requirements 
Report depends upon the values set up in the INBOUND_LABOR 
productivity type.

To set up the INBOUND_LABOR productivity type:

1. Launch the Applications Manager.

2. Navigate to Applications > Warehouse Management.

3. From the tree in the application rules side panel, choose Task 
Management > Productivity > Productivity Types. The Productivity 
Types window appears.

4. In the Productivity Types window select INBOUND_LABOR. The 
Productivity Type Details window appears.

The Sterling Warehouse Management System Reference 
Implementation provides SAM values as displayed in the Figure 2–11.
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Additional Setup Required

Figure 2–11 Productivity Type Details Window, Inbound Labor

5. In the SAM Definition tab, for fields that do not contain zero values, 
enter the appropriate SAM values. These values are used to compute 
the Person Hours Required.

6. Click .
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2.5 Item Attribute Setup Report
The Item Attribute Setup Report lists all items in the warehouse with 
incompletely defined attributes. This report is useful to identify items 
that have incomplete set up.This information is required to execute 
warehouse operations.

Intended Audience
Warehouse managers and inbound supervisors use this report to 
proactively set up item data to carry out item transactions in the 
warehouse. The report is generated manually.

2.5.1 Generating the Report
To generate the Item Attribute Setup Report:

1. Navigate to Inbound > Item Attribute Setup Report. The Item 
Attribute Setup Report criteria screen appears. For more information 
about the Item Attribute Setup Report criteria screen, see 
Section 2.5.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Item Attribute Setup Report appears. For more information about 
the Item Attribute Setup Report layout, see Section 2.5.3.1, "Report 
Layout".

2.5.2 Report Criteria
The Item Attribute Setup Report criteria screen enables you to enter the 
criteria for which the Item Attribute Setup Report generates.
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Report Criteria

Figure 2–12 Item Attribute Setup Report Criteria Screen
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Table 2–12 Item Attribute Setup Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Product Line Select the product line 
corresponding to the 
items in the warehouse.

Click  to enter more 
product lines. These 
product lines are taken 
into consideration while 
generating the report.

Click  to remove a 
specific product line.

Blank. No

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from 
the drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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Show

Table 2–12 Item Attribute Setup Report Criteria Screen

Field Description Default Value Mandatory

Show All 
Items

Choose this to view 
the Item Attribute 
Setup Report, All 
Items, which 
displays all items 
that may or may 
not exist in the 
warehouse 
currently.

Selected. No

Show Items 
in Inventory

Choose this to view 
the Item Attribute 
Setup Report, Only 
Items In 
Inventory, which 
displays all the 
items existing in 
the warehouse.

Not 
Selected.

No

Show Items 
in 
PO/Shipment

Choose this to view 
the Item Attribute 
Setup Report, Only 
Items In 
PO/Shipment, 
which displays all 
the items in the 
purchase order or 
shipment.

Not 
Selected.

No

Show Items 
in Inventory 
and 
PO/Shipment

Choose this to view 
the Item Attribute 
Setup Report, 
Items In Inventory 
and PO/Shipment, 
which displays all 
items in the 
warehouse and in 
the PO or 
Shipment.

Not 
Selected.

No
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Item Attributes

Table 2–12 Item Attribute Setup Report Criteria Screen

Field Description Default Value Mandatory

Length Length of the 
item.

Selected. No

Width Width of the 
item.

Selected. No

Height Height of the 
item.

Selected. No

Weight Weight of the 
item.

Selected. No

Pallet 
Quantity

Quantity of the 
item in the 
pallet.

Selected. No

Case 
Quantity

Quantity of the 
item in the 
case.

Selected. No

Storage 
Type

The storage 
type of the 
item.

Selected. No

Velocity 
Code

The velocity 
code of the 
item. 

Selected. No

Hazmat 
Class

Indicates 
whether the 
material is 
hazardous.

Selected. No

Is 
Dedicated

Location 
dedicated for a 
particular 
inventory.

Selected. No
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Item Attribute Setup Report, All Items

2.5.3 Item Attribute Setup Report, All Items
This report provides a list of all items with incompletely defined 
attributes, including those items that may not exist in the warehouse.

2.5.3.1 Report Layout
This section describes the layout of the Item Attribute Setup Report, All 
Items.

Note: To generate the report, the user must select atleast 
one of the options in Item Attributes.

Note: The value of Show indicates whether the report is 
for All Items.

For the Item Attribute Setup Report for Show All Items, 
the value of Show is All Items.
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Figure 2–13 Item Attribute Setup Report, All Items 
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Item Attribute Setup Report, Only Items In Inventory

The Item Attribute Setup Report appears in portrait layout.

2.5.3.2 Group and Sort Criteria
The Item Attribute Setup Report, All Items is grouped by Enterprise Code 
and Item ID.

The Enterprise Code and Item ID are sorted in ascending order.

2.5.3.3 Page Break Criteria
The Item Attribute Setup Report, All Items has no page break criteria.

2.5.3.4 Additional Setup Required
There is no additional setup required to generate this report.

2.5.4 Item Attribute Setup Report, Only Items In 
Inventory

This report provides a list of all the items existing in the warehouse with 
incompletely defined attributes.

Table 2–13 Item Attribute Setup Report, All Items

Field Description

Enterprise The enterprise to which the shipment belongs.

Item ID The identifier assigned to the item.

Item Description The description of the item.

UOM The unit of measure for the item.

Length The length of the item.

Width The width of the item.

Height The height of the item.

Weight The weight of the item.

Hazmat Class The hazardous material to which the item belongs.

Is Dedicated This indicates if the item has a dedicated location.
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The fields, layout, group and sort criteria and page break criteria of this 
report are similar to the Item Attribute Setup Report, All Items.

2.5.5 Item Attribute Setup Report, Only Items In 
PO/Shipment

This provides a list of all the items with incompletely defined attributes in 
the purchase order or shipment.

The fields, layout, group and sort criteria and page break criteria of this 
report are similar to the Item Attribute Setup Report, All Items.

2.5.6 Item Attribute Setup Report, Items In Inventory and 
PO/Shipment

This provides a list of all the items with incompletely defined attributes in 
the warehouse, and purchase order or shipment.

Note: The value of Show indicates whether the report is 
for Only Items In Inventory. 

For Item Attribute Setup Report for Show Items in 
Inventory, the value of Show is Items in Inventory.

Note: The value of Show indicates whether the report is 
for Only Items in PO/Shipment.

For Item Attribute Setup Report for Show Items in 
PO/Shipment, the value of Show is Items in PO/Shipment.

Note: The value of Show indicates whether the report is 
for Items in Inventory and PO/Shipment.

For Item Attribute Setup Report for Show Items in 
Inventory and PO/Shipment, the value of Show is Items in 
Inventory and PO/Shipment.
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Item Attribute Setup Report, Items In Inventory and PO/Shipment

The fields, layout, group and sort criteria and page break criteria of this 
report are similar to the Item Attribute Setup Report, All Items.
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2.6 Receipt Discrepancy Report
The Receipt Discrepancy Report is used to track the receipt discrepancy 
details between the expected and received quantities, lot number, and 
serial number. The receipt discrepancy can be tracked for a particular day 
or date range. The report displays the discrepancy as Short Receipt, Over 
Receipt, or Damaged.

Intended Audience
Warehouse managers and inbound supervisors use the Receipt 
Discrepancy Report to reconcile the discrepancies in the quantity of 
shipment received. To access this report, the inbound supervisor or 
warehouse manager must belong to the data security group representing 
inbound supervisor or warehouse manager.

2.6.1 Generating the Report
To generate the Receipt Discrepancy Report:

1. Navigate to Inbound > Receipt Discrepancy Report. The Receipt 
Discrepancy Report criteria screen appears. For more information 
about the Receipt Discrepancy Report criteria screen, see 
Section 2.6.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Receipt Discrepancy Report appears. For more information about 
the Receipt Discrepancy Report layout, see Section 2.6.3, "Report 
Layout".

2.6.2 Report Criteria
The Receipt Discrepancy Report criteria screen enables you to enter the 
criteria for which the Receipt Discrepancy Report generates.

Note: The Receipt Discrepancy Report is generated only 
for shipments with orders.

This report lists receipts that are in "Receipt in progress" or 
"Received" status. Receipts that are in "Receipt started" 
status are not listed in this report.
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Figure 2–14 Receipt Discrepancy Report Criteria Screen

Table 2–14 Receipt Discrepancy Report Criteria Screen   

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For this report, the 
document types displayed 
are Blind Return, Blind 
Order, Transfer Order, 
and Purchase Order.

Purchase 
Order.

Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No
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Receipt Date Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes

Table 2–14 Receipt Discrepancy Report Criteria Screen   

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the current 
enterprise of the 
user appears as 
the user’s 
default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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2.6.3 Report Layout
This section describes the layout of the Receipt Discrepancy Report 

Seller Enter the seller 
organization for which 
the report is generated.

You can also click to 
select the seller 
organization.

Blank. No

Discrepancy 
Level

Note: To generate the report. the user must select atleast 
one of the options in the Discrepancy Level. 

Table 2–14 Receipt Discrepancy Report Criteria Screen   

Field Description Default Value Mandatory

Quantity Check this box 
to view the 
quantity 
discrepancy in 
the Receipt 
Discrepancy 
Report.

Selected. No

Lot No. Check this box 
to view the lot 
number 
discrepancy in 
the Receipt 
Discrepancy 
Report.

Selected. No

Serial No. Check this box 
to view the 
serial number 
discrepancy in 
the Receipt 
Discrepancy 
Report.

Selected. No
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Figure 2–15 Receipt Discrepancy Report, Quantity Discrepancy
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Table 2–15 Receipt Discrepancy Report, Quantity Discrepancy

Field Description

Receipt Date The date on which the inbound shipment is received.

Receipt No. The receipt number of the shipment.

Item ID The identifier of the item received.

Item Description The description of the item received.

PC The product class to which the item received belongs.

UOM The unit of measure for the item received.

Discrepancy Type The type of discrepancy in the receipt.

Expected The expected quantity of the item.

Actual The actual quantity of the item received.

Buyer The organization to which the items are shipped.

Seller The organization from where the items are shipped.
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Figure 2–16 Receipt Discrepancy Report, Lot No. Discrepancy
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Table 2–16 Receipt Discrepancy Report, Lot No. Discrepancy

Field Description

Receipt Date The date on which the inbound shipment is received.

Receipt No. The receipt number of the shipment.

Item ID The identifier of the item received.

Item Description The description of the item received.

PC The product class to which the item received belongs. 

UOM The unit of measure for the item received.

Expected Lot No. The expected lot number of the item.

Received Lot No. The actual lot number of the item received.

Buyer The organization to which the items are shipped.

Seller The organization from where the items are shipped.
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Figure 2–17 Receipt Discrepancy Report, Serial No. Discrepancy
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Additional Setup Required

The Receipt Discrepancy Report appears in portrait layout.

2.6.4 Group and Sort Criteria
The Receipt Discrepancy Report is grouped by Enterprise Code, Receipt 
Date, and item ID.

The Enterprise Code is sorted in ascending order, and Receipt Date is 
sorted in descending order.

2.6.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

2.6.6 Additional Setup Required
To obtain the quantity discrepancy data in the report, run the 
RecordReceivingDiscrepancy API.

Table 2–17 Receipt Discrepancy Report, Serial No. Discrepancy

Field Description

Receipt Date The date on which the inbound shipment is received.

Receipt No. The receipt number of the shipment.

Item ID The identifier of the item received.

Item Description The description of the item received.

PC The product class to which the item received belongs.

UOM The unit of measure for the item received.

Expected Serial No. The expected serial number of the item.

Received Serial No. The actual serial number of the item received.

Buyer The organization to which the items are shipped.

Seller The organization from where the items are shipped.
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2.7 Receipt Detail Report
The Receipt Detail Report lists the details of the shipments received for 
the selected shipment, PO, or date range. It provides details at the item 
and quantity level.

Intended Audience
Warehouse managers and inbound supervisors use the Receiving Detail 
Report to track the performance of inbound activities. The report is 
accessed by email, on a subscription basis.

2.7.1 Generating the Report
To generate the Receipt Detail Report:

1. Navigate to Inbound > Receipt Detail Report. The Receipt Detail 
Report criteria screen appears. For more information about the 
Receipt Detail Report criteria screen, see Section 2.7.2, "Report 
Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Receipt Detail Report appears. For more information about the 
Receipt Detail Report layout, see Section 2.7.3, "Report Layout".

2.7.2 Report Criteria
The Receipt Detail Report criteria screen enables you to enter the criteria 
for which the Receipt Detail Report generates.

Note: This report lists receipts that are closed.
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Figure 2–18 Receipt Detail Report Criteria Screen

Table 2–18 Receipt Detail Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

Purchase 
Order.

Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No
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Receipt Date Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes

Shipment # Enter the shipment 
number for which the 
report is generated.

You can also click to 
select the shipment 
number.

Blank. No

Order # Enter the order number 
for which the report is 
generated.

You can also click  to 
select the order number.

Blank. No

Seller Enter the seller 
organization for which 
the report is generated.

You can also click  to 
select the seller 
organization.

Blank. No

Table 2–18 Receipt Detail Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the current 
enterprise of the 
user appears as 
the user’s 
default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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2.7.3 Report Layout
This section describes the layout of the Receipt Detail Report.

Buyer Enter the buyer 
organization for which 
the report is generated.

You can also click to 
select the buyer 
organization.

Blank. No

Carrier Enter the carrier 
organization for which 
the report is generated.

You can also click  to 
select the carrier 
organization.

Blank. No

Table 2–18 Receipt Detail Report Criteria Screen

Field Description Default Value Mandatory
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Figure 2–19 Receipt Detail Report



92   Reports Guide

Additional Setup Required

The Receipt Detail Report appears in portrait layout.

2.7.4 Group and Sort Criteria
The Receipt Detail Report is grouped by Enterprise Code, Receipt Date, 
Receipt No., Order No., and Shipment No.

The Receipt Date, and Receipt No. are sorted in descending order, and 
Enterprise Code, Order No. and Shipment No. are sorted in ascending 
order.

2.7.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

2.7.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 2–19 Receipt Detail Report

Field Description

Receipt Date The date on which the inbound shipment is received.

Receipt No. The receipt number of the shipment.

Shipment No. The shipment number of the shipment received. 

Seller The organization from where the items are shipped.

Buyer The organization to which the items are shipped.

Order No. The order number of the shipment.

Item ID The identifier assigned to the item received.

Item Description The description of the item received.

PC The product class to which the item received belongs.

UOM The unit of measure for the item received.

Quantity The quantity of the item received.
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2.8 Receipt Summary Report
The Receipt Summary Report lists the receipts for the selected shipment, 
PO, or date range as well as summary receipt information at the 
shipment level.

Intended Audience
Warehouse managers and inbound supervisors use the Receipt Summary 
Report to track the performance of inbound activities. The report is 
accessed by email, on subscription.

2.8.1 Generating the Report
To generate the Receipt Summary Report:

1. Navigate to Inbound > Receipt Summary Report. The Receipt 
Summary Report criteria screen appears. For more information about 
the Receipt Summary Report criteria screen, see Section 2.8.2, 
"Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Receipt Summary Report appears. For more information about 
the Receipt Summary Report layout, see Section 2.8.3, "Report 
Layout".

2.8.2 Report Criteria
The Receipt Summary Report criteria screen enables you to enter the 
criteria for which the Receipt Summary Report generates.

Note: This report lists receipts that are closed.
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Figure 2–20 Receipt Summary Report Criteria Screen

Table 2–20 Receipt Summary Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated. 

Purchase 
Order.

Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No
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Receipt Date Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes

Shipment# Enter the shipment 
number for which the 
report is generated.

You can also click to 
select the shipment 
number.

Blank. No

Order# Enter the order number 
for which the report is 
generated.

You can also click  to 
select the order number.

Blank. No

Seller Enter the name of the 
seller organization.

You can also click  to 
select the seller 
organization.

Blank. No

Table 2–20 Receipt Summary Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to 
generate the report 
for a specific 
enterprise and select 
the enterprise name 
from the drop-down 
list. 

Not Selected.

On selecting this, 
the current 
enterprise of the 
user appears as 
the default 
enterprise.

No

Across 
Enterprises

Choose this to 
generate the report 
considering all the 
enterprises in which 
the user participates.

Selected. No
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2.8.3 Report Layout
This section describes the layout of the Receipt Summary Report.

Buyer Enter the buyer 
organization for which 
the report is generated.

You can also click  to 
select the buyer 
organization.

Blank. No

Carrier Enter the name of the 
carrier.

You can also click  to 
select the carrier.

Blank. No

Table 2–20 Receipt Summary Report Criteria Screen

Field Description Default Value Mandatory
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Figure 2–21 Receipt Summary Report
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Additional Setup Required

The Receipt Summary Report appears in portrait layout.

2.8.4 Group and Sort Criteria
The Receipt Summary Report is grouped by Enterprise Code, Shipment 
No., Receipt Date, and Receipt No.

The Enterprise Code and Receipt No. are sorted in ascending order and 
Receipt Date and Shipment No. are sorted in descending order.

2.8.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

2.8.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 2–21 Receipt Summary Report

Field Description

Shipment No. The shipment number of the shipment received. 

Click this to view the Receipt Detail Report, which lists 
the details of the shipments received.

Receipt Date The date on which the shipment is received.

Receipt No. The receipt number of the shipment.

Order No. The order number of the shipment.

Carrier/Service The carrier or service used for the shipment.

Seller The organization from where the items are shipped.

Buyer The organization to which the items are shipped.
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2.9 Shipment Billing Summary Report
The Shipment Billing Summary Report displays the number of shipments 
and shipment lines shipped, and the number of receipts and receipt lines 
received. This report also lists the transaction details for the transactions 
in the details report.

Intended Audience
Warehouse managers and inbound supervisors, as well as enterprise 
users, use the Shipment Billing summary Report to track the transactions 
made for a particular date range.

2.9.1 Generating the Report
To generate the Shipment Billing Summary Report:

1. Navigate to Inbound > Shipment Billing Summary Report. The 
Shipment Billing Summary Report criteria screen appears.

For more information about the Shipment Billing Summary Report, see 
Section 6.16, "Shipment Billing Summary Report" of Chapter 6, "  
Outbound Reports".
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2.10 Vendor Non-Compliance Report
The Vendor Non-Compliance Report displays the non-compliant 
shipments observed during the inbound process. This report helps the 
warehouse to identify the vendors shipping non-compliant shipments.

Intended Audience
Warehouse managers and enterprise users use this report to identify 
shipments that do not meet compliance requirements. 

2.10.1 Generating the Report
To generate the Vendor Non-Compliance Report:

1. Navigate to Inbound > Non Compliance Report. The Non Compliance 
Report criteria screen appears. For more information about the Non 
Compliance Report criteria screen, see Section 2.10.2, "Report 
Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Vendor Non-Compliance Report appears. For more information 
about the Vendor Non-Compliance Report for Sellers, see 
Section 2.10.3.1, "Vendor Non-Compliance Report, Seller". For more 
information about Vendor Non-Compliance Report for Carriers, see 
Section 2.10.3.2, "Vendor Non-Compliance Report, Carrier".

2.10.2 Report Criteria
The Vendor Non-Compliance Report criteria screen enables you to enter 
the criteria for which the Vendor Non-Compliance Report generates.
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Figure 2–22 Non-Compliance Report Criteria Screen
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Table 2–22 Non-Compliance Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

Current node 
of the user.

No

Enterprise Select the enterprise 
name from the 
drop-down list. 

The current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

Yes
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Discrepancy 
Level

Select any one of these levels as the discrepancy level.

It is mandatory to select a discrepancy level.

Table 2–22 Non-Compliance Report Criteria Screen

Field Description Default Value Mandatory

Shipment 
Level

Choose this to view 
the number of 
shipments in 
discrepancy, at the 
shipment level.

Selected. No

Item 
Level

Choose this to view 
the number of 
shipments in 
discrepancy, at the 
item level.

Not Selected. No

Load 
Level

Choose this to view 
the number of 
shipments in 
discrepancy, at the 
load level.

Not Selected. No

Discrepancy 
Code

Indicates the nature 
of discrepancy.

Check the 
appropriate 
discrepancy code 
from this list.

Based on the 
discrepancy level 
and discrepancy 
code selected, the 
number of 
shipments that are 
in discrepancy are 
displayed in the 
report.

Selected. No
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2.10.3 Report Layout
This section describes the report layout of the Vendor Non-Compliance 
Report for Seller and Carrier.

2.10.3.1 Vendor Non-Compliance Report, Seller
This section describes the report layout of the Vendor Non-Compliance 
Report for Seller.

Report 
Generation 
Level

Date Range Enter the start date and 
the end date for which 
the report is generated

You can also click  to 
choose the date.

The current 
date.

Yes

Table 2–22 Non-Compliance Report Criteria Screen

Field Description Default Value Mandatory

Seller Select this to view 
the Vendor 
Non-Compliance 
Report, Seller, which 
provides a detailed 
summary of the 
non-compliant 
shipments shipped 
by the vendor in a 
particular date 
range. 

 Selected. No

Carrier Select this to view 
the Vendor 
Non-Compliance 
Report, Carrier, 
which provides a 
detailed summary of 
the non-compliant 
shipments delivered 
by the carrier in a 
particular date 
range. 

Not 
Selected.

No
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Figure 2–23 Vendor Non-Compliance Report, Seller 
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Report Layout

The Vendor Non-Compliance Report for Seller appears in portrait layout.

2.10.3.2 Vendor Non-Compliance Report, Carrier
This section describes the report layout of the Vendor Non-Compliance 
Report for Carrier.

Table 2–23 Vendor Non-Compliance Report, Seller

Field Description

Vendor Indicates the name of the Vendor.

Total # of Shipments Indicates the total number of shipments shipped by 
the vendor.

# of Non Compliant 
Shipments

Indicates the total number of non-compliant 
shipments shipped by the vendor.

# of Compliant 
Shipments

Indicates the total number of compliant shipments 
shipped by the vendor.

% Compliance Indicates the total percentage of compliance.
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Figure 2–24 Vendor Non-Compliance Report, Carrier
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Additional Setup Required

 

The Vendor Non-Compliance Carrier Report appears in portrait layout.

2.10.4 Group and Sort Criteria
The Vendor Non-Compliance Report for Seller and Carrier has no group 
or sort criteria.

2.10.5 Page Break Criteria
The Vendor Non-Compliance Report for Seller and Carrier has no page 
break criteria.

2.10.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 2–24 Vendor Non-Compliance Report, Carrier 

Field Description

Carrier Indicates the name of the carrier.

Total # of Shipments Indicates the total number of shipments delivered by 
the carrier.

# of Non Compliant 
Shipments

Indicates the total number of non-compliant 
shipments delivered by the carrier. 

# of Compliant 
Shipments

Indicates the total number of compliant shipments 
delivered by the carrier.

% Compliance Indicates the total percentage of compliance.
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3
Returns Reports

The following returns report can be generated using Sterling Warehouse 
Management System:

Returns By Reason Code Report
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3.1 Returns By Reason Code Report
The Returns By Reason Code Report lists all shipments based on the 
return reason code entered during return creation. The report can also be 
viewed for only selected reason codes.

Intended Audience
Warehouse managers and inbound supervisors, as well as enterprise 
users use the Returns By Reason Code Report to verify the returns and 
also to check the reason for the large number of returns.

3.1.1 Generating the Report
To generate Returns by Reason Code Report:

1. Navigate to Returns > Returns By Reason Code Report. The Returns 
By Reason Code Report criteria screen appears. For more information 
about the Returns By Reason Code Report criteria screen, see 
Section 3.1.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Returns By Reason Code Report appears. For more information 
about the Returns By Reason Code Report layout, see Section 3.1.3, 
"Report Layout".

3.1.2 Report Criteria
The Returns By Reason Code Report criteria screen enables you to enter 
the criteria for which the Returns By Reason Code Report generates.
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Figure 3–1 Returns By Reason Code Report Criteria Screen
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Table 3–1 Returns By Reason Code Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

The document type for 
which the report is 
generated.

Return order. Yes

Node The node for which the 
report is generated.

If you are an enterprise 
user, select the 
appropriate node from 
the drop-down list. For 
other users, the current 
node of the user appears.

The current 
node of the 
user.

No

Ship Date Enter the start date and 
the end date for which 
the report is generated.

You can also click the  

and icons to choose 
the date range and time.

For Date: The 
current date. 

For Time: 
00:00:00 and 
23:59:59.

Yes

Reason Code Select the reason code 
captured while creating 
return order.

Blank. No

Product Line Select the product line 
corresponding to the item 
on the return shipment. 

Blank. No

Enterprise Chose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the current 
enterprise of the 
user appears as 
the user’s 
default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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3.1.3 Report Layout
This section describes the report layout of the Returns By Reason Code 
Report.
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Figure 3–2 Returns By Reason Code Report
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The Returns By Reason Code Report appears in portrait layout.

3.1.4 Group and Sort Criteria
The Returns By Reason Code Report is grouped by Enterprise Code, 
Return Reason, Node, Date, Shipment No. and Group Total (Return Reason 
Code).

The Return Reason is sorted in descending order, and Enterprise Code, 
Date, Shipment No. and Group Total (Return Reason Code) are sorted in 
ascending order.

Table 3–2 Returns By Reason Code Report

Fields Description

Return Reason This corresponds to the reason why the item is 
returned. 

Node The node to which the item is returned.

Date The date of dispatch of the shipment to the user.

Shipment No. The shipment number of the shipment captured at the 
time of return order creation.

Ship From The customer identifier of the customer who returned 
the item.

Item ID The item identifier of the item in the shipment.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure of the item.

Quantity The quantity of the items in one shipment.

Group Total For Return 
Reason Code

The total number of shipments returned for a 
particular enterprise with a particular reason code.

For example, E1 is the enterprise with return Reason 
Code Damaged.

Group Total For 
Enterprise

The total number of shipments summarized by 
enterprise. 

For example, E1 is such an enterprise.
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3.1.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table. 

3.1.6 Additional Setup Required
There is no additional setup required to generate this report.
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4
Inventory Reports

The following inventory reports can be generated using the Sterling 
Warehouse Management System:

Containers Not Having Standard Quantity Report

Cycle Count Variance Daily Report

Cycle Count Variance Monthly Report

Cycle Count Variance Weekly Report

Dedicated Locations Usage Report

Dedicated Locations Activity Report

Empty Location Report

Inventory Aging Report

Inventory Audit Report

Inventory Balance Report

Inventory Hold Report

Item Inventory Across Nodes Report

Item Inventory Report

Item Tag No. Report

Item Velocity Report

Location Inventory Detail Report

Location Inventory Summary Report

Location/SKU Velocity Mismatch Report
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Node Inventory Valuation Report

Participant List Report

Space Consolidation Report

Space Utilization Report

Note: The Search consoles of all the reports under the 
Inventory menu display inventory organizations in the 
Enterprise drop-down list.
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4.1 Containers Not Having Standard Quantity 
Report

The Containers Not Having Standard Quantity Report lists all cartons 
stored in the warehouse that have less than a case or pallet quantity. 
This report can be used to identify opportunities for consolidation.

Intended Audience
Warehouse managers and inventory supervisors use this report to check 
and see if the actual quantity in the cases are less or more than the 
standard quantity. It also helps to identify the opportunities for 
consolidation. To access this report, the user must belong to the data 
security group representing warehouse managers and inventory 
supervisors.

4.1.1 Generating the Report
To generate the Containers Not Having Standard Quantity Report:

1. Navigate to Inventory > Container Not Having Std. Qty. Report. The 
Containers Not Having Standard Quantity Report criteria screen 
appears. For more information about the Containers Not Having 
Standard Quantity Report criteria screen, see Section 4.1.2, "Report 
Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Containers Not Having Standard Quantity Report appears. For 
more information about the Containers Not Having Standard Quantity 
Report layout, see Section 4.1.3, "Report Layout".

4.1.2 Report Criteria
The Containers Not Having Standard Quantity Report criteria screen 
enables you to enter the criteria for which the Containers Not Having 
Standard Quantity Report generates.
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Figure 4–1 Container Not Having Std. Qty. Report Criteria Screen
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Table 4–1 Containers Not Having Standard Quantity Report 
Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Zone Enter the identifier of the 
zone for which the report 
is generated.

You can also click  to 
choose the zone.

Blank. No

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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Container Type

Container 
Having

Table 4–1 Containers Not Having Standard Quantity Report 
Criteria Screen

Field Description Default Value Mandatory

Case Check this box to 
generate the report for 
cases having quantity 
less than or more than 
the standard quantity.

Selected. Yes

Pallet Check this box to 
generate the report for 
pallets having quantity 
less than or more than 
the standard quantity.

Selected. Yes

Having more 
than 
case/pallet 
quantity

Check this box 
to view the 
Containers 
Having More 
Than Standard 
Quantity 
Report, which 
enables you to 
view 
containers with 
more than the 
standard 
quantity.

Selected. Yes

Having less 
than 
case/pallet 
quantity

Check this box 
to view the 
Containers 
Having Less 
Than Standard 
Quantity 
Report, which 
enables you to 
view 
containers with 
less than the 
standard 
quantity.

Selected. Yes
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4.1.3 Report Layout
This section describes the layout of the Containers Having More Than 
Standard Quantity Report and the Containers Having Less Than Standard 
Quantity Report.

4.1.3.1 Containers Having More Than Standard Quantity Report
The Containers Having More than Standard Quantity Report enables you 
to view containers that contain more than the standard quantity.

Note: To generate the report, the user must select one of 
the options in the Container Type and the Container Having 
area.

Select both the options in the Container Having area to 
view a combined report. This report enables you to view 
containers with more than the standard quantity as well as 
containers with less than the standard quantity, for each 
enterprise. 
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Figure 4–2 Containers Having More Than Standard Quantity 
Report
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T

The Containers Having More Than Standard Quantity Report appears in 
portrait layout.

4.1.3.2 Containers Having Less Than Standard Quantity Report
The Containers Having Less than Standard Quantity Report enables you 
to view containers that contain less than the standard quantity.

Table 4–2 Containers Having More Than Standard Quantity 
Report

Field Description

Zone ID A unique description of the zone where the item is 
placed.

Item ID The identifier of the item in the container.

Item Description The description of an item.

PC The product class of the item in the container.

UOM The unit of measure for the item.

Location ID The identifier of the location where the item is placed 
within a particular zone.

Container Type The type of container where the item is present.

Container ID A unique description of the container where the item is 
present.

Actual Quantity The actual quantity of the item in the container.

Standard Quantity The standard quantity of the item in the container.



126   Reports Guide

Report Layout

Figure 4–3 Containers Having Less Than Standard Quantity 
Report
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The Containers Having Less Than Standard Quantity Report appears in 
portrait layout.

4.1.4 Group and Sort Criteria
The Containers Not Having Standard Quantity Report is grouped by 
Enterprise Code, Zone ID, and Item ID.

Enterprise Code, Zone ID, and Item ID are sorted in ascending order.

4.1.5 Page Break Criteria
The Containers Not Having Standard Quantity Report has no page break 
criteria.

4.1.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 4–3 Containers Having Less Than Standard Quantity 
Report

Field Description

Zone ID A unique description of the zone where the item is 
placed.

Item ID The identifier of the item in the container.

Item Description The description of an item.

PC The product class of the item in the container.

UOM The unit of measure for the item.

Location ID The identifier of the location where the item is placed 
within a particular zone.

Container Type The type of container where the item is present.

Container ID A unique description of the container where the item 
is present.

Actual Quantity The actual quantity of the item in the container.

Standard Quantity The standard quantity of the item in the container.
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Report Criteria

4.2  Cycle Count Variance Daily Report
The Cycle Count Variance Daily Report provides cycle count variance 
information on a daily basis for a given date range.

Intended Audience
Warehouse managers, inventory supervisors, and as well as the 
enterprise users use this report to monitor inventory accuracies with 
indicators like percentage variance, variance value in Nodes’ locale 
currency at an item location level.

4.2.1 Generating the Report
To generate the Cycle Count Variance Daily Report:

1. Navigate to Inventory > Cycle Count Variance Daily Report. The Cycle 
Count Variance Daily Report criteria screen appears. For more 
information about the Cycle Count Variance Daily Report criteria 
screen see Section 4.2.2, "Report Criteria".

2. Enter the criteria and click Generate Report. The Cycle Count 
Variance Daily Report appears. For more information about the Cycle 
Count Variance Daily Report layout, see Section 4.2.3, "Report 
Layout".

4.2.2 Report Criteria
The Cycle Count Variance Daily Report criteria screen enables you to 
enter the criteria for which the Cycle Count Variance Daily Report 
generates.
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Figure 4–4 Cycle Count Variance Daily Criteria Screen

.
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Report Criteria

Table 4–4 Cycle Count Variance Daily Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

If you are an enterprise 
user, select the 
appropriate node from 
the drop-down list. For 
other users, the current 
node of the user appears.

The current 
node of the 
user.

No

Date Range Enter the start date and 
the end date for which 
the report is generated.

You can also click the  

icons to choose the date 
range.

The current 
date.

Yes

Zone Enter the identifier of the 
zone for which the report 
is generated.

You can also click  to 
choose the zone.

The current 
zone of the 
user.

Yes

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Chose this to generate the 
report considering all the 
enterprises in which the 
user participates.

Selected. No
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4.2.3 Report Layout
This section describes the layout of the Cycle Count Variance Daily 
Report.

Velocity Code Select the Velocity Code 
from the drop-down 
menu.

Blank. No

Product Line Select the product line 
from the drop-down 
menu.

Blank. No

Table 4–4 Cycle Count Variance Daily Report Criteria Screen

Field Description Default Value Mandatory
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Report Layout

Figure 4–5 Cycle Count Variance Daily Report 
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Table 4–5 Cycle Count Variance Daily Report 

Field Description

Node The node for which the report is generated.

Date The date on which the counting task takes place.

Item ID The identifier of the item.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Location ID The identifier of the location where the item is placed.

Container Type The type of container in which the item is placed.

Container No. The container identifier of the shipment in which the 
item is placed.

System Quantity The quantity of the item as recorded in the system.

Count Quantity The actual quantity counted by the user.

Variance Quantity The difference between the System Quantity and the 
Count Quantity.

Absolute Variance 
Quantity

The absolute of variance quantity. 

Even when the Variance Quantity is negative, the 
Absolute Variance Quantity is considered to be 
positive.

% Variance If System Quantity is zero than % Variance is 100.

If System Quantity is not zero than % Variance is 
calculated as follows:

% Variance = (Absolute Variance Quantity 
/ System Quantity) x 100.

Accuracy If Count Quantity is zero than Accuracy is zero.

If Count Quantity is not zero than Accuracy is 
calculated as follows:

Accuracy = (Count Quantity / System 
Quantity) x 100.

Variance Value The product of the unit cost of the item and the 
absolute variance quantity.

Variance Currency The currency of Variance Value.
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Additional Setup Required

Report Totals: The report total displays the summary of Location IDs, 
System Quantities, Count Quantities, Variance Quantities, and the 
Variance Values considering all the items.

The Cycle Count Variance Daily Report appears in portrait layout.

4.2.4 Group and Sort Criteria
The Cycle Count Variance Daily Report is grouped by Date, Enterprise 
Code, Item ID, and UOM.

The Date and Enterprise Code are sorted in ascending order. Within a 
specific Date, the Item ID is sorted in ascending order and within a 
specific Item ID, the UOM is sorted in ascending order.

4.2.5 Page Break criteria
The Cycle Count Variance Daily Report has no page break criteria.

4.2.6 Additional Setup Required
There is no additional setup required to generate this report.
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4.3 Cycle Count Variance Monthly Report
The Cycle Count Variance Daily Report provides cycle count variance 
information on a monthly basis for a given date range.

Intended Audience
Warehouse managers, inventory supervisors, and enterprise users use 
this report to monitor inventory accuracies with indicators like 
percentage variance, variance value in Nodes’ locale currency at an item 
location level.

4.3.1 Generating the Report
To generate the Cycle count Variance Monthly Report:

1. Navigate to Inventory > Cycle Count Variance Monthly Report.The 
Cycle Count Variance Monthly Report criteria screen appears. For 
more information about the Cycle Count Variance Monthly Report 
criteria screen, see Section 4.3.2, "Report Criteria".

2. Enter the criteria and click Generate Report. The Cycle Count 
Variance Monthly Report screen appears. For more information about 
the Cycle Count Variance Monthly Report layout, see Section 4.3.3, 
"Report Layout".

4.3.2 Report Criteria
The Cycle Count Variance Monthly Report criteria screen enables you to 
enter the criteria for which the Cycle Count Variance Monthly Report 
generates.
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Report Criteria

Figure 4–6 Cycle Count Variable Monthly Report Criteria Screen
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Table 4–6 Cycle Count Variance Monthly Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

If you are an enterprise 
user, select the 
appropriate node from 
the drop-down list. For 
other users, the current 
node of the user appears.

The current 
node of the 
user.

No

Date Range Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The previous 
month’s date 
and current 
date.

Yes

Zone Enter the identifier of the 
zone for which the report 
is generated.

You can also click  to 
choose the zone.

Blank. No

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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Report Layout

4.3.3 Report Layout
This section describes the report of the Cycle Count Variance Monthly 
Report.

Velocity Code Select the velocity code 
from the drop-down 
menu.

Blank. No

Product Line Select the product line 
from the drop-down 
menu.

Blank. No

Table 4–6 Cycle Count Variance Monthly Report Criteria Screen

Field Description Default Value Mandatory



Report Layout

Inventory Reports   139

Figure 4–7 Cycle Count Variance Monthly Report 
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Report Layout

The Cycle Count Variance Monthly Report appears in portrait layout.

Table 4–7 Cycle Count Variable Monthly Report 

Field Description

Node The node for which the report is generated.

Month Begins On The date on which the count task begins.

Month Ends On The date on which the month ends along with the 
count task.

Locations Counted The number of locations for which the count task was 
performed.

Locations With 
Variance

The locations which showed variance.

System Quantity The quantity defined with the Selling and Fulfillment 
Foundation.

Count Quantity The actual quantity counted by the user.

Variance Quantity The difference between the system quantity and the 
count quantity.

Absolute Variance 
Quantity

The sum of absolute of variance quantity.

Even when the Variance Quantity is negative, the 
Absolute Variance Quantity is considered to be 
positive.

% Variance If System Quantity is zero than Variance percentage is 
100.

If System Quantity is not zero than Variance 
percentage is calculated as follows:

Variance percentage = (Absolute Variance 
Quantity / System Quantity) x 100.

Accuracy If Count Quantity is zero than Accuracy is 0.

If Count Quantity is not zero than Accuracy is 
calculated as follows:

Accuracy = (Count Quantity / System 
Quantity) x 100.

Variance Value The product of unit cost of the item and the absolute 
variance quantity.

Variance Currency The currency of Variance Value.
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4.3.4 Group and Sort Criteria
The Cycle Count Variance Monthly Report has no group criteria or sort 
criteria.

4.3.5 Page Break Criteria
The Cycle Count Variance Monthly Report has no page break criteria.

4.3.6 Additional Setup Required
There is no additional setup required to generate this report.
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Report Criteria

4.4 Cycle Count Variance Weekly Report
The Cycle Count Variance Weekly Report provides cycle count variance 
information on a weekly basis for a given date range.

Intended Audience
Warehouse managers, inventory supervisors, and enterprise users use 
this report to monitor inventory accuracies with indicators like 
percentage variance, variance value in Nodes’ locale currency at an item 
location level.

4.4.1 Generating the Report
To generate the Cycle Count Variance Weekly Report:

1. Navigate to Inventory > Cycle Count Variance Weekly Report. The 
Cycle Count Variance Weekly Report criteria screen appears. For more 
information about the Cycle Count Variance Weekly Report criteria 
screen, see Section 4.4.2, "Report Criteria".

2. Enter criteria and click Generate Report. The Cycle Count Variance 
Weekly Report Screen appears. For more information about the Cycle 
Count Variance Weekly Report layout, see Section 4.4.3, "Report 
Layout". 

4.4.2 Report Criteria
The Cycle Count Variance Weekly Report criteria screen enables you to 
enter the criteria for which the Cycle Count Variance Weekly Report 
generates.
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Figure 4–8 Cycle Count Variance Weekly Criteria Screen
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Report Criteria

Table 4–8 Cycle Count Variance Weekly Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

If you are an enterprise 
user, select the 
appropriate node from 
the drop-down list. For 
other users, the current 
node of the user appears.

The current 
node of the 
user.

No

Date Range Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The previous 
week’s date 
and current 
date.

Yes

Zone Enter the identifier of the 
zone for which the report 
is generated.

You can also click  to 
choose the zone.

Blank. Yes

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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4.4.3 Report Layout
This section describes the layout of the Cycle Count Variance Weekly 
Report.

Velocity Code Select the velocity code 
from the drop-down 
menu.

Blank. No

Product Line Select the product line 
from the drop-down 
menu.

Blank. No

Table 4–8 Cycle Count Variance Weekly Criteria Screen

Field Description Default Value Mandatory
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Report Layout

Figure 4–9 Cycle Count Variance Weekly Report 
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The Cycle Count Variance Weekly Report appears in portrait layout.

Table 4–9 Cycle Count Variance weekly Report 

Field Description

Node The node for which the report is generated.

Week Begins On The date on which the count task begins.

Week Ends On The date on which the week ends along with the count 
task.

Locations Counted The number of locations for which the count task was 
performed.

Locations With 
Variance

The locations which showed variance.

System Quantity The quantity defined with the Selling and Fulfillment 
Foundation.

Count Quantity The actual quantity counted by the user.

Variance Quantity The difference between the system quantity and the 
count quantity.

Absolute Variance 
Quantity

The sum of absolute of variance quantity. 

Even when the Variance Quantity is negative, the 
Absolute Variance Quantity is considered to be 
positive.

% Variance If System Quantity is zero than Variance percentage is 
100.

If System Quantity is not zero than Variance 
percentage is calculated as follows:

Variance percentage = (Absolute Variance 
Quantity / System Quantity) x 100.

Accuracy If Count Quantity is zero than Accuracy is 0.

If Count Quantity is not zero than Accuracy is 
calculated as follows:

Accuracy = (Count Quantity / System 
Quantity) x 100.

Variance Value The product of the unit cost of the item and the 
absolute variance quantity.

Variance Currency The currency of Variance Value.
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Additional Setup Required

4.4.4 Group and Sort criteria
The Cycle Count Variance Weekly Report has no group criteria or sort 
criteria.

4.4.5 Page Break criteria
The Cycle Count Variance Weekly Report has no page break criteria.

4.4.6 Additional Setup Required
There is no additional setup required to generate this report.
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4.5 Dedicated Locations Usage Report
The Dedicated Locations Usage Report provides visibility into locations 
that are dedicated for certain Stock Keeping Units (SKUs). The usage 
report shows the locations that have remained unused in different time 
buckets.

Intended Audience
Warehouse managers and inventory supervisors use this report to track 
the number of locations that are left unused. To access this report, the 
user must belong to the data security group representing warehouse 
managers and inventory supervisors.

4.5.1 Generating the Report
To generate the Dedicated Locations Usage Report:

1. Navigate to Inventory > Dedicated Locations Usage Report. The 
Dedicated Locations Usage Report criteria screen appears. For more 
information about the Dedicated Locations Usage Report criteria 
screen, see Section 4.5.2, "Report Criteria".

2. Enter the criteria and click Generate Report. The Dedicated Locations 
Usage Report Screen appears. For more information about the 
Dedicated Locations Usage Report layout, see Section 4.5.3, "Report 
Layout". 

4.5.2 Report Criteria
The Dedicated Locations Usage Report criteria screen enables you to 
enter the criteria for which the Dedicated Locations Usage Report 
generates.
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Report Layout

Figure 4–10 Dedicated Locations Usage Report Criteria Screen

4.5.3 Report Layout
This section describes the layout of the Dedicated Locations Usage 
Report.

Table 4–10 Dedicated Locations Usage Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Zone Enter the zone for which 
the report is generated.

You can also click  to 
choose the zone. 

Click  to enter more 
zones. These zones are 
taken into consideration 
while generating the 
report.

Click  to remove a 
specific zone.

Blank. No



Report Layout

Inventory Reports   151

Figure 4–11 Dedicated Locations Usage Report
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Report Layout

Note: Based on the number of days for which locations 
are unused in a warehouse, the Dedicated Locations Usage 
Report displays one or more of the following columns:

No. of Locations Unused for more than 7 days

No. of Locations Unused for more than 15 days

No. of Locations Unused for more than 30 days

No. of Locations Unused for more than 90 days

Table 4–11 Dedicated Locations Usage Report 

Field Description

Zone ID A unique description of the zone.

No. of Dedicated 
Locations

The total number of dedicated locations.

Click this to view the Dedicated Locations Summary 
Report.

No. of Locations 
Unused for more than 
7 days

The total number of locations that have not been used 
for more than seven days.

Click this to view the Dedicated Locations Unused for 
More Than 7 Days, which displays the details of the 
locations which have not been used for more than 7 
days.

No. of Locations 
Unused for more than 
15 days

The total number of locations which have not been 
used for more than fifteen days.

Click this to view Dedicated Locations Unused for More 
Than 15 Days, which displays the details of the 
locations which have not been used for more than 15 
days.
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The Dedicated Locations Usage Report appears in portrait layout.

4.5.4 Group and Sort Criteria
The Dedicated Locations Usage Report is grouped by Zone ID. 

The Zone ID is sorted in descending order.

4.5.5 Page Break Criteria
The Dedicated Locations Usage Report has no page break criteria.

4.5.6 Additional Setup Required
There is no additional setup required to generate this report.

4.5.7 Dedicated Locations Summary Report
The Dedicated Locations Summary Report explains the number of active 
locations and the number of locations used at different intervals.

4.5.7.1 Report Layout
This section describes the layout of the Dedicated Locations Summary 
Report.

No. of Locations 
Unused for more than 
30 days

The total number of locations which have not been 
used for more than thirty days.

Click this to view Dedicated Locations Unused for More 
Than 90 Days, which displays the details of the 
locations which have not been used for more than 30 
days.

No. of Locations 
Unused for more than 
90 days

The total number of locations which have not been 
used for more than ninety days.

Click this to view Dedicated Locations Unused for More 
Than 30 Days, which displays the details of the 
locations which have not been used for more than 90 
days.

Table 4–11 Dedicated Locations Usage Report 

Field Description
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Dedicated Locations Summary Report

Figure 4–12  Dedicated Locations Summary Report
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The Dedicated Locations Summary Report appears in portrait layout. 

4.5.7.2 Group and Sort Criteria
The Dedicated Locations Summary Report has no group criteria and sort 
criteria.

4.5.7.3 Page Break Criteria
The Dedicated Locations Summary Report has no page break criteria.

4.5.8 Dedicated Locations Unused for More Than 7 Days
This report provides details about the dedicated locations which are 
unused for more than 7 days.

The fields, layout, group and sort criteria and page break criteria of this 
report are similar to the Dedicated Locations Unused for More Than 30 
Days.

4.5.9 Dedicated Locations Unused for More Than 15 Days
This report provides details about the dedicated locations which are 
unused for more than 15 days.

Table 4–12 Dedicated Locations Summary Report

Field Description

Regions of this color indicates the number of locations 
that are unused for more than 30 days.

In the above example, the number of locations that 
are unused for more than 30 days is 1.

Regions of this color indicates the number of locations 
that are unused for more than 7 days.

In the above example, the number of locations that 
are unused for more than 7 days is 1.

Regions of this color indicates the number of locations 
that are unused for more than 90 days.

In the above example, number of locations that are 
unused for more than 90 days is 1.
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Dedicated Locations Unused for More Than 30 Days

The fields, layout, group and sort criteria and page break criteria of this 
report are similar to the Dedicated Locations Unused for More Than 30 
Days.

4.5.10 Dedicated Locations Unused for More Than 30 Days
This report provides details about the dedicated locations which are 
unused for more than 90 days.

4.5.10.1 Report Layout
This section describes the layout of the Dedicated Locations Unused for 
Different Intervals.
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Figure 4–13 Dedicated Locations Unused for More Than 30 Days
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Dedicated Locations Unused for More Than 90 Days

The Dedicated Locations Unused For More Than 30 Days appears in 
portrait layout.

4.5.10.2 Group and Sort Criteria
This report is grouped by Last Activity Date, Location ID, Item ID, and 
Item Description.

Last Activity Date and Location ID are sorted in ascending order. Within 
Location ID, the Item ID and Item Description are sorted in ascending 
order.

4.5.10.3 Page Break Criteria
This report has no page break criteria.

4.5.11 Dedicated Locations Unused for More Than 90 Days
This report provides details about the dedicated locations which are 
unused for more than 30 days.

The fields, layout, group and sort criteria and page break criteria of this 
report are similar to the Dedicated Locations Unused for More Than 30 
Days.

Table 4–13 Dedicated Locations Unused for More Than 30 Days

Field Description

Last Activity Date The date on which the activity was last performed.

Location ID The identifier of the location where the items are 
placed.

Item ID The identifier of the item.

Item Description The description of the item.

PC The product class to which the item belongs

UOM The unit of measure for the item.

Inventory Organization 
Code

The Inventory Organization Code.
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4.6 Dedicated Locations Activity Report
The Dedicated Locations Activity Report provides visibility into locations 
that are dedicated for certain Stock Keeping Units (SKUs). The activity 
report categorizes the locations based on the number of times that the 
location is replenished.

Intended Audience
Warehouse managers, inbound supervisors, inventory supervisors, and 
outbound supervisors use this report to track locations that are dedicated 
to certain Stock Keeping Units. To access this report, the user must 
belong to the data security group representing warehouse managers.

4.6.1 Generating the Report
To generate the Dedicated Locations Activity Report:

1. Navigate to Inventory > Dedicated Locations Activity Report. The 
Dedicated Locations Activity Report criteria screen appears. For more 
information about the Dedicated Locations Activity Report criteria 
screen, see Section 4.6.2, "Report Criteria".

2. Enter the criteria and click Generate Report. The Dedicated Locations 
Activity Report appears. For more information about the Dedicated 
Locations Activity Report, see Section 4.6.3, "Report Layout". 

4.6.2 Report Criteria
The Dedicated Locations Activity Report criteria screen enables you to 
enter the criteria for which the Dedicated Locations Activity Report 
generates.
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Report Layout

Figure 4–14 Dedicated Locations Activity Report Criteria Screen

4.6.3 Report Layout
This section describes the layout of the Dedicated Locations Activity 
Report.

Table 4–14 Dedicated Locations Activity Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Zone Enter the zone for which 
the report is generated.

You can also click  to 
choose the zone.

Click  to enter more 
zones. These zones are 
taken into consideration 
while generating the 
report.

Click  to remove a 
specific zone.

Blank. No

Display 
Replenishment 
for Past Days

Enter the number of past 
days to display 
replenishment.

90. Yes
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Figure 4–15 Dedicated Locations Activity Report 
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Group and Sort Criteria

The Dedicated Locations Activity Report appears in portrait layout.

4.6.4 Group and Sort Criteria
The Dedicated Locations Activity Report is grouped by zone.

The zone is sorted in ascending order. 

Table 4–15 Dedicated Locations Activity Report 

Field Description

Zone The zone where the items are present.

No. Of Dedicated 
Locations

The total number of dedicated locations.

Click this to see the Dedicated Locations Activity 
Summary Report, which displays the summary of all 
the locations dedicated for certain SKUs.

No. of Locations with 
Replenishment 1-5

The number of locations with replenishments between 
1 and 5.

Click this to see the Dedicated Location Activity Detail 
Report, Locations With Replenishment 1-5, which 
provides details of the locations with replenishment 
between 1 and 5. 

No. of Locations with 
Replenishment 6-10

The number of locations with replenishments between 
6 and 10.

Click this to see the Dedicated Location Activity Detail 
Report, Locations With Replenishment 6-10, which 
provides details of the locations with replenishment 
between 6 and 10.

No. of Locations with 
Replenishment 11-25

The number of locations with replenishments between 
11 and 25.

Click this to see the Dedicated Location Activity Detail 
Report, Locations With Replenishment 11-25, which 
provides details of the locations with replenishment 
between 11 and 25.

No. of Locations with 
Replenishment > 25

The number of locations with replenishments greater 
than 25.

Click this to see the Dedicated Location Activity Detail 
Report, Locations With Replenishment >25, which 
provides details of the locations with replenishment 
greater than 25.
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4.6.5 Page Break Criteria
The Dedicated Locations Activity Report has no page break criteria.

4.6.6 Additional Setup Required
There is no additional setup required to generate this report.

4.6.7 Dedicated Locations Activity Summary Report
The Dedicated Locations Activity Summary Report provides details of the 
number of locations that have replenishments in different ranges.

4.6.7.1 Report Layout
This section describes the layout of the Dedicated Locations Activity 
Summary Report.
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Dedicated Locations Activity Summary Report

Figure 4–16 Dedicated Locations Activity Summary Report
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The Dedicated Locations Activity Summary Report appears in portrait 
layout

4.6.7.2 Group and Sort Criteria
The Dedicated Locations Activity Summary Report is grouped by Location 
ID.

The Location ID is sorted in ascending order. 

4.6.7.3 Page Break Criteria
The Dedicated Locations Activity Summary Report has no page break 
criteria.

4.6.8 Dedicated Location Activity Detail Report, Locations
With Replenishment 1-5

The Dedicated Locations Activity Report, Locations With Replenishment 
1-5 provides details of the locations that have replenishments in the 
range of 1-5.

Table 4–16 Dedicated Locations Activity Summary Report

Field Description

Location ID The identifier of the location.

Available Volume The volume available for the items to be placed in a 
particular location within a particular zone.

Volume UOM The unit of measure of volume.

Available Weight The difference between the maximum weight that the 
location can withstand and the total weight of the 
items present in that location.

Weight UOM The unit of measure of weight.

Enterprise The enterprise for which the report is generated.

Item ID The identifier of the item.

Item Description The description of the item.

UOM The unit of measure for the item.

PC The product class to which the item belongs.
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Dedicated Location Activity Detail Report, Locations With Replenishment 1-5

4.6.8.1 Report Layout
This section describes the layout of the Dedicated Locations Activity 
Detail Report, Locations With Replenishment 1-5.
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Figure 4–17 Dedicated Locations Activity Detail Report, Locations With 
Replenishment 1-5 
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Dedicated Location Activity Detail Report, Locations With Replenishment 6-10

The Dedicated Locations Activity Detail Report, Locations With 
Replenishment 1-5 appears in portrait layout.

4.6.8.2 Group and Sort Criteria
The Dedicated Locations Activity Report, Locations With Replenishment 
1-5 is grouped by Location ID.

The Location ID is sorted in ascending order. 

4.6.8.3 Page Break Criteria
The Dedicated Locations Activity Report, Locations With Replenishment 
1-5 has no page break criteria.

4.6.9 Dedicated Location Activity Detail Report,
Locations With Replenishment 6-10

The Dedicated Locations Activity Report, Locations With Replenishment 
6-10 provides details of the locations that have replenishments in the 
range of 6-10.

The fields, layout, group and sort criteria, and page break criteria of this 
report are similar to the Dedicated Location Activity Detail Report, 
Locations With Replenishment 1-5.

Table 4–17 Dedicated Locations Activity Detail Report, Locations With 
Replenishment 1-5

Field Description

Location ID The identifier of the location.

Enterprise The enterprise for which the report is generated.

Item ID The identifier of the item.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.
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4.6.10 Dedicated Location Activity Detail Report,
Locations With Replenishment 11-25

The Dedicated Locations Activity Report, Locations With Replenishment 
11-25 provides details of the locations that have replenishments in the 
range of 11-25.

The fields, layout, group and sort criteria, and page break criteria of this 
report are similar to the Dedicated Location Activity Detail Report, 
Locations With Replenishment 1-5.

4.6.11 Dedicated Location Activity Detail Report,
Locations With Replenishment >25

The Dedicated Locations Activity Report, Locations With Replenishment > 
25 provides details of the locations that have replenishments in the range 
> 25.

The fields, layout, group and sort criteria, and page break criteria of this 
report are similar to the Dedicated Location Activity Detail Report, 
Locations With Replenishment 1-5.
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4.7 Empty Location Report
The Empty Location Report displays the list of empty locations in the 
warehouse. This report can also be accessed as a sub-report from the 
Space Utilization Report.

Intended Audience
Warehouse managers and inventory supervisors use Empty Location 
Report to check for any changes in the inventory due to transactions. The 
report is generated manually.

4.7.1 Generating the Report
To generate an Empty Location Report:

1. Navigate to Inventory > Empty Location Report. The Empty Location 
Report criteria screen appears. For more information about the Empty 
Location Report criteria screen, see Section 4.7.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Empty Location Report appears. For more information about the 
Empty Location Report layout, see Section 4.7.3, "Report Layout".

4.7.2 Report Criteria
The Empty Location Report criteria screen enables you to enter the 
criteria for which the Empty Location Report generates.

Figure 4–18 Empty Location Report Criteria screen
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4.7.3 Report Layout
This section describes the layout of the Empty Location Report.

Table 4–18 Empty Location Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Zone Enter the zone for which 
the report is generated.

You can also click  to 
choose the zone.

Click  to enter more 
zones. These zones are 
taken into consideration 
while generating the 
report.

Click  to remove the 
specific zone.

Blank. No

Location Size 
Code

Enter the size code of the 
location.

Click  to enter more 
location size codes. These 
size codes are taken into 
consideration while 
generating the report.

Click  to remove a 
specific size code.

Blank. No
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Report Layout

Figure 4–19 Empty Location Report
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The Empty Location Report appears in portrait layout.

4.7.4 Group and Sort Criteria
The Empty Location Report is grouped by Location Type.

The report is sorted by Location Type, Location ID, and Location Size 
Code in ascending order.

4.7.5 Page Break Criteria
The Empty Location Report has no page break criteria.

4.7.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 4–19 Empty Location Report

Field Definition

Location Type The type specified for a location which indicates the 
purpose the location serves.

Location ID The identifier of the location.

Location Size Code The code which represents the storage capacity of the 
location.

Aisle Number The number of the aisle in which the empty locations 
exist.

Level Number The number of the level in which the empty locations 
exist. 

Bay Number The number of the bay in which the empty locations 
exist.

Current Available 
Volume

The volume of the location available for usage.

Pend In Volume Volume of items awaited in the near future for that 
particular location.

Net Available Volume The actual volume available for usage.
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4.8 Inventory Aging Report
The Inventory Aging Report provides the inventory age identified by its 
receipt date. In case the receipt date information is lost, the inventory 
age cannot be ascertained and is therefore classified as "Inventory with 
Unknown Age". The number of columns in the report varies with the 
number of items in the inventory based on their age.

Intended Audience
Warehouse managers and inventory supervisors use this report to 
identify the age of the inventory by its receipt date. To access this report, 
the user must belong to the data security group representing warehouse 
managers.

4.8.1 Generating the Report
To generate the Inventory Aging Report

1. Navigate to Inventory > Inventory Aging Report. The Inventory Aging 
Report criteria screen appears. For more information about The 
Inventory Aging Report criteria screen, see Section 4.8.2, "Report 
Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Inventory Aging Report appears. For more information about the 
layout of the Inventory Aging Report, see Section 4.8.3, "Report 
Layout".

4.8.2 Report Criteria
The Inventory Aging Report criteria screen enables you to enter the 
criteria for which the Inventory Aging Report generates. 
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Figure 4–20 Inventory Aging Report Criteria Screen

 

Table 4–20 Inventory Aging Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
enterprises in which the 
user participates.

Selected. No
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4.8.3 Report Layout
This section describes the layout of the Inventory Aging Report.

Product Class The product class of the 
item.

You can select the 
product class from the 
drop-down menu.

Click to enter more 
product class. These 
product class are taken 
into consideration while 
generating the report.

Click to remove the 
specific product class.

Blank. No

Product Line The product line of the 
item.

You can select the 
product line from the 
drop-down menu.

Click to enter more 
product line. These 
product line are taken 
into consideration while 
generating the report.

Click to remove the 
specific product line.

Blank. No

Table 4–20 Inventory Aging Report Criteria Screen

Field Description Default Value Mandatory
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Figure 4–21 Inventory Aging Report 
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Note: Based on the age of the inventories available in 
the warehouse, the Inventory Aging Report displays one or 
more of the following columns:

Inventory Age Less than 1 Month

Inventory Age More than 1 Month

Inventory Age More than 2 Months

Inventory Age More than 3 Months

Inventory Age Unknown

Table 4–21 Inventory Aging Report Item Description

Field Description

Currency The currency in which the item is priced.

Product Line The product line in which the item is present.

Item ID The identifier of the item.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Table 4–22 Inventory Aging Less Than 1 Month

Field Description

Quantity The quantity of inventory aging less than 1 month. 

Click this to view the Inventory Aging Detail Report for 
Inventory Aging Less than One Month.

Table 4–26 provides information about the field 
descriptions of this report.

Value The value of the item.

# of Locations The number of locations for an item in the inventory.
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The Inventory Aging Report appears in portrait layout.

4.8.4 Group and Sort Criteria
The Inventory Aging Report is grouped by Cost currency, Product line, 
Item ID, UOM and Product Class.

Table 4–23 Inventory Aging More Than 1 Month

Field Description

Quantity The quantity of inventory aging more than 1 month. 

Click this to view the Inventory Aging Detail Report for 
Inventory Aging More Than One Month.

Table 4–26 provides information about the field 
descriptions of this report.

Value The value of the item.

# of Locations The number of locations for an item in the inventory.

Table 4–24 Inventory With Unknown Age

Field Description

Quantity The quantity of inventory with unknown age.

Click this to view the Inventory Aging Detail Report for 
Unknown Inventory Age.

Table 4–26 provides information about the field 
descriptions of this report.

Value The value of the item.

# of Locations The number of locations for an item in the inventory.

Table 4–25  Total Inventory

Field Description

Quantity The quantity of total inventory.

Value The value of the item.

# of Locations The number of locations for an item in the inventory.
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Inventory Aging Detail Report for Inventory Aging Less than One Month

The Cost Currency, Product Line, Item ID, UOM and Product Class are 
sorted in ascending order.

4.8.5 Page Break criteria
The Inventory Aging Report has no page break criteria.

4.8.6 Inventory Aging Detail Report for Inventory
Aging Less than One Month

The Inventory Aging Detail Report for Inventory Aging Less than 1 Month 
explains in detail about the Inventory Aging less than a month.

4.8.6.1 Report Layout
This section describes the layout of the Inventory Aging Report.
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Figure 4–22 Inventory Aging Detail Report for Inventory Aging Less 
than 1 month
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Inventory Aging Detail Report for Inventory Aging More Than One Month.

The Inventory Aging Report for Inventory Aging Less than 1 Month 
appears in portrait layout.

4.8.6.2 Group and Sort Criteria
The Inventory Aging Report for Inventory Aging Less than 1 Month is 
grouped by Receipt Date, Item ID, UOM, Short Description, and Location 
ID.

The Receipt Date is sorted in descending order.

4.8.6.3 Page Break Criteria
The Inventory Aging Report for Inventory Aging Less than 1 Month has 
no page break criteria.

4.8.6.4 Additional Setup Required
There is no additional setup required to generate this report.

4.8.7 Inventory Aging Detail Report for Inventory
Aging More Than One Month.

The Inventory Aging Detail Report for Inventory Aging More than 1 
Month Report explains in detail about the items in the inventory whose 
age is more than 1 month.

Table 4–26 Inventory Aging Detail Report for Inventory Aging Less than 
1 month

Field Description

Receipt Date The date on which the item was received.

Item ID The identifier of the item.

Item Description The description of the item.

Product Class  The product class to which the item belongs. 

UOM The unit of measure for the item.

Location ID A unique description of the location.

Quantity The quantity of the item within that location.
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The fields, layout, group and sort criteria and page break criteria of this 
report are similar to the Inventory Aging Detail Report for Inventory 
Aging Less than One Month.

4.8.8 Inventory Aging Detail Report for Unknown 
Inventory Age

The Inventory Aging Detail report for Unknown Inventory Age report 
explains in detail about the items in the inventory whose age is unknown.

The fields, layout, group and sort criteria and page break criteria of this report 
are similar to the Inventory Aging Detail Report for Inventory Aging Less than 
One Month.
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4.9 Inventory Audit Report
The Inventory Audit Report enables you to track inventory changes 
resulting from the execution of tasks in the warehouse. This report helps 
you track changes to item or location inventory, inventory changes done 
by a user, or a combination of these.

Intended Audience
Warehouse managers and inventory supervisors use the Inventory Audit 
Report to check for any changes in the inventory due to transactions. The 
report is generated manually.

4.9.1 Generating the Report
To generate the Inventory Audit Report:

1. Navigate to Inventory > Inventory Audit Report. The Inventory Audit 
Report criteria screen appears. For more information about the 
Inventory Audit Report criteria screen, see Section 4.9.2, "Report 
Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Inventory Audit Report appears. For more information about the 
Inventory Audit Report layout, see Section 4.9.3, "Report Layout".

4.9.2 Report Criteria
The Inventory Audit Report criteria screen enables you to enter the 
criteria for which the Inventory Audit Report generates.
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Figure 4–23 Inventory Audit Report Criteria Screen
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Table 4–27 Inventory Audit Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report is 
generated.

The current 
node of the 
user.

No

Audit Date Enter the start date, end date 
and the time period for which 
the report is generated.

You can also click the  and  
icons to choose the date range 
and time.

The current 
date. 

The time is 
00:00:00 and 
23:59:59.

Yes

Zone Enter the zone for which the 
report is generated.

You can also click  to choose 
zone.

Click  to enter more zones. 
These zones are taken into 
consideration while generating 
the report.

Click  to remove a specific 
zone.

Blank. No

Enterprise Choose this to generate the 
report for a specific enterprise 
and select the enterprise name 
from the drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate the 
report considering all the 
enterprises in which the user 
participates.

Selected. No
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Location Enter the location for which the 
report is generated.

You can also click  to choose 
location.

Click to enter more locations. 
These locations are taken into 
consideration while generating 
the report.

Click to remove a specific 
location.

Blank. No

Item ID Enter the identifier of the item. 

You can also click  to choose 
Item ID.

Click to enter more Item IDs. 
These Item IDs are taken into 
consideration while generating 
the report.

Click to remove a specific 
Item ID.

Blank. No

Product 
Class

Select the product class.

Click to enter more product 
classes. These product classes 
are taken into consideration 
when generating the report.

Click to remove a specific 
product class.

Blank. No

Unit Of 
Measure

Enter the unit of measure of the 
item.

You can also select the UOM 
from the drop-down menu.

Blank No

Table 4–27 Inventory Audit Report Criteria Screen

Field Description Default Value Mandatory
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User ID The identifier of the user who 
has made the changes to the 
inventory.

You can also click  to choose 
User ID.

Click  to enter more User IDs. 
These User IDs are taken into 
consideration while generating 
the report.

Click  to remove a specific 
User ID.

Blank. No

Activity Type Select Return to generate the 
report for the returned 
shipment.

Select Receipt to generate the 
report for the received 
shipment.

Select Shipment to generate the 
report for the outbound 
shipment.

Select Adjustment to generate 
report for the inventory 
adjusted in the warehouse.

Blank. No

Audit Type Select the audit type from the 
drop-down menu. 

Blank. No

Table 4–27 Inventory Audit Report Criteria Screen

Field Description Default Value Mandatory
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4.9.3 Report Layout
This section describes the report layout of the Inventory Audit Report.

Task Type Select the task type from the 
drop-down menu.

Blank. No

Adjustment 
Reason 
Code

Enter the reason for the 
adjustment of the inventory.

You can also click  to choose 
reason code.

Click  to enter more reason 
codes. These reason codes are 
taken into consideration while 
generating the report.

Click  to remove the specific 
reason code.

Blank. No

Table 4–27 Inventory Audit Report Criteria Screen

Field Description Default Value Mandatory
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Figure 4–24 Inventory Audit Report
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The Inventory Audit Report appears in portrait layout.

4.9.4 Group and Sort Criteria
The Inventory Audit Report is grouped by Enterprise Code, Transaction 
Date and Location ID. 

The Enterprise Code, Transaction Date, and Location ID are sorted in 
ascending order. Within a specific Location ID, the items are sorted by 
Item ID, in ascending order.

4.9.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

Table 4–28 Inventory Audit Report

Field Description

Transaction Date The date of the transaction.

Location ID The identifier of the location of transaction.

Item ID The identifier of the item.

Item Description The description of the item.

UOM The unit of measure for the item.

PC The product class of the item.

Activity Type The type of transaction.

User ID The identifier of the user.

Quantity The quantity of the item in the location.

Container Type The type of container used to pack the items of the 
shipment.

The typical container type is case or pallet.

Container No The number of the container in which the item is 
stored.

Reason Code The reason code for the adjustment made.
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4.9.6 Additional Setup Required
There is no additional setup required to generate this report.
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4.10 Inventory Balance Report
The Inventory Balance Report is used to balance the opening and closing 
quantity of the inventory for an item, within a specified date range. The 
opening balance and closing balance are printed, along with the receipts, 
returns, adjustments, and shipments made within the specified date 
range. This report provides a high-level view of the Item velocity at the 
shipment and receipt levels.

Intended Audience
The warehouse managers, inventory supervisors, and enterprise users 
use the Inventory Balance Report to reconcile inventory by comparing it 
with the transactions for the day. To access this report, the user must 
belong to the data security group representing warehouse managers, 
inventory supervisors, or enterprise users.

4.10.1 Generating the Report
To generate the Inventory Balance Report:

1. Navigate to Inventory > Inventory Balance Report. The Inventory 
Balance Report criteria screen appears. For more information about 
the Inventory Balance Report criteria screen, see Section 4.10.2, 
"Report Criteria"

2. Enter the criteria and click Generate Report to generate the report. 
The Inventory Balance Report appears. For more information about 
the Inventory Balance Report layout, see Section 4.10.3, "Report 
Layout"

4.10.2 Report Criteria
The Inventory Balance Report criteria screen enables you to enter the 
criteria for which the Inventory Balance Report generates.
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Figure 4–25 Inventory Balance Report Criteria Screen
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Table 4–29 Inventory Balance Report Criteria Screen

Fields Description Default Value Mandatory

Node The node for which the 
report is generated.

If you are an enterprise 
user, select the 
appropriate node from 
the drop-down list. For 
other users, the current 
node of the user 
appears.

The current 
node of the 
user.

No

Date Range Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes

Enterprise Chose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from 
the drop-down list. 

Not Selected.

On selecting 
this, the current 
enterprise of the 
user appears as 
the default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
enterprises in which the 
user participates.

Selected. No
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4.10.3 Report Layout
This section describes the layout of the Inventory Balance Report

Item ID Enter the identifier of 
the item. 

You can click  to 
choose the Item ID.

Click  to enter more 
Item IDs. These Item 
IDs are taken into 
consideration while 
generating the report.

Click  to remove a 
specific Item ID.

Blank. No

Product Line Enter the product line to 
which the item belongs.

You can also select the 
product line from the 
drop-down menu.

Click  to enter more 
product lines. These 
product lines are taken 
into consideration while 
generating the report.

Click  to remove a 
specific product line.

Blank. No

Table 4–29 Inventory Balance Report Criteria Screen

Fields Description Default Value Mandatory
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Figure 4–26 Inventory Balance Report
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The Inventory Balance Report only displays items having at least one 
transaction during the day.

Table 4–30 Inventory Balance Report

Fields Description

Date The date when the receipt or shipment was made.

Node The node where the receipt or shipment was made.

Item ID The identifier of the item that was received or shipped 
out.

Item Description The description of the item.

PC The product class of the item.

UOM The unit of measure for the item.

Supply Type Indicates the availability of the inventory.

In the Figure 4–26, the supply type is ONHAND.

Segment Type The segment types are:

MTC: Made To Customer

MTO: Made To Order

Segment Inventory set aside to fulfill orders from a specific 
customer. 

Ship By Date The date by which shipment needs to be shipped from 
the warehouse.

Tag No. The tag identifier of the item.

Opening Balance(Qty) The quantity of the item at the beginning of the day.

Receipts The quantity of the item received during the day.

Shipments The quantity of the item shipped during the day.

Adjustments The quantity of the item adjusted during the day.

Returns The quantity of the item returned during the day.

Closing Balance(Qty) The quantity of the item at the end of the day.

The Closing Balance is calculated as follows:

Closing Balance = Opening Balance + 
Receipts + Adjustments + Returns - 
Shipments
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The Inventory Balance Report is displayed in portrait layout.

4.10.4 Group and Sort Criteria
This report is grouped by Date and Node.

Date is sorted in descending order and Node is sorted in ascending order. 
Within a specific Node, the items are sorted by Item ID, in ascending 
order.

4.10.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

4.10.6 Additional Setup Required
There is no additional setup required to generate this report.
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4.11 Inventory Hold Report
The Inventory Hold Report lists the item and location details for all items 
that are on hold due to QC activities or Count variances, and locations 
that are frozen for Picking or Putaway.

Intended Audience
Warehouse managers and inventory supervisors use the Inventory Hold 
Report to get a list of all inventory that is in "HELD" status. The report is 
generated manually.

4.11.1 Generating the Report
To generate the Inventory Hold Report:

1. Navigate to Inventory > Inventory Hold Report. The Inventory Hold 
Report criteria screen appears. For more information about the 
Inventory Hold Report criteria screen, see Section 4.11.2, "Report 
Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Inventory Hold Report appears. For more information about the 
Inventory Hold Report layout, see Section 4.11.3, "Report Layout".

4.11.2 Report Criteria
The Inventory Hold Report criteria screen enables you to enter the 
criteria for which the Inventory Hold Report generates.
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Figure 4–27 Inventory Hold Report Criteria Screen

Table 4–31 Inventory Hold Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting this, 
the current 
enterprise of the 
user appears as 
the user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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Zone Enter the zone for which 
the report is generated.

You can also click  to 
choose the zone.

Click  to enter more 
zones. These zones are 
taken into consideration 
while generating the 
report.

Click  to remove a 
specific zone.

Blank. No

Inventory 
Status

Enter the inventory 
status of the items.

You can also select the 
inventory status from the 
drop-down list.

Blank. No

Inventory 
Hold Type

Table 4–31 Inventory Hold Report Criteria Screen

Field Description Default Value Mandatory

For QC 
Activities

Check this box to 
generate a report for 
items that are on 
hold due to QC 
activities. 

Selected. No

Due to Count 
Variance

Check this box to 
generate a report for 
items that are on 
hold due to count 
variance.

Selected. No

On Freeze for 
Picking

Check this box to 
generate a report for 
items that are on 
freeze for picking.

Selected. No
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4.11.3 Report Layout
This section describes the layout of the Inventory Hold Report.

Note: The user must choose at least one Inventory Hold 
Type for the report to be generated.
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Figure 4–28 Inventory Hold Report, For QC Activities
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Table 4–32 Inventory Hold Report Screen, For QC Activities

Field Description

Zone The zone for which the report is generated.

Location The location of the items on hold.

Item ID The identifier of the item which is on hold.

Item Description The description of the item.

PC The product class to which the item belongs. 

UOM The unit of measure for the item.

Inventory Status Status associated with an inventoried item.

Quantity The quantity of the item on hold.
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Figure 4–29 Inventory Hold Report, Due to Count Variance
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Table 4–33 Inventory Hold Report Screen, Due to Count Variance

Field Description

Zone The zone for which the report is generated.

Location The location of the items on hold.

Item ID The identifier of the item which is on hold.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Inventory Status Status associated with an inventoried item.

Quantity The quantity of the item on hold.
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Report Layout

Figure 4–30 Inventory Hold Report, On Freeze for Picking
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The Inventory Hold Report appears in portrait layout.

4.11.4 Group and Sort Criteria
The Inventory Hold Report is grouped by Enterprise Code, Zone, and 
Location.

The Enterprise Code, Zone, and Location are sorted in ascending order. 
Within a specific Location, the items are sorted by Item ID, in ascending 
order.

4.11.5 Page Break Criteria
The Inventory Hold Report has no page break criteria.

4.11.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 4–34 Inventory Hold Report Screen, On Freeze for Picking

Field Description

Zone The zone for which the report is generated.

Location The location of the items on hold.

Item ID The identifier of the item which is on hold.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Inventory Status Status associated with an inventoried item.

Quantity The quantity of the item on hold.
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4.12 Item Inventory Across Nodes Report
The Item Inventory Across Nodes Report is used to track the inventory of 
items across nodes for either all or selected enterprises. The report can 
be generated only for those enterprises to which the user has access.

Intended Audience
Enterprise users use the Item Inventory Across Nodes Report to verify 
inventory in a node or across nodes. To access this report, the user must 
belong to the data security group representing enterprise users.

4.12.1 Generating the Report
To generate an Item Inventory Across Nodes Report:

1. Navigate to Inventory > Item Inventory Across Nodes Report. The 
Item Inventory Across Nodes Report criteria screen appears. For more 
information about the Item Inventory Across Nodes Report criteria 
screen, see Section 4.12.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Item Inventory Across Nodes Report appears. For more 
information about the Item Inventory Across Nodes Report layout, 
see Section 4.12.3, "Report Layout".

4.12.2 Report Criteria
The Item Inventory Across Nodes Report criteria screen enables you to 
enter the criteria for which the Item Inventory Across Nodes Report 
generates.

Note: This report only displays the inventory details of 
items that are on hand. Only items with supply type is 
'Onhand' are considered.

Note: This report is accessible only to enterprise users 
and does not display in the menu for other users.
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Figure 4–31 Item Inventory Across Nodes Criteria Screen
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Table 4–35 Item Inventory Across Nodes Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

You can also click  to 
choose the node.

Click  to enter more 
nodes. These nodes are 
taken into consideration 
while generating the 
report.

Click  to remove a 
specific node.

Blank. No

Item ID Enter the identifier of the 
item. 

You can also click  to 
choose the Item ID.

Click  to enter more 
Item IDs. These Item 
IDs are taken into 
consideration while 
generating the report.

Click  to remove a 
specific Item ID.

Blank. No

Enterprise Choose this to generate 
the report for the user’s 
default enterprise. 

Not Selected.

On selecting 
this, the current 
enterprise of the 
user appears as 
the user’s 
default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering 
all the enterprises in 
which the user 
participates.

Selected. No
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4.12.3 Report Layout
This section describes the layout of the Item Inventory Across Nodes 
Report.

Product Class Select the product class 
from the drop-down list.

Blank No

Product Line Select the product line 
from the drop-down list. 

Blank No

Table 4–35 Item Inventory Across Nodes Criteria Screen

Field Description Default Value Mandatory



214   Reports Guide

Report Layout

Figure 4–32 Item Inventory Across Nodes Report
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The Item Inventory Across Nodes Report appears in the landscape 
layout.

4.12.4 Group and Sort Criteria
The Item Inventory Across Nodes Report is grouped by Enterprise Code, 
Item ID, and Node.

The Enterprise Code, Item ID and Node are sorted in ascending order.

Table 4–36 Item Inventory Across Nodes Report

Field Description

Item ID The identifier of the item.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Node The selected node or the node to which the items 
belong.

On Hand Quantity The current inventory with supply type Onhand.

Allocated Quantity The quantity of the item allocated for a shipment.

Available Quantity The difference between On Hand Quantity and 
Allocated Quantity.

Unit Cost The total value of the item.

Value The total value of the item.

This is computed as the product of Available Quantity 
and Unit Cost.

Currency The currency in which the cost and value of the item 
displays.

Group Total for Item The total On Hand Quantity, Available Quantity, Value, 
and Cost Currency for a particular item.

Group Total for 
Enterprise

The total On Hand Quantity and Available Quantity for 
a particular enterprise.
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4.12.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

4.12.6 Additional Setup Required
There is no additional setup required to generate this report.
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4.13 Item Inventory Report
The Item Inventory Report lists the details of the item inventory at the 
node. You can drill down to location level and container level reports from 
this report. 

Intended Audience
Warehouse managers and inventory supervisors use the Item Inventory 
Report to search inventory details at the node. To access this report, the 
user must belong to the data security group representing warehouse 
managers, or inventory supervisors.

4.13.1 Generating the Report
To generate the Item Inventory Report

1. Navigate to Inventory > Item Inventory Report. The Item Inventory 
Report criteria screen appears. For more information about the Item 
Inventory Report criteria screen, see Section 4.13.2, "Report 
Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Item Inventory Report appears. For more information about the 
Item Inventory Report layout, see Section 4.13.3, "Report Layout".

4.13.2 Report Criteria
The Item Inventory Report criteria screen enables you to enter the 
criteria for which the Item Inventory Report generates.
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Figure 4–33 Item Inventory Report Criteria Screen

Table 4–37 Item Inventory Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current node 
of the user.

No

Item ID Enter the identifier of the 
item.

You can also click  to 
choose the Item ID.

Blank. No

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting this, 
the current 
enterprise of the 
user appears as 
the user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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4.13.3 Report Layout
This section describes the layout of the Item Inventory Report.

Unit Of 
Measure

Select the UOM of the 
item from the drop-down 
menu.

Blank. No

Product Class Select the product class 
from the drop-down 
menu.

Blank. No

Table 4–37 Item Inventory Report Criteria Screen

Field Description Default Value Mandatory
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Figure 4–34 Item Inventory Report
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The Item Inventory Report appears in portrait layout.

4.13.4 Group and Sort Criteria
The Item Inventory Report is grouped by Enterprise Code.

The Enterprise Code is sorted in ascending order.

Within an enterprise, the Item ID is sorted in ascending order.

4.13.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

4.13.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 4–38 Item Inventory Report 

Field Description

Item ID The identifier of the item for the selected location.

Click the Item ID to view the Location Inventory 
Summary Report.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Inventory Status Status associated with an inventoried item.

Quantity The quantity of the item in the warehouse.
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4.14 Item Tag No. Report
The Item Tag No. Report lists all item transactions for the given tag 
number. The report displays the transactions in three categories: 
Inbound, Inventory, and Outbound.

Intended Audience
Warehouse managers, inbound supervisors, outbound supervisors, and 
inventory supervisors use the Item Tag No. Report to check on 
transactions for a particular tag number. The report is generated 
manually.

4.14.1 Generating the Report
To generate the Item Tag No. Report: 

1. Navigate to Inventory > Item Tag No. Report. The Item Tag No. 
Report criteria screen appears. For more information about the Item 
Tag No. Report criteria screen, see Section 4.14.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Item Tag No. Report appears. For more information about the 
Item Tag No. Report layout, see Section 4.14.3, "Report Layout".

4.14.2 Report Criteria
The Item Tag No. Report criteria screen enables you to enter the criteria 
for which the Item Tag No. Report generates.
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Figure 4–35 Item Tag No. Report Criteria Screen
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Table 4–39 Item Tag No. Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Item ID Enter the identifier of the 
item. 

You can also click  to 
choose the Item ID.

Blank. No

Unit Of 
Measure

Select the UOM of the 
item from the drop-down 
menu.

Blank. No

Tag No. Enter the tag number of 
the item.

Blank. No

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.
On selecting 
this, the current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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4.14.3 Report Layout
This section describes the layout of the Item Tag No. Report.

Identify_Tag If the item selected is 
tagged, click this to 
display the Tag-Identifier 
area which allows the 
user to enter the item 
attributes.

Blank. No

Tag Identifiers This area enables the 
user to enter the tag 
attribute of the tag- 
tracked item. The field is 
displayed for the items 
tracked with tag 
attributes.

In the given example, the 
item Tag-L-001 is lot- 
tracked. Hence the Lot # 
is displayed in tag 
identifier.

Blank. No

Table 4–39 Item Tag No. Report Criteria Screen

Field Description Default Value Mandatory
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Figure 4–36 Item Tag No. Report, Inbound Report
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Table 4–40 Item Tag No. Report, Inbound Report

Field Description

Shipment No. The shipment number of the inbound shipment.

Expected Delivery Date The expected date of delivery of the inbound 
shipment.

Seller The organization from where the items are shipped.

Item ID The identifier of the item that is received.

Item Description The description of the item.

PC The product class to which the item belongs. 

UOM The unit of measure for the item.

Quantity The quantity of the item specific to the shipment 
number.

Tag No. The tag identifier of the item.
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Figure 4–37 Item Tag No. Report, Inventory Report



Report Layout

Inventory Reports   229

Table 4–41 Item Tag No. Report, Inventory Report

Field Description

Location ID The identifier of the locations in the warehouse that 
have the input tag number.

Item ID The identifier of the item.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Quantity The quantity of the item specific to the shipment 
number.

Tag No. The tag identifier of the item.
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Figure 4–38 Item Tag No. Report, Outbound Report
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The Item Tag No. Report appears in portrait layout.

4.14.4 Group and Sort Criteria
The Item Tag No. Report, Inbound Report is grouped by Enterprise Code, 
Shipment No, Expected Deliver Date, Item ID, and Tag No.

The Enterprise code, Shipment No, Expected Delivery Date, and Item ID 
are sorted ascending order.

The Item Tag No. Report, Inventory Report is grouped by Enterprise 
Code, Location ID, Item ID, and Tag No.

The Enterprise code, Location ID and Item ID are sorted in ascending 
order.

The Item Tag No. Report, Outbound Report is grouped by Enterprise 
Code, Shipment No, Actual Shipment Date, and Item ID.

The Enterprise code, Shipment No and Item ID are sorted in ascending 
order and Actual Shipment Date is sorted in descending order.

4.14.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

Table 4–42 Item Tag No. Report, Outbound Report

Field Description

Shipment No The shipment number of the outbound shipment.

Actual Ship Date The actual date of shipment. 

Seller The organization from where the items are shipped.

Item ID The identifier of the item that is shipped out.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Quantity The quantity of the item specific to the shipment 
number.

Tag No. The tag identifier of the item.
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4.14.6 Additional Setup Required
There is no additional setup required to generate this report.
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4.15 Item Velocity Report
Due to changes in demand, seasonal variations, and product lifecycle 
characteristics, the item velocity changes over time. The Item Velocity 
Report captures the item velocity, as measured by the number of 
outbound shipments that the item is featured in, during the selected date 
range.

Intended Audience
Warehouse managers and inventory supervisors use this report to check 
if the items have the right item velocities and change the velocity code, if 
necessary. This report is generated manually.

4.15.1 Generating the Report
To generate the Item Velocity Report:

1. Navigate to Inventory > Item Velocity Report. The Item Velocity 
Report criteria screen appears. For more information about the Item 
Velocity Report criteria screen, see Section 4.15.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Item Velocity Report appears. For more information about the 
Item Velocity Report layout, see Section 4.15.3, "Report Layout".

4.15.2 Report Criteria
The Item Velocity Report criteria screen enables you to enter the criteria 
for which the Item Velocity Report generates.
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Figure 4–39 Item Velocity Report Criteria Screen

Table 4–43 Item Velocity Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Actual Ship 
Date

Enter the start date and 
the end date for which 
the report is generated.

You can click the  icons 
to choose the date range.

The current 
date.

Yes

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.
On selecting 
this, the current 
enterprise of the 
user appears as 
the user’s 
default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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4.15.3 Report Layout
 This section describes the layout of the Item Velocity Report.



236   Reports Guide

Report Layout

Figure 4–40 Item Velocity Report
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The Item Velocity Report appears in portrait layout.

4.15.4 Group and Sort Criteria
The Item Velocity Report is grouped by Enterprise Code, Velocity Code, 
and Range.

The Enterprise code, Velocity Code and Range are sorted in ascending 
order.

Table 4–44 Item Velocity Report

Field Description

No. of Shipments 
Featured In

The shipments containing the items of a particular 
velocity code. The shipments are in the range of 1-25, 
26-50, 51-75, and Over 76.

A count of the number of items with the specified 
velocity code is displayed against the number of 
shipments containing the items of that particular 
velocity code, below the No. Shipments of Featured In.

Click the item count to view the Item Velocity 
Detail Report.

Velocity Code This indicates the velocity code of the items.

Items can have Velocity Codes A, B, C, or Not Setup.

Velocity Code A This indicates all the 
shipments with velocity 
code A.

Velocity Code B This indicates all the 
shipments with velocity 
code B.

Velocity Code C This indicates all the 
shipments with velocity 
code C.

Not Setup This indicates the number of 
items with no velocity code 
set up.
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4.15.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

4.15.6 Additional Setup Required
There is no additional setup required to generate this report.

4.15.7 Item Velocity Detail Report
This provides the details of the items belonging to a particular velocity 
code.

4.15.7.1 Report Layout
This section describes the layout of the Item Velocity Detail Report.
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Figure 4–41 Item Velocity Detail Report
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The Item Velocity Detail Report appears in portrait layout.

4.15.7.2 Group and Sort Criteria
The Item ID is sorted in ascending order.

4.15.7.3 Page Break Criteria
The Item Velocity Detail Report has no page break criteria. 

Table 4–45 Item Velocity Detail Report

Field Description

Item ID The identifier of the item.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.
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4.16 Location Inventory Detail Report
The Location Inventory Detail Report is used to track the inventory of 
items and locations in the warehouse at the item, case, pallet, status, 
and other item attributes levels.

Intended Audience
Warehouse managers and inventory supervisors use this report to search 
inventory details for zone, location, or item. To access this report, the 
user must belong to the data security group representing warehouse 
managers or inventory supervisors.

4.16.1 Generating the Report
To generate the Location Inventory Detail Report:

1. Navigate to Inventory > Location Inventory Detail Report. The 
Location Inventory Detail Report criteria screen appears. For more 
information about the Location Inventory Detail Report criteria 
screen, see Section 4.16.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Location Inventory Detail Report appears. For more information 
about the Location Inventory Detail Report layout, see 
Section 4.16.3, "Report Layout".

4.16.2 Report Criteria
The Location Inventory Detail Report criteria screen enables you to enter 
the criteria for which the Location Inventory Detail Report generates.
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Figure 4–42 Location Inventory Detail Report Criteria Screen
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Table 4–46  Location Inventory Detail Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Zone Enter the zone for which 
the report is generated.

You can also click  to 
choose the zone.

Blank. No

Location Enter the location for 
which the report is 
generated.

You can also click  to 
choose the location.

Blank. No

Item ID The identifier of the item.

You can also click  to 
choose the Item ID. 

Blank. No

Unit Of 
Measure

Select the UOM of the 
item from the drop-down 
menu.

Blank. No

Product Class Select the Product Class 
from the drop-down 
menu.

Blank. No

Tag No. The tag number of the 
items.

Blank. No

Enterprise Choose this to generate the 
report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.
On selecting this, 
the current 
enterprise of the 
user appears as 
the user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate the 
report considering all the 
enterprises in which the 
user participates.

Selected. No
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4.16.3 Report Layout
This section describes the report layout of the Location Inventory Detail 
Report.

Identify_Tag If the item selected is 
tagged, click this to 
display the Tag-Identifier 
area which allows the 
user to enter the item 
attributes.

Blank. No

Tag Identifiers This area enables the 
user to enter the tag 
attribute of the tag- 
tracked item. The field is 
displayed for the items 
tracked with tag 
attributes.

In the given example, the 
item Tag-B-001 is batch 
tracked. Hence the Batch 
# is displayed in tag 
identifier. 

Blank. No

Table 4–46  Location Inventory Detail Report Criteria Screen

Field Description Default Value Mandatory
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Figure 4–43 Location Inventory Detail Report
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The Location Inventory Detail Report appears in portrait layout.

4.16.4 Group and Sort Criteria
The Location Inventory Detail Report is grouped by Enterprise Code, 
Zone ID, Location ID, Container Type, and Container ID.

The Enterprise code, Zone ID and Location ID are sorted in ascending 
order.

4.16.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

Table 4–47 Location Inventory Detail Report

Field Description

Zone ID The identifier of the zone in the warehouse.

Location ID The identifier of the location in the warehouse.

Container Type The type of container used to pack the items of the 
shipment.

The typical container type is case or pallet.

Container ID The identifier of the container in which the item is 
stored.

Item ID The identifier of the item.

Item Description The description of the items.

PC The product class of the item.

UOM The unit of measure for the item.

Quantity The quantity of the items in the location.

Inventory Status Status associated with an inventoried item.

Tag No. The tag number of the items.

Serial No. The serial number of the items.

Quantity The number of units of the item.
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4.16.6 Additional Setup Required
There is no additional setup required to generate this report.
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4.17 Location Inventory Summary Report
The Location Inventory Summary Report is used to track the inventory of 
items and locations in the warehouse at the item or location level.

Intended Audience
Warehouse managers and inventory supervisors use this report to search 
inventory details for zone, location, or item. To access this report, the 
user must belong to the data security group representing warehouse 
managers and inventory supervisors.

4.17.1 Generating the Report
To generate the Location Inventory Summary Report:

1. Navigate to Inventory > Location Inventory Summary Report. The 
Location Inventory Summary Report criteria screen appears. For more 
information about the Location Inventory Summary Report criteria 
screen, see Section 4.17.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Location Inventory Summary Report appears. For more 
information about the Location Inventory Summary Report layout, 
see Section 4.17.3, "Report Layout".

4.17.2 Report Criteria
The Location Inventory Summary Report criteria screen enables you to 
enter the criteria for which the Location Inventory Summary Report 
generates.
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Figure 4–44 Location Inventory Summary Report Criteria Screen
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Table 4–48 Location Inventory Summary Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Zone Enter the zone for which 
the report is generated.

You can also click  to 
choose the zone.

Blank. No

Location Enter the location for 
which the report is 
generated.

You can also click  to 
choose the location.

Blank. No

Item ID The identifier of the item.

You can also click  to 
choose the Item ID. 

Blank. No

Unit Of 
Measure

Select the UOM of the 
item from the drop-down 
menu.

Blank. No

Product Class Select the product class 
of the item from the 
drop-down list.

Blank. No

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.
On selecting 
this, the current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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4.17.3 Report Layout
This section describes the report layout of the Location Inventory 
Summary Report.
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Figure 4–45 Location Inventory Summary Report
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The Location Inventory Summary Report appears in portrait layout.

4.17.4 Group and Sort Criteria
The Location Inventory Summary Report is grouped by Enterprise Code, 
Zone ID, Location ID, and Item ID.

The Enterprise code, and Zone ID are sorted in ascending order.

4.17.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

4.17.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 4–49 Location Inventory Summary Report

Field Description

Zone ID The zone for which the report is generated.

Location ID The location of the item in the warehouse.

Click the hyperlink to view the Location Inventory 
Detail Report appears.

Item ID The identifier of the item for which the report is 
generated.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Quantity The quantity of the items in the location.
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4.18 Location/SKU Velocity Mismatch Report
The Location/SKU Velocity Mismatch Report matches the Location 
Velocity to the Item Velocity to identify locations that have a mismatch. 
The warehouse can use this report to reorganize item locations to 
optimize the utilization of locations.

Intended Audience
Warehouse managers and inventory supervisors use this report to 
reorganize inventory in the warehouse. This report is generated manually 
every month. 

4.18.1 Generating the Report
To generate the Location/SKU Velocity Mismatch Report:

1. Navigate to Inventory > Location/SKU Velocity Mismatch Report. The 
Location/SKU Velocity Mismatch Report criteria screen appears. For 
more information about the Location/SKU Velocity Mismatch Report 
criteria screen, see Section 4.18.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Location/SKU Velocity Mismatch Report appears. For more 
information about the Location/SKU Velocity Mismatch Report layout, 
see Section 4.18.3, "Report Layout".

4.18.2 Report Criteria
The Location/SKU Velocity Mismatch Report criteria screen enables you to 
enter the criteria for which the Location/SKU Velocity Mismatch Report 
generates.
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Figure 4–46 Location/SKU Velocity Mismatch Criteria Screen

4.18.3 Report Layout
This section describes the layout of the Location/SKU Velocity Mismatch 
Report.

Table 4–50 Location/SKU Velocity Mismatch Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Zone The zone for which the 
report is generated.

You can also click  to 
choose the zone.

Click  to enter more 
zones. These zones are 
taken into consideration 
while generating the 
report.

Click  to remove a 
specific zone.

Blank. No
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Figure 4–47 Location/SKU Velocity Mismatch Report
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The Location/SKU Mismatch Report appears in portrait layout.

4.18.4 Group and Sort Criteria
The Location/SKU Mismatch Report is grouped by Zone ID, Location 
Velocity and Item velocity. 

The Zone ID, Location Velocity, and Item Velocity are sorted in ascending 
order.

4.18.5 Page Break Criteria
The Location/SKU Mismatch Report has no page break criteria.

4.18.6 Additional Setup Required
There is no additional setup required to generate this report.

4.18.7 Location/SKU Velocity Mismatch Detail Report
The Location/SKU Mismatch Detail Report provides details of the location 
and the items in that particular location.

Table 4–51 Location/SKU Velocity Mismatch Report

Field Description

Zone ID The zone for which the report is generated.

Location Velocity Code which identifies the frequency of demand of the 
items in that particular location.

Item Velocity A count of the number of locations with the specified 
Location Velocity Code existing in the specified Zone. 
These locations contain items with the specified Item 
Velocity. 

For example, in the Figure 4–47, BULK-ZONE1 with 
locations of Location Velocity Code C, contains two 
locations with items of item velocity code Not Setup, 
four locations with items of item velocity code A, and 
two locations with items of item velocity code B.

Click the item count to view the Location/SKU 
Velocity Mismatch Detail Report.
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4.18.7.1 Report Layout
This section describes the layout of the Location/SKU Velocity Mismatch 
Detail Report.
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Figure 4–48 Location/SKU Velocity Mismatch Detail Report
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Location/SKU Velocity Mismatch Detail Report

The Location/SKU Velocity Mismatch Detail Report appears in portrait 
layout.

4.18.7.2 Group and Sort Criteria
The Location/SKU Velocity Mismatch Detail Report is grouped by Location 
and Item ID.

The Location and Item ID are sorted in ascending order.

4.18.7.3 Page Break Criteria
The Location/SKU Velocity Mismatch Detail Report has no page break 
criteria.

Table 4–52 Location/SKU Velocity Mismatch Detail Report

Field Description

Location The location of the item in the warehouse.

Item ID The identifier of the item.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Quantity The quantity of the item with the same Item ID.
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4.19 Node Inventory Valuation Report
The Node Inventory Valuation Report lists the item, quantity, and 
valuation details for a node. This report is useful in determining the 
inventory valuation in a node.

Intended Audience
Warehouse managers and inventory supervisors, as well as enterprise 
users use this report to check the value of the inventory in the 
warehouse. To access this report, the user must belong to the data 
security group representing warehouse managers and the inventory 
supervisors.

4.19.1 Generating the Report
To generate the Node Inventory Valuation report:

1. Navigate to Inventory > Node Inventory Valuation Report. The Node 
Inventory Valuation Report criteria screen appears. For more 
information about the Node Inventory Valuation Report criteria 
screen, see Section 4.19.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Node Inventory Valuation Report appears. For more information 
about the Node Inventory Valuation Report layout, see 
Section 4.19.3, "Report Layout".

4.19.2 Report Criteria
The Node Inventory Valuation Report criteria screen enables you to enter 
the criteria for which the Node Inventory Valuation Report generates.
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Report Criteria

Figure 4–49 Node Inventory Valuation Report Criteria Screen

Table 4–53 Node Inventory Valuation Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

If you are an enterprise 
user, select the 
appropriate node from 
the drop-down list. For 
other users, the current 
node of the user appears.

The current 
node of the 
user.

No

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.
On selecting 
this, the current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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4.19.3 Report Layout
This section describes the layout of the Node Inventory Valuation Report.

Product Class Select the product class 
from the drop-down 
menu.

Blank. No

Product Line Select the product line 
from the drop-down 
menu.

Blank. No.

Table 4–53 Node Inventory Valuation Report Criteria Screen

Field Description Default Value Mandatory
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Report Layout

Figure 4–50 Node Inventory Valuation Report
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The Node Inventory Valuation Report appears in portrait layout.

4.19.4 Group and Sort Criteria
The Node Inventory Valuation Report is grouped by Enterprise Code, 
Node, and Item ID.

The Enterprise code, Node and Item ID are sorted in ascending order.

4.19.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

4.19.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 4–54 Node Inventory Valuation Report

Field Description

Node The node to which the item belongs.

Item ID The identifier of the item in the inventory.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Quantity The Quantity of the inventory.

Value The value of the item. 

The value of the item is computed as a product of unit 
cost and quantity.

Cost Currency The currency in which the cost of the inventory 
displays.

Total The total value of the inventory of the node for a 
particular enterprise.
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4.20  Participant List Report
The Participant List Report provides a count of the number of participants 
defined in the participant model with the role details.

Intended Audience
Warehouse managers, inbound supervisors, inventory supervisors, and 
outbound supervisors, and enterprise users, use the Participant List 
Report to get a count of the participants with role details. The report is 
generated manually.

4.20.1 Generating the Report
To generate the Participant List Report:

1. Navigate to Inventory > Participant List Report. The Participant List 
Report criteria screen appears. For more information about the 
Participant List Report criteria screen, see Section 4.20.2, "Report 
Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Participant List Report appears. For more information about the 
Participant List Report layout, see Section 4.20.3, "Report Layout".

4.20.2 Report Criteria
The Participant List Report criteria screen enables you to enter the 
criteria for which the Participant List Report generates.

Figure 4–51 Participant List Report Criteria Screen
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4.20.3 Report Layout
This section describes the layout of the Participant List Report.

Table 4–55 Participant List Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

If you are an enterprise 
user, select the 
appropriate node from 
the drop-down list. For 
other users, the current 
node of the user appears.

The current 
node of the 
user.

No

Participant 
Active As On 
Date

Enter the date for which 
the report is generated.

You can also click the  
icon to select the date.

The current 
date.

Yes
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Report Layout

Figure 4–52 Participant List Report
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The Participant List Report appears in portrait layout.

4.20.4 Group and Sort Criteria
The Participant List Report is grouped by Participant Roles.

The Participant Roles is sorted in descending order.

4.20.5 Page Break Criteria
The Participant List Report has no page break criteria.

Table 4–56 Participant List Report

Field Definition

Enterprises The total number of enterprises defined in the 
participant model of the hub organization until the 
date specified in the criteria.

Click the count to view the Participant Detail Report, 
Enterprise.

Buyers The total number of buyers defined in the participant 
model of the hub organization until the date specified 
in the criteria.

Click the count to view the Participant Detail Report, 
Buyer.

Sellers The total number of sellers defined in the participant 
model of the hub organization until the date specified 
in the criteria.

Click the count to view the Participant Detail Report, 
Seller. 

Nodes The total number of nodes defined in the participant 
model of the hub organization until the date specified 
in the criteria.

Click the count to view the Participant Detail Report, 
Nodes.

Carriers The total number of carriers defined in the participant 
model of the hub organization until the date specified 
in the criteria.

Click the count to view the Participant Detail Report, 
Carrier.



270   Reports Guide

Participant Detail Report, Enterprise

4.20.6 Additional Setup Required
There is no additional setup required to generate this report.

4.20.7 Participant Detail Report, Enterprise
The Participant Detail Report, Enterprise displays the list of participants 
in the Enterprise role.

4.20.7.1 Report Layout
This section describes the layout of the Participant Detail Report, 
Enterprise.
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Figure 4–53 Participant Detail Report, Enterprise
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Participant Detail Report, Buyer

The Participant Enterprise Detail Report appears in portrait layout.

4.20.7.2 Group and Sort Criteria
The Participant Enterprise Detail Report is grouped by Organization Code.

The Organization Code is sorted in ascending order.

4.20.7.3 Page Break Criteria
The Participant Enterprise Detail Report has no page break criteria.

4.20.8 Participant Detail Report, Buyer
The Participant Detail Report, Buyer displays the list of participants in the 
buyer role.

4.20.8.1 Report Layout
This section describes the layout of the Participant Detail Report, Buyer.

Table 4–57 Participant Detail Report, Enterprise

Field Description

Organization Code The unique code for each enterprise.
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Figure 4–54 Participant Detail Report, Buyer
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Participant Detail Report, Seller

The Participant Detail Report, Buyer appears in portrait layout.

4.20.8.2 Group and Sort Criteria
The Participant Detail Report, Buyer is grouped by Organization Code.

The Organization Code is sorted in ascending order.

4.20.8.3 Page Break Criteria
The Participant Detail Report, Buyer has no page break criteria.

4.20.9 Participant Detail Report, Seller
The Participant Detail Report, Seller displays the list of participants in the 
seller role.

4.20.9.1 Report Layout
This section describes the layout of the Participant Detail Report, Seller.

Table 4–58 Participant Detail Report, Buyer 

Field Description

Organization Code The unique code for each seller.
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Figure 4–55 Participant Detail Report, Seller
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Participant Detail Report, Nodes

The Participant Detail Report, Seller appears in portrait layout.

4.20.9.2 Group and Sort Criteria
The Participant Detail Report, Seller is grouped by Organization Code.

The Organization Code is sorted in ascending order.

4.20.9.3 Page Break Criteria
The Participant Detail Report, Seller has no page break criteria.

4.20.10 Participant Detail Report, Nodes
The Participant Detail Report, Nodes displays the list of nodes in the 
participant model.

4.20.10.1 Report Layout
This section describes the layout of the Participant Detail Report, Nodes.

Table 4–59 Participant Detail Report, Seller

Field Description

Organization Key The unique code for each carrier.
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Figure 4–56 Participant Detail Report, Nodes
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Participant Detail Report, Carrier

The Participant Detail Report, Nodes appears in portrait layout.

4.20.10.2 Group and Sort Criteria
The Participant Detail Report, Nodes is grouped by Organization Code.

The Organization Code is sorted in ascending order.

4.20.10.3 Page Break Criteria
The Participant Detail Report, Nodes has no page break criteria.

4.20.11 Participant Detail Report, Carrier
The Participant Detail Report, Carrier displays the list of participants in 
the carrier role.

4.20.11.1 Report Layout
This section describes the layout of the Participant Detail Report, Carrier.

Table 4–60 Participant Detail Report, Nodes

Field Description

Organization Code The unique code for each nodes.
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Figure 4–57 Participant Detail Report, Carrier
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Participant Detail Report, Carrier

The Participant Detail Report, Carrier appears in portrait layout.

4.20.11.2 Group and Sort Criteria
The Participant Detail Report, Carrier is grouped by Organization Code.

The Organization Code is sorted in ascending order.

4.20.11.3 Page Break Criteria
The Participant Detail Report, Carrier has no page break criteria.

Table 4–61 Participant Detail Report, Carrier

Field Description

Organization Code The unique code for each carrier.
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4.21 Space Consolidation Report
The Space Consolidation Report provides item-wise information about the 
location capacity utilization. This helps in identifying space consolidation 
opportunities.

Intended Audience
Warehouse managers and inventory supervisors use this report to check 
the capacity of the location for an item.

4.21.1 Generating the Report
To generate the Space Consolidation Report:

1. Navigate to Inventory > Space Consolidation Report. The Space 
Consolidation Report criteria screen appears. For more information 
about the Space Consolidation Report criteria screen, see 
Section 4.21.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Space Consolidation Report appears. For more information about 
the Space Consolidation Report layout, see Section 4.21.3, "Report 
Layout".

4.21.2 Report Criteria
The Space Consolidation Report criteria screen enables you to enter the 
criteria for which the Space Consolidation Report generates.

Note: The Space Consolidation Report can be generated 
only for locations with finite capacity.
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Report Criteria

Figure 4–58 Space Consolidation Report Criteria Screen

Table 4–62 Space Consolidation Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from 
the drop-down list. 

Not Selected.

On selecting 
this, the current 
enterprise of the 
user appears as 
the user’s 
default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering 
all the enterprises in 
which the user 
participates.

Selected. No
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4.21.3 Report Layout
This section describes the layout of the Space Consolidation Report.

Zone Enter the zone for which 
the report is generated.

You can also click  to 
choose the zone.

Click  to enter more 
zones. These zones are 
taken into consideration 
while generating the 
report.

Click  to remove a 
specific zone.

Blank. No

Product Class Enter the product class of 
the item.

You can select the 
product class from the 
drop-down menu.

Click  to enter more 
product class. These are 
taken into consideration 
while generating the 
report.

Click  to remove a 
specific product class.

Blank. No

Location(s) 
with% 
Utilization <=

Enter the percentage of 
the capacity of the 
location utilized for the 
item.

50 Yes

Table 4–62 Space Consolidation Report Criteria Screen

Field Description Default Value Mandatory
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Report Layout

Figure 4–59 Space Consolidation Report
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The Space Consolidation Report appears in portrait layout.

4.21.4 Group and Sort Criteria
The Space Consolidation Report is grouped by Enterprise Code, Zone ID, 
and Item ID.

The Enterprise code, Zone ID and Item ID are sorted in ascending order.

4.21.5 Page Break Criteria
The Space Consolidation Report has no page break criteria.

4.21.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 4–63 Space Consolidation Report

Field Description

Item ID The identifier of the item.

Item Description The description of the item.

PC The product class to which the item belongs. 

UOM The unit of measure for the item.

Zone ID The zone ID of the zone.

Location ID The location id of the item.

Location Size Code The code representing the storage capacity of the 
location.

Quantity The quantity of the item in the location.

Capacity Utilization The percentage of the capacity of the location utilized 
for the item.
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4.22 Space Utilization Report
The Space Utilization Report provides information on location capacity 
utilization in terms of percentage.

Intended Audience
Warehouse managers, and inventory supervisors use the Space 
Utilization Report to check the capacity of the location for an item.

4.22.1 Generating the Report
To generate the Space Utilization Report:

1. Navigate to Inventory > Space Utilization Report. The Space 
Utilization Report criteria screen appears. For more information about 
the Space Utilization Report criteria screen, see Section 4.22.2, 
"Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Space Utilization Report appears. For more information about the 
Space Utilization Report layout, see Section 4.22.3, "Report Layout".

4.22.2 Report Criteria
The Space Utilization Report criteria screen enables you to enter the 
criteria for which the Space Utilization Report generates.
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Figure 4–60 Space Utilization Report Criteria Screen

Table 4–64 Space Utilization Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No
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Report Layout

4.22.3 Report Layout
This section describes the layout of the Space Utilization Report.

Zone Enter the zone for which 
the report is generated.

You can also click  to 
choose the zone.

Click  to enter more 
zones. These zones are 
taken into consideration 
while generating the 
report.

Click  to remove a 
specific zone.

Blank. No

Location Size 
Code

Enter the size code of the 
location.

Click  to enter more 
size codes. These size 
codes are taken into 
consideration while 
generating the report.

Click  to remove a 
specific size code.

Blank. No

Table 4–64 Space Utilization Report Criteria Screen

Field Description Default Value Mandatory
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Figure 4–61 Space Utilization Report
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Page Break Criteria

The Space Utilization Report appears in portrait layout.

4.22.4 Group and Sort Criteria
The Space Utilization Report is grouped by Zone ID and Location Size 
Code.

The Zone ID and Location Size Code are sorted in ascending order.

4.22.5 Page Break Criteria
The Space Utilization Report has no page break criteria.

Table 4–65 Space Utilization Report

Field Description

Zone ID Displays the ID of the zone.

Location Size Code The code representing the storage capacity of the 
location.

Total No. of Locations Displays the total number of locations for the 
particular location size code.

Click the hyperlink to view the Space Utilization 
Summary Report.

Total No. of Empty 
Locations 

Displays the total number of empty locations for the 
particular location size code.

Click the hyperlink to view the Empty Location(s) 
Detail Report.

Total No. of Full 
Locations 

Displays the total number of locations full for the 
particular location size code.

Click the hyperlink to view the Completely Full 
Location(s) Detail Report.

Total No. of Partially 
Full Locations 

Displays the total number of locations partially full for 
the particular location size code.

Click the hyperlink to view the Partially Full Location(s) 
Detail Report.

Location Utilization% The percentage of the location that is full.

Volume Utilization The percentage of the volume of the location that is 
utilized for storage.
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4.22.6 Additional Setup Required
There is no additional setup required to generate this report.

4.22.7 Space Utilization Summary Report
The Space Utilization Summary Report gives a graphical display of the 
percentage of location utilized.

4.22.7.1 Report Layout
This section describes the layout of the Space Utilization Summary 
Report.
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Space Utilization Summary Report

Figure 4–62 Space Utilization Summary Report
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The Space Utilization Summary Report appears in portrait layout.

4.22.7.2 Group and Sort Criteria
The Space Utilization Summary Report has no group criteria and sort 
criteria.

4.22.7.3 Page Break Criteria
The Space Utilization Report has no page break criteria.

4.22.8 Empty Location(s) Detail Report
The Empty Location(s) Detail Report provides a detail report on the 
location which does not have any inventory.

4.22.8.1 Report Layout
This section describes the layout of the Empty Location(s) Detail Report.

Table 4–66 Space Utilization Summary Report

Field Description

The regions of this color indicate the percentage of the 
location completely full.

In the Figure 4–62, 1 location is completely full.

The regions of this color indicate the percentage of the 
location partially full.

In the Figure 4–62, 4 locations are partially full.

The regions of this color indicate the percentage of the 
location empty.

In the Figure 4–62, 4 locations are empty.

Location(s) The location capacity utilization.
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Empty Location(s) Detail Report

Figure 4–63 Empty Location(s) Detail Report
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The Empty Location(s) Detail Report appears in portrait layout.

4.22.8.2 Group and Sort Criteria
The Empty Location(s) Detail Report is grouped by Location Type.

The Location Type is sorted in ascending order.

4.22.8.3 Page Break Criteria
Empty Location(s) Detail Report has no page break criteria.

4.22.9 Completely Full Location(s) Detail Report
The Completely Full Location(s) Detail Report provides a detail report on 
the locations which have no available volume for usage.

4.22.9.1 Report Layout
This section describes the layout of the Completely Full Location(s) Detail 
Report.

Table 4–67 Empty Location(s) Detail Report

Field Description

Location Type The type specified for a location which indicates the 
purpose the location serves.

Location ID The ID of the location for which the report is 
generated.

Aisle Number The number of the aisle where the shipment is 
located.

Level Number The number of the level where the shipment is 
located.

Bay Number The number of the bay where the shipment is located

Current Available 
Volume

The volume of the location available for usage.

Pend In Volume Items awaited in the near future for that particular 
location.

Net Available Volume The actual volume available for usage.
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Completely Full Location(s) Detail Report

Figure 4–64 Completely Full Location(s) Detail Report
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The Completely Full Location(s) Detail Report appears in portrait layout.

4.22.9.2 Group and Sort Criteria
The Completely Full Location(s) Detail Report is grouped by Location 
Type.

The Location Type is sorted in ascending order.

4.22.9.3 Page Break Criteria
The Completely Full Location(s) Detail Report has no page break criteria.

4.22.10 Partially Full Location(s) Detail Report
The Partially Full Location(s) Detail Report provides a detail report on the 
locations which are partially available on the system for that particular 
node.

4.22.10.1 Report Layout
This section describes the layout of the Partially Full Location(s) Detail 
Report.

Table 4–68 Completely Full Location(s) Detail Report

Field Description

Location Type The type specified for a location which indicates the 
purpose the location serves.

Location ID The ID of the location for which the report is 
generated.

Aisle Number The number of the aisle where the shipment is 
located.

Level Number The number of the level where the shipment is 
located.

Bay Number The number of the bay where the shipment is located

Current Available 
Volume

The volume of the location available for usage.

Pend In Volume Items awaited in the near future for that particular 
location.

Net Available Volume The actual volume available for usage.
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Partially Full Location(s) Detail Report

Figure 4–65 Partially Full location(s) Detail Report
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The Partially Full Location(s) Detail Report appears in portrait layout.

4.22.10.2 Group and Sort Criteria
The Partially Full Location(s) Detail Report is grouped by Location Type.

The Location Type is sorted in ascending order.

4.22.10.3 Page Break Criteria
The Partially Full Location(s) Detail Report has no page break criteria.

Table 4–69 Partially Full Location(s) Detail Report

Field Description

Location Type The type specified for a location which indicates the 
purpose the location serves.

Location ID The ID of the location for which the report is 
generated.

Aisle Number The number of the aisle where the shipment is 
located.

Level Number The number of the level where the shipment is 
located.

Bay Number The number of the bay where the shipment is located

Current Available 
Volume

The volume of the location available for usage.

Pend In Volume Items awaited in the near future for that particular 
location.

Net Available Volume The actual volume available for usage.
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Partially Full Location(s) Detail Report



VAS Reports   301

5
VAS Reports

The following Value Added Services (VAS) report can be generated using 
the Sterling Warehouse Management System:

Work Order Report
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Report Criteria

5.1 Work Order Report
The Work Order Report displays all the work orders for the node, in 
different stages of completion. This report is used to review open work 
orders.

Intended Audience
The warehouse manager and inventory supervisor uses the Work Order 
Report to identify the different stages of completion of work orders. The 
open work orders can be reviewed using this report.

5.1.1 Generating the Report
To generate the Work Order Report:

1. Navigate to VAS > Work Order Report. The Work Order Report criteria 
screen appears. For more information about the Work Order Report 
criteria screen, see Section 5.1.2, "Report Criteria".

2. Enter the criteria and click Generate Report. The Work Order Report 
appears. For more information about the Work Order Report layout, 
see Section 5.1.4, "Report Layout".

5.1.2 Report Criteria
The Work Order Report criteria screen enables you to enter the criteria 
for which the Work Order Report generates.
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Figure 5–1 Work Order Report Criteria Screen
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Report Criteria

Table 5–1 Work Order Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

Yes

Start No 
Earlier Than

Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
and  icons to choose the 
date range and time.

The current 
date. 

The time is 
00:00:00 and 
23:59:59.

Yes

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the current 
enterprise of 
the user 
appears as the 
default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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5.1.3 Work Order Report
The Work Order Report displays the work orders in different stages of 
completion and also aids in reviewing the open work orders.

Service Item 
Group

The value of Service Item Group indicates whether the 
report is for Inventory Compliance, De Kitting, Inventory 
Changes, or Kitting.

Work Order 
Status

Enter the status of the 
work order between the 
dates specified.

Work Order 
Created.

Yes

Table 5–1 Work Order Report Criteria Screen

Field Description Default Value Mandatory

Inventory 
Compliance

Select this to 
view the "Work 
Order Report" 
for the 
Inventory 
Compliance 
service item 
group. 

Selected Yes

De Kitting Select this to 
view the "Work 
Order Report" 
for the De 
Kitting service 
item group. 

Not Selected Yes

Inventory 
Changes

Select this to 
view the "Work 
Order Report" 
for the 
Inventory 
Changes 
service item 
group. 

Not Selected Yes

Kitting Select this to 
view the "Work 
Order Report" 
for the Kitting 
service item 
group. 

Not Selected Yes
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Report Layout

5.1.4 Report Layout
This section describes the layout of the Work Order Report.

Note: The value of Service Item Group indicates whether 
the report is for Inventory Compliance, De Kitting, 
Inventory Changes, or Kitting.

In the Work Order Report for Inventory Compliance, 
the value of Service Item Group is Inventory 
Compliance.

In the Work Order Report for De Kitting, the value of 
Service Item Group is De Kitting.

In the Work Order Report for Inventory Changes, the 
value of the Service Item Group is Inventory Changes.

In the Work Order Report for Kitting, The value of the 
Service Item Group is Kitting.
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Figure 5–2 Work Order Report
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Additional Setup Required

The Work Order Report is displayed in portrait layout.

5.1.5 Group and Sort Criteria
The Work Order Report is grouped by Enterprise Code, Work Order No., 
Work Order Status, and Item ID.

Enterprise Code, and Work Order No are sorted in ascending order. 
Within a Work Order number, the Work Order Status and Item ID are 
sorted in ascending order.

5.1.6 Page Break Criteria
For each new enterprise, the report starts in a new table, on another 
page. The name of the enterprise is printed at the top of the table.

5.1.7 Additional Setup Required
There is no additional setup required to generate this report.

Table 5–2 Work Order Report 

Field Description

Work Order No The number of the work order.

Work Order Status The status of the work order.

Container Type The type of the container.

Container No. The identifier number of the container.

Item ID The identifier of the item.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Quantity Allocated The quantity of items allocated for a specific work 
order.

Quantity Completed The quantity of items that met the work order 
requirements.

Quantity Remaining The quantity of items remaining that did not meet the 
work order requirements.
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6
Outbound Reports

The following outbound reports can be generated using the Sterling 
Warehouse Management System:

BOL Total Weights Report

Container Volume Monthly Report

Daily Shipment Report

Dock Pickup Schedule Report

Generic Shipper Report

Hot Inventory Report

On Time Shipment Report

Order Billing Summary Report

Order Cycle Time KPI Report

Order Shipment Report

Outbound Labor Requirements Report

Pack and Hold Shipment Report

Parcel Manifest Report

Replenishment Status Report

Same Day Pick Pack Ship Percentage Report

Shipment Billing Summary Report

Shipment Fill Rate Monthly Report

Shipments Near or Past Cancel Date Report
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Shipment Shortage Report

Staging Locations Report
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6.1 BOL Total Weights Report
The BOL Total Weights Report lists the number of cartons or pallets, and 
the total weight details against each Bill Of Lading (BOL). The report lists 
all details for BOLs shipped for the selected carrier or date range. 

Intended Audience
Warehouse managers and outbound supervisors use this report to track 
the TL/LTL shipments that are shipped. It is also useful to the warehouse 
in reconciling TL/LTL billings based on the shipped weights.

6.1.1 Generating the Report
To generate the BOL Total Weights Report:

1. Navigate to Outbound > BOL Total Weights Report. The BOL Total 
Weights Report criteria screen appears. For more information about 
the BOL Total Weights Report criteria screen, see Section 6.1.2, 
"Report Criteria".

2. Enter the criteria and click Generate Report to generate the Report. 
The BOL Total Weights Report appears. For more information about 
the BOL Total Weights Report layout, see Section 6.1.3, "Report 
Layout".

6.1.2 Report Criteria
The BOL Total Weights Report criteria screen enables you to enter the 
criteria for which the BOL Weights Report generates.
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Figure 6–1 BOL Total Weights Report Criteria Screen

Table 6–1 BOL Total Weights Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For outbound reports, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order. Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No



Report Layout

 Outbound Reports   313

6.1.3 Report Layout
This section describes the layout of the BOL Total Weights Report.

Actual 
Departure Date

Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes

Carrier Enter the carrier 
corresponding to the 
shipment.

Click  to choose the 
carrier for the report to 
be generated.

Blank. No

Table 6–1 BOL Total Weights Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering the 
enterprises in which the 
user participates.

Selected. No
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Report Layout

Figure 6–2 BOL Total Weights Report

Group Total For 
Carrier WWAT

Group Total For 
Enterprise E1 
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The BOL Total Weights Report appears in portrait layout.

6.1.4 Group and Sort Criteria
The BOL Total Weights Report is grouped by Carriers.

Carriers are sorted in ascending order.

Within a specific Carrier, the Actual Departure Date and BOL No. are 
sorted in descending order.

6.1.5 Page Break Criteria
The BOL Total Weights Report has no page break criteria.

6.1.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 6–2 BOL Total Weights Report

Field Description

Carrier The carrier through which the load has been shipped.

Actual Departure Date The date on which the shipment was shipped.

BOL No. The Bill of Lading number.

No. of Cases The number of cases in a particular BOL.

No. of Pallets The number of pallets in a particular BOL.

Weight The weight of that particular BOL.

Total Weight UOM The total weight in terms of UOM.

Group Total For 
Carrier

The total number of cases and pallets in a BOL for a 
particular carrier.

In the above Figure 6–2, WWAT is the carrier. 

Group Total For 
Enterprise

The total number of cases and pallets in a BOL for all 
carriers.
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6.2 Container Volume Monthly Report
The Container Volume Monthly Report shows the number of containers 
shipped each month. For the current month, it only shows the total 
number of cartons shipped till date.

Intended Audience
Warehouse managers, outbound supervisors, and as well as enterprise users, 
use this report to track the number of containers that are shipped on a 
monthly basis.

6.2.1 Generating the Report
To generate the Container Volume Monthly Report:

1. Navigate to Outbound > Container Volume Monthly Report. The   
Container Volume Monthly Report Criteria screen appears. For more 
information about the Container Volume Monthly Report criteria 
screen, see Section 6.2.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Container Volume Monthly Report appears. For more information 
about the Container Volume Monthly Report layout, see Section 6.2.3, 
"Report Layout".

6.2.2 Report Criteria
The Container Volume Monthly Report criteria screen enables you to 
enter the criteria for which the Container Volume Monthly Report 
generates.
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Figure 6–3 Container Volume Monthly Report Criteria Screen
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Table 6–3 Container Volume Monthly Report Criteria screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For outbound reports, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order. Yes

Node The node for which the 
report is generated.

If you are an enterprise 
user, select the 
appropriate node from 
the drop-down list. For 
other users, the current 
node of the user appears.

The current 
node of the 
user.

No

Actual Ship 
Date

Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The date three 
months prior 
to the current 
date and the 
current date.

Yes

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering the 
enterprises in which the 
user participates.

Selected. No
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6.2.3 Report Layout
This section describes the layout of the Container Volume Monthly 
Report.
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Report Layout

Figure 6–4 Container Volume Monthly Report 
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For each month the total number of containers shipped is printed on top 
of the bar representing the shipment shipped in a month.

The Container Volume Monthly Report appears in portrait layout.

6.2.4 Group and Sort Criteria
The Container Volume Monthly Report is grouped by Month. 

Month is sorted in descending order.

6.2.5 Page Break Criteria
The Container Volume Monthly Report has no page break criteria.

6.2.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 6–4 Container Volume Monthly Report 

Field Description

No. of containers 
shipped

The number of containers or cartons shipped.

Ship Month The month in which the shipments are shipped, within 
a specified date range. 

This is grouped by Enterprise Code. 
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6.3 Daily Shipment Report
The Daily Shipment Report provides high-level visibility into shipment 
activity in the warehouse, on a daily basis, for a specified date range. 
This report provides daily information on new shipments awaiting 
shipping on that day, shipments shipped on that day, shipments pending 
from previous days, and shipments carried over to the next day.

Intended Audience
Warehouse managers and outbound supervisors use this report to get an 
update on the total number of shipments shipped and pending on a daily 
basis.

6.3.1 Generating the Report
To generate the Daily Shipment Report:

1. Navigate to Outbound > Daily Shipment Report. The Daily Shipment 
Report criteria screen appears. For more information about the Daily 
Shipment Report criteria screen, see Section 6.3.2, "Report Criteria". 

2. Enter the criteria and click Generate Report. The Daily Shipment 
Report appears. For more information about the Daily Shipment 
Report layout, see Section 6.3.3, "Report Layout".

6.3.2 Report Criteria
The Daily Shipment Report criteria enables you to enter the criteria for 
which the Daily Shipment Report generates. 
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Figure 6–5 Daily Shipment Report Criteria Screen
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Table 6–5 Daily Shipment Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For outbound reports, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order. Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Statistics Date Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes

Shipment 
Mode

Select the specific mode 
of shipment from the 
drop-down menu.

Blank. No

 Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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6.3.3 Report Layout
This section describes the layout of the Daily Shipment Report.

Seller Enter the seller 
organization. 

You can also click  to 
select the seller 
organization.

Blank. No

Carrier Enter the carrier.

You can also click  to 
select the carrier for a 
specific enterprise. 

Blank. No

Table 6–5 Daily Shipment Report Criteria Screen

Field Description Default Value Mandatory
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Report Layout

Figure 6–6 Daily Shipment Report
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The Daily Shipment Report appears in portrait layout.

6.3.4 Group and Sort Criteria
The Daily Shipment Report is grouped by Date.

Date is sorted in descending order.

6.3.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

Table 6–6 Daily Shipment Report Screen

Field Description

Date The date on which the data for the shipment was 
created. 

Shipments Expected to 
be Shipped

The number of shipments expected to be shipped for a 
specific date.

Shipments Pending 
from Previous Day(s)

The number of shipments pending from the previous 
days until this particular date.

Shipments Shipped The number of shipments shipped until that particular 
date.

Pending Shipments 
Shipped

The number of shipments pending until that date and 
shipped on that date.

Shipments shipped on 
Time

The number of shipments shipped at the expected 
time of shipment.

Shipments Shipped 
Early

The number of shipments shipped earlier than the 
expected date of shipment.

Containers Shipped The total number of cartons shipped for all the 
shipments on that date.

Units Shipped The total number of items shipped on that date.

Shipments Carried 
Over

The number of shipments that were not shipped on 
that date and were carried over to the next date.
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6.3.6 Additional Setup Required
To populate the data required for the Daily Shipment Report, run the 
COLLECT_SHIPMENT_STATISTICS agent.

The COLLECT_SHIPMENT_STATISTICS agent mines the data required for 
the Daily Shipment Report from the Shipment transactions and populates 
the YFS_SHIPMENT_STATISTICS table.

6.4 Dock Pickup Schedule Report
The Dock Pickup Schedule Report provides visibility into appointments 
taken for one or more shipping docks, for a range of dates.

Intended Audience
Warehouse managers and outbound supervisors use this report to keep 
track of dock appointments.

6.4.1 Generating the Report
To generate the Dock Pickup Schedule Report:

1. Navigate to Outbound > Dock Pickup Schedule Report. The Dock 
Schedule Report criteria screen displays.

2. Enter the criteria and click Generate Report to generate the report. 
The Dock Schedule Report displays. For more information about the 
Dock Schedule Report layout, see Section 2.2.3, "Report Layout" of 
Chapter 2, "Inbound Reports".

The report criteria, report layout, group and sort criteria, page break 
criteria, and additional setup required for this report is similar to the 
Delivery Dock Schedule Report. For more information about the Delivery 
Dock Schedule Report, see Section 2.2, "Delivery Dock Schedule Report" 
of Chapter 2, "Inbound Reports".
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6.5 Generic Shipper Report
The Generic Shipper Report gives details of shipments that are either to 
be shipped or were shipped using each carrier that the warehouse uses. 
The warehouse can use this report to understand the carrier usage 
patterns.

Intended Audience
Warehouse managers and outbound supervisors use the Generic Shipper 
Report to check the shipment details. The report is generated manually.

6.5.1 Generating the Report
To generate the Generic Shipper Report:

1. Navigate to Outbound > Generic Shipper Report. The Generic Shipper 
Report criteria screen appears. For more information about the 
Generic Shipper Report criteria screen, see Section 6.5.2, "Report 
Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Generic Shipper Report appears. For more information about the 
Generic Shipper Report layout, see Section 6.5.3, "Report Layout".

6.5.2 Report Criteria
The Generic Shipper Report criteria screen enables you to enter the 
criteria for which the Generic Shipper Report generates.
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Report Criteria

Figure 6–7 Generic Shipper Report Criteria Screen
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Table 6–7 Generic Shipper Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For this report, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order. Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Expected 
Shipment Date

Enter the start date and 
end date for which the 
report is generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes

Buyer Enter the buyer to whom 
the shipment is shipped.

You can also click  to 
choose the buyer.

Blank. No

 Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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Report Layout

6.5.3 Report Layout
This section describes the layout of the Generic Shipper Report.

Carrier Enter the carrier of the 
shipment.

You can also click  to 
choose the carrier.

Blank. No

Shipment 
Mode

Enter this to select a 
specific mode of 
shipment from the drop- 
down list.

Blank. No

Load No. Enter the load number of 
the shipment.

Blank. No

Receiving Node Enter the receiving node 
of the shipment.

You can also click to 
choose the receiving 
node.

Blank. No

Status Status of the shipment Shipment 
Created to 
Shipment 
Shipped.

Yes

Table 6–7 Generic Shipper Report Criteria Screen

Field Description Default Value Mandatory
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Figure 6–8 Generic Shipper Report
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Page Break Criteria

The Generic Shipper Report appears in portrait layout.

6.5.4 Group and Sort Criteria
The Generic Shipper Report is grouped by Enterprise Code, Requested 
Ship Date, Load No., and Shipment No. 

The Enterprise Code, Requested Ship Date, Load No., and Shipment No. 
are sorted in ascending order.

6.5.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

Table 6–8 Generic Shipper Report

Field Description

Enterprise Code This report is grouped by Enterprise Code.

Expected Shipment 
Date

The date on which the shipment is expected to reach 
the destination.

Load No. The load number of the load shipped.

Shipment No. The shipment number of the shipment shipped.

Status The status of the shipped shipment.

Seller The organization which ships the shipment.

Buyer The buyer to whom the shipment is shipped.

Receiving Node The node to which the shipment is shipped.

Destination The destination of the shipment.

Carrier/Service The carrier used for the shipment.

Ship Mode The mode of delivery of the shipment.

Weight The total weight of the shipment.

Weight UOM The unit of measure for the weight of the shipment.

Volume The volume of the shipment.

Volume UOM The unit of measure for the volume of the shipment.
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6.5.6 Additional Setup Required
There is no additional setup required to generate this report.
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6.6 Hot Inventory Report
The Hot Inventory Report helps identify the inbound shipments that 
should be unloaded by priority based on the hot items in the container. 
Hot items are items that are on backorder for the warehouse. 

The information of the backordered items is available in DOM, or in 
shortages in outbound shipments for the node.

Intended Audience
Warehouse managers and outbound supervisors use this report to 
prioritize inventory by comparing it with the transactions for the day. To 
access this report, the user must belong to the data security group 
representing warehouse manager and the outbound supervisor.

6.6.1 Generating the Report
To generate the Hot Inventory Report:

1. Navigate to Outbound > Hot Inventory Report. The Hot Inventory 
Report criteria screen appears. For more information about the Hot 
Inventory Report criteria screen, see Section 6.6.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Hot Inventory Report appears. For more information about the 
Hot Inventory Report layout, see Section 6.6.3, "Report Layout".

6.6.2 Report Criteria
The Hot Inventory Report criteria screen enables you to enter the criteria 
for which the Hot Inventory Report generates.
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Figure 6–9 Hot Inventory Report Criteria Screen

Table 6–9 Hot Inventory Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For this report, the 
document types displayed 
are Blind Return, Blind 
Order, Transfer Order and 
Purchase Order. 

Purchase 
Order.

Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No



338   Reports Guide
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6.6.3 Report Layout
This section describes the layout of the Hot Inventory Report.

Requested 
Ship Date

Enter the requested ship 
date to see all hot 
inventory for all 
shipments due until that 
particular date.

You can also click the  
icon to select the ship 
date.

The current 
date.

Yes

Table 6–9 Hot Inventory Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting this, 
the current 
enterprise of the 
user appears as 
the user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering the 
enterprises in which the 
user participates.

Selected. No
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Figure 6–10 Hot Inventory Report
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Additional Setup Required

The Hot Inventory Report appears in portrait layout.

6.6.4 Group and Sort Criteria
The Hot Inventory Report is grouped by Enterprise Code, Item ID, and 
Back Ordered Quantity.

The Enterprise Code and Item ID is sorted in ascending order.

6.6.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

6.6.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 6–10 Hot Inventory Report

Field Description

Item ID The identifier of the item which is in demand.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Shortage Quantity The quantity of the items on backorder for the 
warehouse or in shortage for the outbound shipment.

Inbound Shipment No. The shipment number of the inbound shipment.

Expected Delivery Date The expected date of delivery of the inbound shipment 
into the warehouse.

Shipment Status The description of the status of the inbound shipment.

Shipment Quantity The quantity of inbound shipments.
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6.7 On Time Shipment Report
The On Time Shipment Report captures the number of shipments shipped 
at the scheduled time. It also categorizes the delayed shipments into 
buckets of delays by one, two, or more days.

Intended Audience
Warehouse managers, outbound supervisors, as well as enterprise user, use this 
report to capture the number of shipments that are shipped as planned 
or delayed by one, two, three, or more than three days.

6.7.1 Generating the Report
To generate the On Time Shipment Report:

1. Navigate to Outbound > On Time Shipment Report. The On Time 
Shipment Report criteria screen appears. For more information about 
the On Time Shipment Report criteria screen, see Section 6.7.2, 
"Report Criteria".

2. Enter the criteria and click Generate Report to generate the 
report.The On Time Shipment Report appears. For more information 
about the On Time Shipment Report layout, see Section 6.7.3, 
"Report Layout". 

6.7.2 Report Criteria
The On Time Shipment Report criteria screen enables you to enter the 
criteria for which the On Time Shipment Report generates.
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Figure 6–11 On Time Shipment Report Criteria Screen

.

Table 6–11 On Time Shipment Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For this report, the 
document types Transfer 
Order and Sales Order. 

Sales Order. Yes

Node The node for which the 
report is generated.

If you are an enterprise 
user, select the 
appropriate node from 
the drop-down list. For 
other users, the current 
node of the user appears.

The current 
node of the 
user.

No
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6.7.3 Report Layout
This section describes the layout of the On Time Shipment Report.

Actual Ship 
Date

Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes

Table 6–11 On Time Shipment Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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Figure 6–12 On Time Shipment Report 
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The On Time Shipment Report appears in portrait layout.

6.7.4 Group and Sort Criteria
The On Time Shipment Report is grouped by Enterprise Code and Actual 
Ship Date. 

The Enterprise Code is sorted in ascending order. Within a specific Node, 
the Actual Ship Date is sorted in descending order.

6.7.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

6.7.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 6–12 On Time Shipment Report 

Field Description

Node The node for which the report is generated.

Actual Ship Date The actual date of shipment.

No. of Shipments The number of shipments on a particular date. 

No. Shipments 
Shipped as Scheduled

Number of shipments shipped as per the schedule.

No. Shipments Delayed 
by 1 Day

Number of shipments delayed by 1 day.

No. Shipments Delayed 
by 2 Days

Number of shipments delayed by 2 days.

No. Shipments Delayed 
by 3 Days

Number of shipments delayed by 3 days.

No. Shipments Delayed 
by more than 3 Days

Number of shipments delayed by more than 3 days.
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6.8 Order Billing Summary Report
The Order Billing Summary Report lists the transaction details for all 
types of orders handled by the warehouse. This report helps to track the 
matrix of information for transactions, such as the number of orders or 
order lines shipped or received.

Intended Audience
Enterprise users use the Order Billing Summary Report to track the 
transactions made for particular date range. The report is generated 
manually.

6.8.1 Generating the Report
To generate the Order Billing Summary Report:

1. Navigate to Order > Order Billing Summary Report. The Order Billing 
Summary Report criteria screen appears. For more information about 
the Order Billing Summary Report criteria screen, see Section 6.8.2, 
"Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Order Billing Summary Report appears. For more information 
about the Order Billing Summary Report layout, see Section 6.8.3, 
"Report Layout".

6.8.2 Report Criteria
The Order Billing Summary Report criteria screen enables you to enter 
the criteria for which the Order Billing Summary Report generates.

Note: This report is accessible only to enterprise users 
and does not display in the menu of other users.
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Figure 6–13 Order Billing Summary Report Criteria Screen

6.8.3 Report Layout
This section describes the layout of the Order Billing Summary Report.

Table 6–13 Order Billing Summary Report Criteria Screen

Field Description Default Value Mandatory

Order Date Enter the start date and 
end date for which the 
report is generated.

You can also click the  
icons to choose the date 
range.

The date one 
month prior to 
the current 
date and the 
current date.

Yes

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering the 
enterprises in which the 
user participates.

Selected. No
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Report Layout

Figure 6–14 Order Billing Summary Report
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The Order Billing Summary Report appears in portrait layout.

6.8.4 Group and Sort Criteria
The Order Billing Summary Report is grouped by Enterprise Code and 
Date.

The Enterprise Code is sorted in ascending order, and the Date is sorted 
in descending order. 

6.8.5 Page Break Criteria
The Order Billing Summary Report does not have any page break criteria.

Table 6–14 Order Billing Summary Report Screen

Field Description

Date The date of transaction for all orders in the 
warehouse.

No. of Inbound Orders The number of inbound orders.

Click this to view the Inbound Order Billing Detail 
Report.

No. of Inbound Order 
Lines

The number of inbound order Lines.

Click this to view the Inbound Order Lines Billing Detail 
Report.

No. of Outbound 
Orders

The number of outbound orders. 

Click this to view the Outbound Order Billing Detail 
Report.

No. of Outbound Order 
Lines

The number of outbound order Lines. 

Click this to view the Outbound Order Lines Billing 
Detail Report.

Total for E1 The data is summarized by enterprise for all orders.

For example, in the Figure 6–14, E1 is such an 
enterprise.

Grand Total The total number of orders across all enterprises.
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Inbound Order Billing Detail Report

6.8.6 Additional Setup Required
Run the CLOSE_ORDER agent to close the orders. These closed orders are 
displayed by the Order Billing Summary Report.

6.8.7 Inbound Order Billing Detail Report 
The report lists the details of the inbound orders.

6.8.7.1 Report Layout
This section describes the layout of the Inbound Order Billing Detail 
Report.
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Figure 6–15 Inbound Order Billing Detail Report
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Inbound Order Lines Billing Detail Report

The Inbound Order Billing Detail Report appears in portrait layout.

6.8.7.2 Group and Sort Criteria
The Inbound Order Billing Detail Report is grouped by Document Type 
and Order No.

The Document Type and Order No. are sorted in ascending order. 

6.8.7.3 Page Break Criteria
The Inbound Order Billing Detail Report has no page break criteria.

6.8.8 Inbound Order Lines Billing Detail Report
The Inbound Order Lines Billing Detail Report lists the order numbers of 
the inbound orders and their order lines.

6.8.8.1 Report Layout
This section describes the layout of the Inbound Order Lines Billing Detail 
Report.

Table 6–15 Inbound Order Billing Detail Report

Field Description

Document Type The document type of the inbound orders.

Order No. The order numbers of the item.

No data is displayed in the report screen if no order 
exists for the item.

Order Date The date on which the order is created.

Order Type The type of order.

Buyer The buyer to whom the shipment is shipped.

Seller The seller organization.
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Figure 6–16 Inbound Order Lines Billing Detail Report
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Outbound Order Billing Detail Report

The Inbound Order Lines Billing Detail Report appears in portrait layout.

6.8.8.2 Group and Sort Criteria
The Inbound Order Lines Billing Detail Report is grouped by Document 
Type and Order No.

The Document Type and Order No. are sorted in ascending order. 

6.8.8.3 Page Break Criteria
The Inbound Order Lines Billing Detail Report has no page break criteria.

6.8.9 Outbound Order Billing Detail Report
The Outbound Order Billing Detail Report lists the order numbers of the 
outbound orders.

6.8.9.1 Report Layout
This section describes the layout of the Outbound Order Billing Detail 
Report.

Table 6–16 Inbound Order Lines Billing Detail Report

Field Description

Document Type The document type of the inbound orders.

Order No. The order number of the item. 

No data is displayed in the report screen if no order 
exists for the item.

Order Date The date on which the order is created.

Order Type The type of order.

Buyer The buyer to whom the shipment is shipped.

Seller The seller organization.

Prime Line No. The order line of the order.

Sub Line No. The sub line number of the component of the item.
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Figure 6–17 Outbound Order Billing Detail Report
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Outbound Order Lines Billing Detail Report

The Outbound Order Billing Detail Report appears in portrait layout.

6.8.9.2 Group and Sort Criteria
The Outbound Order Billing Detail Report is grouped by Document Type 
and Order No.

The Document Type and Order No. are sorted in ascending order. 

6.8.9.3 Page Break Criteria
The Outbound Order Billing Detail Report has no page break criteria.

6.8.10 Outbound Order Lines Billing Detail Report
The Outbound Order Lines Billing Detail Report lists the order numbers of 
the outbound orders and their order lines.

6.8.10.1 Report Layout
This section describes the layout of the Outbound Order Lines Billing 
Detail Report.

Table 6–17 Outbound Order Billing Detail Report

Field Description

Document Type The document type of the outbound orders.

Order No. The order number of the item. 

No data is displayed in the report screen if no order 
exists for the item.

Order Date The date on which the order is created.

Order Type The type of order.

Buyer The buyer to whom the shipment is shipped.

Seller The seller organization.
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Figure 6–18 Outbound Order Lines Billing Detail Report
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Outbound Order Lines Billing Detail Report

The Outbound Order Lines Billing Detail Report appears in portrait layout.

6.8.10.2 Group and Sort Criteria
The Outbound Order Lines Billing Detail Report is grouped by Document 
Type and Order No.

The Document Type and Order No. are sorted in ascending order. 

6.8.10.3 Page Break Criteria
The Outbound Order Lines Billing Detail Report has no page break 
criteria.

Table 6–18 Outbound Order Lines Billing Detail Report

Field Description

Document Type The document type of the outbound orders.

Order No. The order number of the item. 

No data is displayed in the report screen if no order 
exists for the item.

Order Date The date on which the order is created.

Order Type The type of order.

Buyer The buyer to whom the shipment is shipped.

Seller The seller organization.

Prime Line No. The order line number of the order.

Sub Line No. The sub line number of the component of the item.



Report Criteria

 Outbound Reports   359

6.9 Order Cycle Time KPI Report
The Order Cycle Time KPI Report is used to measure the turnaround 
cycle time on all outbound shipments or orders. Cycle time is defined as 
the time that elapsed between the release of a shipment or order to a 
warehouse and the time it is shipped.

Intended Audience
Warehouse managers, outbound supervisors, and as well as enterprise 
users, use the Order Cycle Time KPI Report to measure the 
pick-pack-ship efficiency of the warehouse. The report is generated 
manually. 

6.9.1 Generating the Report
To generate the Order Cycle Time KPI Report:

1. Navigate to Outbound > Order Cycle Time KPI Report. The Order 
Cycle Time KPI Report criteria screen appears. For more information 
about the Order Cycle Time KPI Report criteria screen, see 
Section 6.9.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Order Cycle Time KPI Report appears. For more information 
about the Order Cycle Time KPI Report layout, see Section 6.9.3, 
"Report Layout".

6.9.2 Report Criteria
The Order Cycle Time KPI Report criteria screen enables you to enter the 
criteria for which the Order Cycle Time KPI Report generates.
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Figure 6–19 Order Cycle Time KPI Report Criteria Screen
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Table 6–19 Order Cycle Time KPI Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For this report, the 
document types Transfer 
Order and Sales Order. 

Sales Order. Yes

Node The node for which the 
report is generated.

If you are an enterprise 
user, select the 
appropriate node from 
the drop-down list. For 
other users, the current 
node of the user appears.

The current 
node of the 
user.

No

Actual 
Shipment Date

Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
and  icons to choose 
the date range and time.

For Date:The 
current date. 

For Time: 
00:00:00 and 
23:59:59.

Yes

Shipment 
Mode

Select the mode of the 
shipment from the drop- 
down list.

Blank. No

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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6.9.3 Report Layout
This section describes the layout of the Order Cycle Time KPI Report.

Carrier Enter the carrier of the 
shipment.

You can also click the  
icon to select the carrier.

Blank. No

Cycle Time (in 
Hrs)

Enter the amount of time 
that elapsed between 
the release of a 
shipment or order to a 
warehouse and the 
time it is shipped.

8 Yes

Table 6–19 Order Cycle Time KPI Report Criteria Screen

Field Description Default Value Mandatory
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Figure 6–20 Order Cycle Time KPI Report
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Report Layout

Table 6–20 Order Cycle Time KPI Report

Field Description

Node The node of the enterprise for which the report is 
generated.

Ship Date The date the shipments are shipped from the 
warehouse.

Carrier The carrier service used for shipping the shipments.

Ship Mode The mode of shipping the shipments.

For example, in the Figure 6–20, parcel is the ship 
mode.

No. of Shipments 
Shipped

Displays the total number of shipments shipped from 
the node.

Click this to view the Order Cycle Time Detail Report 
Detail Report, which displays the total number of 
shipments shipped. 

Shipments Shipped 
within X hrs

Displays the number of shipments shipped within the 
given time interval.

Click this to view the Order Cycle Time Report Within X 
hours, which displays the list of shipments shipped 
within X hrs.

Shipments Shipped 
within 2X hrs

Displays the number of shipments shipped within twice 
the given time interval.

Click this to view the Order Cycle Time Report Within 
2X hours, which displays the list of shipments shipped 
within 2X hrs.
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The Order Cycle Time KPI Report appears in portrait layout.

6.9.4 Group and Sort Criteria
The Order Cycle Time KPI Report is grouped by Enterprise Code, Node, 
and Ship Date.

The Enterprise Code is sorted in ascending order and Ship Date is sorted 
in descending order.

6.9.5 Page Break Criteria
For each new enterprise, the report starts in a new table. The name of 
the enterprise is printed at the top of the table.

6.9.6 Additional Setup Required
There is no additional setup required to generate this report.

Shipments Shipped 
beyond 2X hrs

Displays the number of shipments shipped after twice 
the given time interval.

Click this to view the Order Cycle Time Report Beyond 
2X hours, which displays the list of shipments shipped 
beyond 2X hrs.

Table 6–20 Order Cycle Time KPI Report

Field Description

Total number of shipments shipped.

The number of shipments shipped within x hours.

The number of shipments shipped within 2x hours.

The number of shipments shipped beyond 2x 
hours.
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6.9.7 Order Cycle Time Detail Report 
This report gives the list of all the outbound shipments and their details 
for a particular warehouse.

6.9.7.1 Report Layout
This section describes the layout of the Order Cycle Time Detail Report.
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Figure 6–21 Order Cycle Time Detail Report
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Order Cycle Time Report Within 2X hours

The Order Cycle Time Detail Report appears in portrait layout.

6.9.7.2 Group and Sort Criteria
This report is grouped by Enterprise Code and Node.

The Enterprise Code, Node, and Shipment Number are sorted in 
ascending order.

6.9.7.3 Page Break Criteria
For each new enterprise, the report starts in a new table. The name of 
the enterprise is printed at the top of the table.

6.9.8 Order Cycle Time Report Within X hours
This report gives the details of all the shipments shipped within X hrs.

The fields, layout, group and sort criteria and page break criteria of this 
report are similar to the Order Cycle Time Detail Report.

6.9.9 Order Cycle Time Report Within 2X hours
This report gives the details of all the shipments shipped within 2X hrs.

The fields, layout, group and sort criteria and page break criteria of this 
report are similar to the Order Cycle Time Detail Report.

Table 6–21 Order Cycle Time Detail Report

Field Description

Node The node to where the shipment is shipped.

Shipment No. The shipment number of the shipment shipped.

Ship Date The date the shipments are shipped from the 
warehouse.

Carrier The organization from where the items are shipped.

Ship Mode The mode of shipping the shipments.

For example, in the Figure 6–21, parcel is the ship 
mode.

Cycle Time The time between the release of elapsed from when an 
order to a warehouse and to the time it is shipped.
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6.9.10 Order Cycle Time Report Beyond 2X hours
This report gives the details of all the shipments shipped beyond 2X hrs.

The fields, layout, group and sort criteria and page break criteria of this 
report are similar to the Order Cycle Time Detail Report.
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6.10 Order Shipment Report
The Order Shipment Report provides the details of the shipments shipped 
against the orders. 

This report helps to identify all shipments made against an order, as 
there are many cases where an order is fulfilled in multiple shipments.

Intended Audience
Warehouse managers and outbound supervisors use the Order Shipment 
Report to track all the shipments made against for an order. This report 
is generated manually.

6.10.1 Generating the Report
To generate the Order Shipment Report:

1. Navigate to Outbound > Order Shipment Report. The Order Shipment 
Report criteria screen appears. For more information about the Order 
Shipment Report criteria screen, see Section 6.10.2, "Report 
Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Order Shipment Report appears. For more information about the 
Order Shipment Report layout, see Section 6.10.3, "Report Layout".

6.10.2 Report Criteria
The Order Shipment Report criteria screen enables you to enter the 
criteria for which the Order Shipment Report generates.
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Figure 6–22 Order Shipment Report Criteria Screen

 

Table 6–22 Order Shipment Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For this report, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order. Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No
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6.10.3 Report Layout
This section describes the layout of the Order Shipment Report.

Actual Ship 
Date

Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes

Order No Enter the order number 
of the shipment. 

You can click to search 
for the order number.

Blank. No

Buyer Enter the name of the 
buyer.

You can click to search 
for the buyer.

Blank. No

Table 6–22 Order Shipment Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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Figure 6–23 Order Shipment Report
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The Order Shipment Report appears in portrait layout.

6.10.4 Group and Sort Criteria
The Order Shipment Report is grouped by Enterprise Code, Order No., 
and Ship Date.

The Enterprise Code and Order No. are sorted in ascending order and 
Ship Date is sorted in descending order.

6.10.5 Page Break Criteria
For each new enterprise, the report starts in a new table. The name of 
the enterprise is printed at the top of the table.

6.10.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 6–23 Order Shipment Report

Field Description

Order No. The order number for which the shipment is shipped.

Ship Date The date on which the shipment is shipped.

Shipment No. The number of the shipment that is shipped.

Seller The organization that ships the shipment.

Buyer The organization to which the shipment is shipped.

Item ID The identifier of the item.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure for the item.

Quantity Ordered The quantity of the item the customer has requested.

Quantity Shipped The quantity of the item shipped to the customer.
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6.11 Outbound Labor Requirements Report
The Outbound Labor Requirements Report is used to determine the labor 
requirements for waves or shipments that are to be picked, packed, and 
shipped on a future date. This report is useful to plan resource 
requirements for outbound activities.

Intended Audience
Warehouse managers and outbound supervisors use this report to plan 
resources for picking.This report also helps them to decide whether to 
reduce shipments, move people from other operations, or add more 
shipments when resources are available.

6.11.1 Generating the Report
To generate the Outbound Labor Requirements Report:

1. Navigate to Outbound > Outbound Labor Requirements Report. The 
Outbound Labor Requirements criteria screen appears. For more 
information about the Outbound Labor Requirements Report criteria 
screen, see Section 6.11.2, "Report Criteria".

2. Enter the criteria and click Generate Report. The Outbound Labor 
Requirements Report appears. For more information about the 
Outbound Labor Requirements Report layout, see Section 6.11.3, 
"Report Layout". 

6.11.2 Report Criteria
The Outbound Labor Requirements Report criteria screen enables you to 
enter the criteria for which the Outbound Labor Requirements Report 
generates.



376   Reports Guide

Report Criteria

Figure 6–24 Outbound Labor Requirements Report Criteria Screen

Table 6–24 Outbound Labor Requirements Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For outbound reports, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order. Yes

Node The Node for which the 
report is generated.

The current 
node of the 
user.

No
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6.11.3 Report Layout
This section describes the layout of the Outbound Labor Requirements 
Report.

Date Range Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The previous 
day’s and 
current date.

Yes

Table 6–24 Outbound Labor Requirements Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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Figure 6–25 Outbound Labor Requirements Report 
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The Outbound Labor Requirements Report appears in portrait layout.

6.11.4 Group and Sort Criteria
The Outbound Labor Requirements Report is sorted by Expected Ship 
Date.

The Expected Ship Date is sorted in descending order.

6.11.5 Page Break Criteria
For each new enterprise, the report starts in a new table. The name of 
the enterprise is printed at the top of the table.

Table 6–25 Outbound Labor Requirements Report 

Field Description

Expected Shipment 
Date

The date on which the shipment is expected to ship 
from the warehouse.

No. of Shipments The number of shipments on that particular date.

No. of Shipment Lines The number of shipment lines for all shipments on that 
particular date.

No. of Units The total number of units shipped for all shipments on 
a particular date.

No. of Cases The total number of cases shipped for all shipments on 
a particular date.

Person Hours Reqd The person hours required for shipping all shipments 
with expected ship date listed against the person 
hours.

Person Hours Reqd is calculated as follows:

Person Hours Reqd = [ (No. of Shipments * 
SAM Per Productivity Batch) + (No. of 
Shipment Lines * SAM per Item) + (No. of 
Units * SAM per Unit) + (No. of Cases * 
SAM per Case) ] / 60
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6.11.6 Additional Setup Required
To compute the Person Hours Required, the Outbound Labor 
Requirements Report depends upon the values set up in the 
OUTBOUND_LABOR productivity type.

To set up the OUTBOUND_LABOR productivity type:

1. Launch the Applications Manager.

2. Navigate to Applications > Warehouse Management.

3. From the tree in the application rules side panel, choose Task 
Management > Productivity > Productivity Types. The Productivity 
Types window appears.

4. In the Productivity Types window, select OUTBOUND_LABOUR. The 
Productivity Type Details window appears.

The Sterling Warehouse Management System Reference 
Implementation provides Standard Allowable Minutes (SAM) values as 
displayed in the Figure 6–25.
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Figure 6–26 Productivity Type Details Window, Outbound Labor

5. In the SAM Definition tab, for fields that do not contain zero values, 
enter the appropriate SAM values. These values are used to compute 
the Person Hours Required.

6. Click .
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6.12 Pack and Hold Shipment Report
The Pack and Hold Shipment Report lists all shipments that are currently 
in the ‘pack and hold’ status, along with their location and shipper 
details. This report is useful to the warehouse supervisor when reviewing 
pack and hold shipments.

Intended Audience
Warehouse managers and outbound supervisors use this report to keep a 
track of pack and hold shipment. This report is also useful when viewing 
the shipments that are near or have reached the ship date.

6.12.1 Generating the Report
To generate the Pack and Hold Shipment Report:

1. Navigate to Outbound > Pack and Hold Shipment Report. The Pack 
and Hold Shipment Report criteria screen appears. For more 
information about the Pack and Hold Shipment Report criteria screen, 
see Section 6.12.2, "Report Criteria". 

2. Enter the criteria and click Generate Report. The Pack and Hold 
Shipments Report appears. For more information about the Pack and 
Hold Shipment Report layout, see Section 6.12.3, "Report Layout".

6.12.2 Report Criteria
The Pack and Hold Shipment Report criteria screen enables you to enter 
the criteria for which the Pack and Hold Shipment Report generates.



Report Criteria

 Outbound Reports   383

Figure 6–27 Pack and Hold Shipment Criteria Screen

Table 6–26 Pack and Hold Shipment Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For outbound reports, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order. Yes

Node The Node for which the 
report is generated.

The current 
node of the 
user.

No
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6.12.3 Report Layout
This section describes the layout of the Pack and Hold Shipment Report. 

Expected Ship 
Date

Enter the expected ship 
date.

The current 
date.

Yes

Carrier Enter the carrier of the 
shipment.

You can also click  to 
select the carrier.

Blank. No

Table 6–26 Pack and Hold Shipment Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprise in which 
the user participates.

Selected. No
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Figure 6–28 Pack and Hold Shipment Report
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Additional Setup Required

The Pack and Hold Shipments Report appears in portrait layout.

6.12.4 Group and Sort Criteria
The Pack and Hold Shipment Report is grouped by Expected Ship Date 
and Shipment No.

Expected Ship Date is sorted in descending order.

6.12.5 Page Break Criteria
The Pack and Hold Shipment Report has no page break criteria.

6.12.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 6–27 Pack and Hold Requirement Report

Field Description

Expected Ship Date The expected date for shipment.

Shipment No. A unique identity for shipment.

Seller The organization that ships the shipment.

Buyer The organization to which the shipment is shipped.

Number of Cases The number of cases for a specific shipment.

Number of Pallets The number of pallets for a specific shipment.

Scheduled Dock Door The dock door scheduled for shipping the shipment.
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6.13 Parcel Manifest Report
The Parcel Manifest Report lists the Parcel manifest details in terms of 
shipment details, number of containers, weight, and other details for the 
selected manifest date, or carrier and service.

Intended Audience
Warehouse managers and outbound supervisors use this report to 
estimate the manifest.To access this report, the user must belong to the 
data security group representing warehouse managers.

6.13.1 Generating the Report
To generate the Parcel Manifest Report:

1. Navigate to Outbound > Parcel Manifest Report. The Parcel Manifest 
Report criteria screen appears. For more information about the Parcel 
Manifest Report criteria screen, see Section 6.13.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Parcel Manifest Report appears. For more information about the 
Parcel Manifest Report layout, see Section 6.13.3, "Report Layout".

6.13.2 Report Criteria
The Parcel Manifest Report criteria screen enables you to enter the 
criteria for which the Parcel Manifest Report generates.
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Figure 6–29 Parcel Manifest Report Criteria Screen

Table 6–28 Parcel Manifest Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For outbound reports, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order. Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No
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6.13.3 Report Layout
This section describes the layout of the Parcel Manifest Report.

Manifest Date Enter the start date and 
the end date of 
manifesting for which the 
report is generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes

Carrier Enter the carrier.

You can also click  icon 
to select the carrier for 
this enterprise.

Blank. No

Table 6–28 Parcel Manifest Report Criteria Screen

Field Description Default Value Mandatory
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Figure 6–30 Parcel Manifest Report

Carrier/Service
Group Total For

 X Ground 
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The Parcel Manifest Report appears in portrait layout.

6.13.4 Group and Sort Criteria
The Parcel Manifest Report is grouped by Manifest Date and Carrier.

Manifest Date is sorted in descending order.

6.13.5 Page Break Criteria
The Parcel Manifest Report has no page break criteria.

6.13.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 6–29 Parcel Manifest Report 

Field Description

Carrier/Service The carrier for this manifest.

Manifest Date The date of manifest.

Weight Total weight of all the parcels for this carrier.

Weight UOM The actual weight in terms of UOM.

No. of Parcels Total number of packages shipped using the carrier 
service.

Basic Freight Charge The basic freight charges for the packages shipped 
using the carrier service.

Special Service 
Surcharge

The charges for the packages shipped using the carrier 
service.

Charge Currency The currency in which the charges display.

Total for 
Carrier/Service

The total of the Basic Freight Charge and Special 
Service Surcharge for a particular carrier or service.

Summary The total of the Basic Freight Charge and Special 
Service Surcharge across all carriers or services.
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6.14 Replenishment Status Report
The Replenishment Status Report helps the monitoring of replenishment 
activities in the warehouse. The report provides information about the 
replenishment status and highlights shortages or overages of 
replenishment quantities.

Intended Audience
In the Replenishment Status Report, the Replenishment Quantities mode 
helps the outbound supervisors, inventory supervisors, and warehouse 
managers when generating the replenishment tasks for those locations 
whose item quantity needs to be increased.

6.14.1 Generating the Report
To generate the Replenishment Status Report:

1. Navigate to Outbound > Replenishment Status Report. The 
Replenishment Status Report criteria screen appears. For more 
information about the Replenishment Status Report criteria screen, 
see Section 6.14.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Replenishment Status Report appears. For more information 
about the Replenishment Status Report layout, see Section 6.14.3, 
"Report Layout".

6.14.2 Report Criteria
The Replenishment Status Report criteria screen enables you to enter the 
criteria for which the Replenishment Status Report generates.
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Figure 6–31 Replenishment Status Report Criteria Screen

Table 6–30 Replenishment Status Report Criteria Screen

Field Description Default Value Mandatory

Node The Node for which the 
report is generated.

The current 
node of the 
user.

No

Zone Enter the zone for which   
the report is generated. 

You can also click  to 
choose the zone.

Click  to enter more 
zones. These zones are 
taken into consideration 
while generating the 
report.

Click  to remove a 
specific zone.

Selected. No
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6.14.3 Report Layout
This section describes the layout of the Replenishment Status Report.

Wave No. Enter the Wave number 
for which the report is 
generated.

Selected. No

Display 
Replenishment

Table 6–30 Replenishment Status Report Criteria Screen

Field Description Default Value Mandatory

By Quantity Check this box to 
generate the 
report for the 
locations that 
currently have less 
than location 
capacity 
replenishment 
quantities. This 
includes the 
pend-in quantity.

Selected. No

By Location 
Capacity

Check this box to 
generate the 
report for the 
locations that have 
on-hand quantity 
that is more than 
the location 
capacity. This 
includes the 
pend-in quantity. 

Selected. No



Report Layout

 Outbound Reports   395

Figure 6–32 Replenishment Status Report
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Report Layout

The Replenishment Status Report appears in portrait layout.

Table 6–31 Replenishment Status Report, Replenishment Quantities 
Report

Field Description

Location ID The identifier of the location for which the report is 
generated.

Item ID The identifier of the item.

Item Description The description of the item.

PC The product class of the item.

UOM The unit of measure for the item.

Demand Quantity The quantity of items that are in demand.

On Hand Quantity The available quantity of the items in the location.

Pend In Quantity The quantity of items expected at the location.

Table 6–32 Replenishment Status Report, Replenishment Location 
Capacity Report

Field Description

Location ID The identifier of the location for which the report is 
generated.

Item ID The identifier of the item.

Item Description The description of the item.

PC The product class of the item.

UOM The unit of measure for the item.

On Hand Quantity The available quantity of the items in the location.

Pend In Quantity The quantity of items expected at the location.

Pend Out Quantity The quantity of items that are in demand.

Location Size Code The size code which indicates the capacity of the 
location.

Location Capacity (x) The volume of the location.

Capacity Needed The capacity needed in multiples of current volume.
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6.14.4 Group and Sort Criteria
The Replenishment Status Report is grouped by Location ID.

The Location ID is sorted in ascending order.

6.14.5 Page Break Criteria
The Replenishment Status Report has no page break criteria.

6.14.6 Additional Setup Required
There is no additional setup required to generate this report.
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6.15 Same Day Pick Pack Ship Percentage Report
The Same Day Pick Pack Ship Percentage Report gives a measure of the 
number of shipments picked, packed, and shipped on the same day. The 
criterion for any shipment to be counted is that the pick date is the same 
as the actual ship date.

Intended Audience
Warehouse managers and outbound supervisors use this report to track 
the percentage of items that are picked, packed, and shipped on a 
monthly basis.

6.15.1 Generating the Report
To generate the Same Day Pick Pack Ship Percentage Report:

1. Navigate to Outbound > Same Day Pick Pack% Report. The Same 
Day Pick Pack Percentage Report criteria screen appears. For more 
information about the Same Day Pick Pack Ship Percentage Report 
criteria screen, see Section 6.15.2, "Report Criteria".

2. Enter the criteria and click Generate Report. The Same Day Pick Pack 
Ship Percentage Report appears. For more information about the 
Same Day Pick Pack Ship Percentage Report layout, see 
Section 6.15.3, "Report Layout".

6.15.2 Report Criteria
The Same Day Pick Pack Ship Percentage Report enables you to enter the 
criteria for which the Same Day Pick Pack Ship Percentage Report 
generates.
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Figure 6–33 Same Day Pick Pack Percentage Report Criteria Screen

Table 6–33 Same Day Pick Pack Percentage Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For outbound reports, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order. Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No
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Report Layout

6.15.3 Report Layout
This section describes the layout of the Same Day Pick Pack Ship 
Percentage Report.

Actual Ship 
Date

Enter the start date and 
end date for which the 
report is generated.

You can also click the  
icons to choose the date 
range.

Selected. Yes

Table 6–33 Same Day Pick Pack Percentage Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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Figure 6–34 Same Day Pick Pack Ship Percentage Report 
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Additional Setup Required

The Same Day Pick Pack Percentage Report appears in portrait layout.

6.15.4 Group and Sort Criteria
The Same Day Pick Pack Percentage Report has no group or sort criteria.

6.15.5 Page Break Criteria
The Same Day Pick Pack Percentage Report has no page break criteria.

6.15.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 6–34 Same Day Pick Pack Percentage Report 

Field Description

Percentage of 
Shipments Shipped on 
Same Day

The percentage of shipments shipped on the same day 
in a particular month.

Month The month in which the item was picked packed and 
shipped.
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6.16 Shipment Billing Summary Report
The Shipment Billing Summary Report displays the number of outbound 
shipments and outbound shipment lines shipped from the warehouse, 
and the number of receipts and receipt lines received. The number of 
receipts and receipt lines received indicates the number of inbound 
shipments that are in the Closed status, and the corresponding number 
of inbound shipment lines received in the warehouse. This report also 
lists the transaction details for the transactions in the details report.

Intended Audience
Inventory supervisors, outbound supervisors, and as well as enterprise 
users, use the Shipment Billing Summary Report to track the 
transactions made for a particular date range.

6.16.1 Generating the Report
To generate the Shipment Billing Summary Report:

1. Navigate to Outbound > Shipment Billing Summary Report. The 
Shipment Billing Summary Report criteria screen appears. For more 
information about the Shipment Billing Summary Report criteria 
screen, see Section 6.16.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Shipment Billing Summary Report appears. For more information 
about the Shipment Billing Summary Report layout, see 
Section 6.16.3, "Report Layout".

6.16.2 Report Criteria
The Shipment Billing Summary Report criteria screen enables you to 
enter the criteria for which the Shipment Billing Summary Report 
generates.



404   Reports Guide

Report Criteria

Figure 6–35 Shipment Billing Summary Report Criteria Screen

Table 6–35 Shipment Billing Summary Report Criteria screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

If you are an enterprise 
user, select the 
appropriate node from 
the drop-down list. For 
other users, the current 
node of the user appears.

The current 
node of the 
user.

No
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6.16.3 Report Layout
This section describes the layout of the Shipment Billing Summary 
Report.

Ship Date Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The date one 
month prior to 
the current 
date and the 
current date.

Yes

Table 6–35 Shipment Billing Summary Report Criteria screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
enterprises in which the 
user participates.

Selected. No
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Report Layout

Figure 6–36 Shipment Billing Summary Report
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The Shipment Billing Summary Report appears in portrait layout.

6.16.4 Group and Sort Criteria
The Shipment Billing Summary Report is grouped by Enterprise Code, 
Node, and Date.

The Enterprise Code and Node are sorted in ascending order, and Date is 
sorted in descending order. 

6.16.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

Table 6–36 Shipment Billing Summary Report

Field Description

Node The node of the enterprise for which the report is 
generated.

Date The date when the transaction is made.

No. of Inbound 
Shipments

The number of inbound shipments.

Click this to view the Inbound Shipment Billing Detail 
Report screen. 

No. of Inbound 
Shipment Lines

The number of inbound shipment lines.

Click this to view the Inbound Shipment Lines Billing 
Detail Report screen.

No of Outbound 
Shipments

The number of outbound shipments. 

Click this to view the Outbound Shipment Billing 
Detail Report screen.

No of Outbound 
Shipment Lines

The number of outbound shipment lines. 

Click this to view the Outbound Shipment Lines 
Billing Detail Report screen.

Total for E1 The total number of transactions for the enterprise, 
within a specified date range.

Grand Total The grand total of the transactions for multiple 
enterprises, within a specified date range.
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Inbound Shipment Billing Detail Report

6.16.6 Additional Setup Required
Run the CLOSE_SHIPMENT agent to close the shipments. These closed 
shipments are displayed by the Shipment Billing Summary Report.

6.16.7 Inbound Shipment Billing Detail Report
The Inbound Shipment Billing Detail Report lists the shipment number, 
seller, and buyer of the inbound shipment.

6.16.7.1 Report Layout
This section describes the layout of the Inbound Shipment Billing Detail 
Report.
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Figure 6–37 Inbound Shipment Billing Detail Report
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Inbound Shipment Lines Billing Detail Report

The Inbound Shipment Billing Detail Report appears in portrait layout.

6.16.7.2 Group and Sort Criteria
The Inbound Shipment Billing Detail Report is grouped by Document Type 
and Shipment No.

The Document Type and Shipment No. are sorted in ascending order.

6.16.7.3 Page Break Criteria
The Inbound Shipment Billing Detail Report has no page break criteria.

6.16.8 Inbound Shipment Lines Billing Detail Report
The Inbound Shipment Lines Billing Detail Report lists the details of the 
items in the shipment.

6.16.8.1 Report Layout
This section describes the report layout of the Inbound Shipment Lines 
Billing Detail Report.

Table 6–37 Inbound Shipment Billing Detail Report

Field Description

Document Type Displays the document type of the inbound shipment.

Shipment No. The shipment number of the shipment.

Seller The organization which ships the shipment.

Buyer The organization to which the shipment is shipped.
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Figure 6–38 Inbound Shipment Lines Billing Detail Report
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Inbound Shipment Lines Billing Detail Report

The Inbound Shipment Lines Billing Detail Report appears in portrait 
layout.

6.16.8.2 Group and Sort Criteria
The Inbound Shipment Lines Billing Detail Report is grouped by 
Document Type and Shipment No.

The Document Type and Shipment No. are sorted in ascending order.

6.16.8.3 Page Break Criteria
The Inbound Shipment Lines Billing Detail Report has no page break 
criteria.

Table 6–38 Inbound Shipment Lines Billing Detail Report

Field Description

Document Type Displays the document type of the inbound shipment.

Shipment No. The shipment number of the shipment.

Seller The organization that ships the shipment.

Buyer The organization to which the shipment is shipped.

Prime Line No. The shipment line of the shipment.

Sub Line No. The sub line number of the component of the item.
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6.16.9 Outbound Shipment Billing Detail Report
The Outbound Shipment Billing Detail Report lists the shipment numbers 
of the outbound shipment.

6.16.9.1 Report Layout
This section describes the layout of the Outbound Shipment Billing Detail 
Report.
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Outbound Shipment Billing Detail Report

Figure 6–39 Outbound Shipment Billing Detail Report
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The Outbound Shipment Billing Detail Report appears in portrait layout.

6.16.9.2 Group and Sort Criteria
The Outbound Shipment Billing Detail Report is grouped by Document 
Type and Shipment No.

The Document Type and Shipment No. are sorted in ascending order.

6.16.9.3 Page Break Criteria
The Outbound Shipment Billing Detail Report has no page break criteria.

6.16.10 Outbound Shipment Lines Billing Detail Report
The Outbound Shipment Lines Billing Detail Report lists the shipment line 
number for the shipment number of the outbound shipment.

6.16.10.1 Report Layout
This section describes the layout of the Outbound Shipment Lines Billing 
Detail Report.

Table 6–39 Outbound Shipment Billing Detail Report

Field Description

Document Type Displays the document type of the outbound 
shipments.

Shipment No. The shipment number of the shipments shipped during 
the day.

Seller The organization that ships the shipment.

Buyer The organization to which the shipment is shipped.
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Outbound Shipment Lines Billing Detail Report

Figure 6–40 Outbound Shipment Lines Billing Detail Report
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The Outbound Shipment Lines Billing Detail Report appears in portrait 
layout.

6.16.10.2 Group and Sort Criteria
The Outbound Shipment Lines Billing Detail Report is grouped by 
Document Type and Shipment No.

The Document Type and Shipment No. are sorted in ascending order.

6.16.10.3 Page Break Criteria
The Outbound Shipment Lines Billing Detail Report has no page break 
criteria.

Table 6–40 Outbound Shipment Lines Billing Detail Report

Field Description

Document Type Displays the document type of the outbound 
shipments.

Shipment No. The shipment number of the shipments shipped during 
the day.

Seller The organization that which ships the shipment.

Buyer The organization to which the shipment is shipped.

Prime Line No. The shipment line of the shipment.

Sub Line No. The sub line number of the component of the item.



418   Reports Guide

Report Criteria

6.17 Shipment Fill Rate Monthly Report
The Shipment Fill Rate Monthly Report shows the percentage of complete 
shipments shipped by the warehouse. The percentage is calculated as 
the ratio of the complete shipments shipped to the total number of 
shipments shipped by the node.

Intended Audience
Warehouse managers and outbound supervisors use the Shipment Fill 
Rate Monthly Report to track the percentage of complete shipments 
shipped. The report is generated manually.

6.17.1 Generating the Report
To generate the Shipment Fill Rate Monthly Report:

1. Navigate to Outbound > Shipment Fill Rate Monthly Report. The 
Shipment Fill Rate Monthly Report criteria Screen appears. For more 
information about the Shipment Fill Rate Monthly Report criteria 
screen, see Section 6.17.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Shipment Fill Rate Monthly Report appears. For more information 
about the Shipment Fill Rate Monthly Report layout, see 
Section 6.17.3, "Report Layout".

6.17.2 Report Criteria
The Shipment Fill Rate Monthly Report criteria screen enables you to 
enter the criteria for which the Shipment Fill Rate Monthly Report 
generates.
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Figure 6–41 Shipment Fill Rate Monthly Report Criteria Screen

Table 6–41 Shipment Fill Rate Monthly Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For this report, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order. Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No
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Report Layout

6.17.3 Report Layout
This section describes the layout of the Shipment Fill Rate Monthly 
Report.

Date Range Enter the start date and 
the end date for which 
the report is generated.

You can also click the  

icons to choose the date 
range.

The current 
date.

Yes

Table 6–41 Shipment Fill Rate Monthly Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the current 
enterprise of the 
user appears as 
the default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering 
the enterprises in which 
the user participates.

Selected. No
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Figure 6–42 Shipment Fill Rate Monthly Report
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Additional Setup Required

For each month the percentage of complete shipments shipped is printed 
on top of the bar representing the shipment shipped in a month.

The Shipment Fill Rate Monthly Report appears in portrait layout.

6.17.4 Group and Sort Criteria
The Shipment Fill Rate Monthly Report is grouped by node.

6.17.5 Page Break Criteria
The Shipment Fill Rate Monthly Report has no page break criteria.

6.17.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 6–42 Shipment Fill Rate Monthly Report

Field Description

Months Grouped By 
Enterprise Code

The months during which complete shipments are 
shipped by the warehouse. 

This is grouped by Enterprise Code.

Percentage Of 
Complete Shipments

The percentage of complete shipments shipped for the 
particular month.
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6.18 Shipments Near or Past Cancel Date Report
The Shipments Near or Past Cancel Date Report lists unshipped 
shipments that are near or past the selected order cancel date range. 
This report is useful to track the shipments that are due and manage 
resources to generate the same.

Intended Audience
Warehouse managers and outbound supervisors use this report to ensure 
that all shipments approaching the order cancel dates are processed and 
shipped as scheduled.

6.18.1 Generating the Report
To generate the Shipments Near or Past Cancel Date Report:

1. Navigate to Outbound > The Shipments Near or Past Cancel Date 
Report criteria screen appears. For more information about the 
Shipments Near or Past Cancel Date Report criteria screen, see 
Section 6.18.2, "Report Criteria". 

2. Enter the criteria and click Generate Report to generate the report. 
The Shipments Near or Past Cancel Date Report appears. For more 
information about the Shipments Near or Past Cancel Date Report 
layout, see Section 6.18.3, "Report Layout".

6.18.2 Report Criteria
The Shipments Near or Past Cancel Date Report criteria screen enables 
you to enter the criteria for which the Shipments Near or Past Cancel 
Date Report generates.
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Report Criteria

Figure 6–43 Shipments Near or Past Cancel Date Report Criteria Screen

Table 6–43 Shipments Near or Past Cancel Date Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For this report, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order. Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No
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6.18.3 Report Layout
This section describes the layout of the Shipments Near or Past Cancel 
Date Report.

Look for Cancel 
Dates Upto

Enter the number of 
days.

2. Yes

Show 
Shipments 
with Cancel 
Date in the 
Past

Choose yes to display the 
shipments with past 
cancel dates.

Choose No to avoid the 
display.

Selected. Yes

Customer Enter the customer.

You can also click  to 
choose the customer.

Blank. No

Table 6–43 Shipments Near or Past Cancel Date Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
enterprises in which the 
user participates.

Selected. No
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Report Layout

Figure 6–44 Shipments Near or Past Cancel Date Report
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The Shipments Near or Past Cancel Date Report appears in portrait 
layout.

6.18.4 Group and Sort Criteria
The Shipments Near or Past Cancel Date Report is grouped by Shipment 
No. 

Shipment No. is sorted in ascending order.

6.18.5 Page Break Criteria
For each new enterprise, the report starts in a new table. The name of 
the enterprise is printed at the top of the table.

6.18.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 6–44 Shipments Near or Past Cancel Date Report 

Field Description

Cancel Date The cancel date for a specific shipment.

Shipment No. A unique identifier for the shipment.

Shipment Status The status of the shipment.

Expected Shipment 
Date

The expected date of the shipment.

Order No. A unique identifier for the order.

Buyer The buyer organization.
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6.19 Shipment Shortage Report
The Shipment Shortage Report lists all shipped shipments that have item 
shortages. This helps warehouse managers to manage exceptions.

Intended Audience
Warehouse managers and outbound supervisors use this report to 
manage exceptions which helps them to take the appropriate action if 
shortages are detected earlier in the shipment life cycle.

6.19.1 Generating the Report
To generate the Shipment Shortage Report:

1. Navigate to Outbound > Shipment Shortage Report. The Shipment 
Shortage Report criteria screen appears. For more information about 
the Shipment Shortage Report criteria screen, see Section 6.19.2, 
"Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Shipment Shortage Report appears. For more information about 
the Shipment Shortage Report layout, see Section 6.19.3, "Report 
Layout".

6.19.2 Report Criteria
The Shipment Shortage Report criteria screen enables you to enter the 
criteria for which the Shipment Shortage Report generates.
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Figure 6–45 Shipment Shortage Report Criteria Screen

 

Table 6–45 Shipment Shortage Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For outbound reports, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order. Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No
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Report Layout

6.19.3 Report Layout
This section describes the layout of the Shipment Shortage Report.

Actual Ship 
Date

Enter the start date and 
the end date of shipment 
for which the report is 
generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes

Table 6–45 Shipment Shortage Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
the enterprises in which 
the user participates.

Selected. No
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Figure 6–46 Shipment Shortage Report
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Additional Setup Required

The Shipment Shortage Report appears in portrait layout.

6.19.4 Group and Sort Criteria
The Shipment Shortage Report is grouped by Enterprise Code, Ship Date, 
Shipment No., and Item ID.

Enterprise Code, Shipment No., and Ship Date are sorted in ascending 
order.

6.19.5 Page Break Criteria
For each new enterprise, the report starts in a new table on another 
page. The name of the enterprise is printed at the top of the table.

6.19.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 6–46 Shipment Shortage Report 

Field Description

Ship Date The date of shipment.

Shipment No. A unique description for shipment.

Seller The organization which ships the shipment.

Item ID The identifier of the item.

Item Description The description of the item.

PC The product class to which the item belongs.

UOM The unit of measure.

Original Quantity The quantity of the items requested by the customer.

Shipment Quantity The actual quantity of items being shipped to the 
customer.

Shortage Quantity The total shortage quantity of the items, within a 
specific node.
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6.20  Staging Locations Report
Warehouses have limited staging locations. This may become a 
bottleneck if not managed properly. This report provides a means to 
identify the locations that may be occupying space with shipments that 
are either not loaded or are awaiting containers.

Intended Audience
Outbound supervisors use the Staging Locations Report to track the 
percentage of complete shipments shipped. The report is generated 
manually.

6.20.1 Generating the Report
To generate the Staging Locations Report

1. Navigate to Outbound > Staging Locations Report. The Staging 
Locations Report criteria Screen appears. For more information about 
the Staging Locations Report criteria screen, see Section 6.20.2, 
"Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
Depending on the selection, that particular Staging Locations Report 
screen appears.

For more information about the Staging Locations Report, Sort By 
Location, see Section 6.20.3.1, "Report Layout".   

For more information about the Staging Locations Report, Sort By 
Time, see Section 6.20.4.1, "Report Layout".                                            

6.20.2 Report Criteria
The Staging Locations Report criteria screen enables you to enter the 
criteria for which the Staging Locations Report generates.

Note: The staging locations that are considered by this 
report are the shipment sort locations that are used to sort 
the shipment containers before shipping them.
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Figure 6–47 Staging Locations Report Criteria Screen

Table 6–47 Staging Locations Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For this report, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order. Yes

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Zone Enter the zone for which 
the report is generated.

You can also click  to 
choose the zone.

Blank. No
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6.20.3 Staging Locations Report, Sort By Location
The Staging Locations Report, Sort By Location provides the report based 
on the locations staged. 

6.20.3.1 Report Layout
This section describes the layout of the Staging Locations Report, Sort By 
Location.

Wave No. Enter the wave number 
for which the report is 
generated.

Blank. No

Sort By

Table 6–47 Staging Locations Report Criteria Screen

Field Description Default Value Mandatory

Locations Choose this to 
view the Staging 
Locations Report, 
Sort By Location. 

Selected. No

Time Since 
Last Activity

Choose this to 
view the Staging 
Locations Report, 
Sort By Time.

Not 
Selected.

No
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Staging Locations Report, Sort By Location

Figure 6–48 Staging Locations Report, Sort By Location
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The Staging Locations Report, Sort By Location appears in portrait 
layout.

6.20.3.2 Group and Sort Criteria
The Staging Locations Report, Sort By Location has no group and sort 
criteria.

6.20.3.3 Page Break Criteria
The Staging Locations Report, Sort By Location has no page break 
criteria.

6.20.3.4 Additional Setup Required
There is no additional setup required to generate this report.

6.20.4 Staging Locations Report, Sort By Time
The Staging Locations Report, Sort By Time provides the report based on 
the time.

Table 6–48 Staging Location Report, Sort By Location

Field Description

Location ID The location identifier of the shipments staged in the 
location.

Shipment No. The shipment number of the shipment in the location.

Seller The organization that ships the shipment.

No. Of Cases The number of cases of the shipment being shipped.

No. Of Pallets The number of pallets of the shipment being shipped.

Wave No. The unique number of a wave for the warehouse.

% Complete (Quantity) The percentage of the shipment quantity that has 
been staged in the staging location.

Time Since Last 
Activity(Days:Hrs)

The time elapsed since the last shipment was staged 
in the location.
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Staging Locations Report, Sort By Time

6.20.4.1 Report Layout
This section describes the layout of the Staging Locations Report, Sort By 
Time.
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Figure 6–49 Staging Locations Report, Sort By Time
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Staging Locations Report, Sort By Time

The Staging Locations Report, Sort By Time appears in portrait layout.

6.20.4.2 Group and Sort Criteria
The Staging Locations Report, Sort By Time has no group and sort 
criteria.

6.20.4.3 Page Break Criteria
The Staging Locations Report, Sort By Time has no page break criteria.

6.20.4.4 Additional Setup Required
There is no additional setup required to generate this report.

Table 6–49 Staging Location Report, Sort By Time

Field Description

Time Since Last 
Activity(Days:Hrs)

The time elapsed since the last shipment was staged 
in the location.

Shipment No. The shipment number of the shipment.

Seller The organization that ships the shipment.

No of Cases The number of cases of the shipment being shipped.

No of Pallets The number of pallets of the shipment being shipped.

Wave No. The unique number of a wave for the warehouse.

% Complete (Quantity) The percentage of the shipment quantity that has 
been staged in the staging location.

Location ID The location identifier of the shipments staged in the 
location.
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7
Task Reports

The following task reports can be generated using the Sterling 
Warehouse Management System:

In-Progress Container Summary Report

In-Progress Shipment Summary Report

User Productivity Daily Report

User Productivity Weekly Report

User Productivity Monthly Report

Warehouse Activity Completion Report

Putaway Location Override Report
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7.1 In-Progress Container Summary Report
The In-Progress Container Summary Report shows the current status of 
the pick-pack-ship process. The default Container Summary view shows 
two graphs: Container Dashboard by statuses and Container by Carriers.

Intended Audience
Warehouse managers, inbound supervisors, inventory supervisors, and 
outbound supervisors use this report to track containers in different 
statuses. To access this report, the user must belong to the data security 
group representing warehouse managers, inbound supervisors, inventory 
supervisors, or outbound supervisors.

7.1.1 Generating the Report
To generate the In-Progress Container Summary Report:

1. Navigate to Task > In-Progress Container Summary Report. The 
In-Progress Container Summary Report criteria screen appears. For 
more information about the In-Progress Container Summary Report 
criteria screen, see Section 7.1.2, "Report Criteria".

2. Enter the criteria and click Generate Report. The In-Progress 
Container Summary Report appears. For more information about the 
In-Progress Container Summary Report layout, see Section 7.1.3, 
"Report Layout".

7.1.2 Report Criteria
The In-Progress Container Summary Report criteria screen enables you 
to enter the criteria for which the In-Progress Container Summary Report 
generates.
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Figure 7–1 In-Progress Container Summary Report Criteria Screen

Table 7–1 In-Progress Container Summary Report Criteria Screen

Field Description Default Value Mandatory

Document 
Type

The document type for 
which the report is 
generated.

For this report, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order. Yes

Node The node for which the 
report is generated.

If you are an enterprise 
user, select the 
appropriate node from 
the drop-down list. For 
other users, the current 
node of the user appears.

The current 
node of the 
user.

No



444   Reports Guide

Report Layout

7.1.3 Report Layout
This section describes the layout of the In-Progress Container Summary 
Report.

Date Enter the date. The 
report lists containers 
with expected ship dates 
less than or equal to this 
date.

You can also click the  
icon to choose the date.

The current 
date.

Yes

Shipment 
Mode

Select the mode in which 
the container is shipped.

Blank. No

Carrier Enter the carrier used to 
transport the container.

You can also click the  
icon to choose the carrier.

Blank. No

Table 7–1 In-Progress Container Summary Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
enterprises.

Selected. No
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Figure 7–2 In-Progress Container Summary Report

Note: Based on the status of containers available in the 
warehouse, the Status column in the table that is displayed 
in the In-Progress Container Summary Report displays one 
or more of the following statuses:

Picked

Packed

Shipped

Manifested
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Table 7–2 In-Progress Container Summary Report, Containers By 
Statuses

Field Description

No. of containers The total number of containers in a certain status.

Status The number of containers that are in a certain status.

The statuses can be either Picked, Packed, Manifested, 
or Shipped.

Picked The total number of 
shipments in the picked 
status.

Packed The total number of 
shipments in the packed 
status.

Manifested The total number of 
shipments in the 
manifested status.

Shipped The total number of the 
shipments in the shipped 
status.

Regions of this color indicate the number of 
containers that are in Packed, Manifested, or Shipped 
status.

Regions of this color indicate the number of 
containers that are yet to be Packed, Manifested, or 
Shipped.
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Table 7–3 In-Progress Container Summary Report, Containers By 
Carriers

Field Description

No. of containers The number of containers transported by a certain 
carrier.

Carrier The carrier selected by you in the criteria screen.

If you did not select any carrier in the criteria 
screen, each carrier used to transport the containers 
appears in the graph, along with the number of 
containers in various statuses.

Status Description

Table 7–4 In-Progress Container Summary Report, Table

Field Description

Enterprise Code The enterprise code of the enterprise that ships the 
containers.

Document Type The document type of the shipment. 

Carrier The carrier that transports the container.

Shipment Mode The mode of transportation for the container.

Regions of this color indicate the 
number of containers in 
Manifested status.

Regions of this color indicate the 
number of containers in Shipped 
status.
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The In-Progress Container Summary Report appears in landscape layout.

7.1.4 Group and Sort Criteria
The In-Progress Container Summary Report has no group or sort criteria.

7.1.5 Page Break Criteria
The In-Progress Container Summary Report has no page break criteria.

7.1.6 Additional Setup Required
There is no additional setup required to generate this report.

Status The current status of the container.

The status can be Manifested, Packed, or Shipped.

Click Manifested to view the In-Progress Container 
Details Report, Packed, which provides a detailed 
report for containers that are in Manifested status.

Click Packed to view the In-Progress Container Details 
Report, Packed, which provides a detailed report for 
containers that are in Packed status.

Click Shipped to view the In-Progress Container 
Details Report, Packed, which provides a detailed 
report for containers that are in Shipped status.

Completed Containers The total number of containers that have been Packed, 
Manifested or Shipped.

Note: On refreshing the In-Progress Container Summary 
Report screen, the Sterling Warehouse Management 
System may prompt users to enter their specific locale 
code, for example, a U.S user must enter en_US_EST as 
the locale code, and click OK.

Table 7–4 In-Progress Container Summary Report, Table

Field Description
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7.1.7 In-Progress Container Details Report, Packed
This report provides details for containers that are in packed status.

7.1.7.1 Report Layout
This section describes the layout of the In-Progress Container Details 
Report for packed status.

Note: The value of Status indicates whether the 
In-Progress Container Details Report is for containers that 
are in Packed status.

The value of status is Packed in the In-Progress Container 
Summary Report for Packed.
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In-Progress Container Details Report, Packed

Figure 7–3 In-Progress Container Details Report

The In-Progress Container Details Report appears in landscape layout.

Table 7–5 In-Progress Container Details Report

Field Description

Container No. The container number on the container.

Ship To The node to which the container is shipped.

Carrier The carrier that transports the containers.

Time Since Last 
Activity

The amount of elapsed time since the last activity was 
performed.
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7.1.7.2 Group and Sort Criteria
The In-Progress Container Details Report, Packed has no group criteria or 
sort criteria.

7.1.7.3 Page Break Criteria
The In-Progress Container Details Report, Packed has no page break 
criteria.

7.1.8 In-Progress Container Details Report, Manifested
This report provides details for containers that are in manifested status.

The fields, layout, group and sort criteria, and page break criteria of this 
report are similar to the In-Progress Container Details Report, Packed.

7.1.9 In-Progress Container Details Report, Shipped
This report provides details for containers that are in shipped status.

The fields, layout, group and sort criteria, and page break criteria of this 
report are similar to the In-Progress Container Details Report, Packed.

Note: The value of Status indicates whether the 
In-Progress Container Details Report is for containers that 
are in Manifested status.

The value of status is Packed in the In-Progress Container 
Summary Report for Manifested.

Note: The value of Status indicates whether the 
In-Progress Container Details Report is for containers that 
are in Shipped status.

The value of status is Packed in the In-Progress Container 
Summary Report for Shipped.
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7.2 In-Progress Shipment Summary Report
The In-Progress Shipment Summary Report shows the current status of 
the pick-pack-ship process. The default Shipment Summary view shows 
two graphs: Shipments by Statuses and Shipments by Carriers.

Intended Audience
Warehouse managers, inbound supervisors, inventory supervisors, and 
outbound supervisors use this report to track shipments in different 
statuses. To access this report, the user must belong to the data security 
group representing warehouse managers, receiving supervisors, 
inventory supervisors, shipping supervisors, or enterprise users.

7.2.1 Generating the Report
To generate the In-Progress Shipment Summary Report:

1. Navigate to Task > In-Progress Shipment Summary Report. The 
In-Progress Shipment Summary Report criteria screen appears. For 
more information about the In-Progress Shipment Summary Report 
criteria screen, see Section 7.2.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The In-Progress Shipment Summary Report Screen appears. For 
more information about the In-Progress Shipment Summary Report 
layout, see Section 7.2.3, "Report Layout".

7.2.2 Report Criteria
The In-Progress Shipment Summary Report criteria screen enables you 
to enter the criteria for which the In-Progress Shipment Summary Report 
generates.
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Figure 7–4 The In-Progress Shipment Summary Report Criteria 
Screen
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Table 7–6 The In-Progress Shipment Summary Report Criteria 
Screen

Field Description Default Value Mandatory

Document 
Type

Select the document type 
for which the report is 
generated.

For this report, the 
document types displayed 
are Transfer Order and 
Sales Order.

Sales Order Yes

Node The node for which the 
report is generated.

If you are an enterprise 
user, select the 
appropriate node from 
the drop-down list. For 
other users, the current 
node of the user appears.

The current 
node of the 
user.

No

Ship Date Enter the date. The 
report lists shipments 
with expected ship dates 
less than or equal to this 
date.

You can also click the    
icon to choose the date.

The current 
date.

Yes

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
enterprises.

Selected. No
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7.2.3 Report Layout
This section describes about the layout of the In-Progress Shipment 
Summary Report.

Shipment 
Mode

Select the mode in which 
the container is shipped 
from the drop down 
menu list.

Blank. No

Carrier Enter the carrier used to 
transport the container.

You can also click the  
icon to choose the carrier.

Blank. No

Table 7–6 The In-Progress Shipment Summary Report Criteria 
Screen

Field Description Default Value Mandatory
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Figure 7–5 In-Progress Shipment Summary Report 
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Note: Based on the status of containers available in the 
warehouse, the Status column in the table that is displayed 
in the In-Progress Shipment Summary Report displays one 
or more of the following statuses:

Picked

Packed

Shipped

Manifested

Table 7–7 In-Progress Shipment Summary Report, Shipments by 
Statuses

Field Description

No. of Shipments The total number of shipments in a certain status.
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Status The number of shipments that are in a certain status.

The statuses can be either Picked, Packed, Manifested, 
or Shipped.

Table 7–7 In-Progress Shipment Summary Report, Shipments by 
Statuses

Field Description

Picked The total number of 
shipments in the picked 
status.

Packed The total number of 
shipments in the packed 
status.

Manifested The total number of 
shipments in the 
manifested status.

Shipped The total number of 
shipments in the shipped 
status.

Regions of this color indicate the number of 
shipments that are in packed or manifested status.

Regions of this color indicate the number of 
shipments that are yet to be packed or manifested.
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Table 7–8 In-Progress Shipment Summary Report, Shipments By 
Carriers

Field Description

No. of Shipments The total number of shipments transported by a 
certain carrier.

Carrier The carrier selected by you in the criteria screen.

If you did not select any carrier in the criteria 
screen, each carrier used to transport the shipments 
appears in the graph, along with the number of 
containers in various statuses.

Status Description

Table 7–9 The In-Progress Shipment Summary Report Screen, 
Table

Field Description

Enterprise Code The enterprise code of the enterprise that ships the 
shipments.

Document Type The document type of the shipment. 

Carrier The carrier that transports the shipment.

Shipment Mode The mode of transportation for the container.

Regions of this color indicate 
the number of shipments in 
Shipped status.

Regions of this color indicate 
the number of shipments in 
Manifested status.
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Additional Setup Required

The In-Progress Shipment Summary Report is displayed in landscape 
layout.

7.2.4 Group and Sort Criteria
The In-Progress Shipment Summary Report has no Group and Sort 
Criteria.

7.2.5 Page Break Criteria
The In-Progress Shipment Summary Report has no page break criteria.

7.2.6 Additional Setup Required
There is no additional setup required to generate this report.

Status The current status of the shipment.

The status can be Packed or Manifested.

Click Packed to view the In-Progress Shipment 
Details Report, Picked, which provides a detailed 
report for containers that are in Packed status.

Click Manifested to view the In-Progress Shipment 
Details Report, Picked, which provides a detailed 
report for containers that are in Manifested status.

Completed Shipments The total number of shipments that have been Packed 
as well as Manifested.

Note: On refreshing the In-Progress Shipment Summary 
Report screen, the Sterling Warehouse Management 
System prompts users to enter their specific locale code, 
for example, a U.S user must enter en_US_EST as the 
locale code, and click OK.

Table 7–9 The In-Progress Shipment Summary Report Screen, 
Table

Field Description
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7.2.7 In-Progress Shipment Details Report, Picked
This report provides details for shipments that are in the Picked status.

7.2.7.1 Report Layout
This section describes the layout of the In-Progress Shipment Details 
Report for the Picked status.

Note 1: The value of Status indicates whether the 
In-Progress Shipment Details Report is for shipments that 
are in Picked status.

The value of status is Picked in the In-Progress Shipment 
Summary Report for Picked.

Note 2: The value of Shipment Mode and Carrier is the 
same as that of the containers whose status you click in 
the In-Progress Shipment Summary Report.
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In-Progress Shipment Details Report, Picked

Figure 7–6 In-Progress Shipment Details Report

The In-Progress Shipment Details Report appears in landscape layout.

Table 7–10 In-Progress Shipment Details Report

Field Description

Shipment No. The shipment number on the container.

Ship To The node to which the container is shipped.

Carrier The carrier that transports the containers.

Time Since Last 
Activity

The amount of elapsed time since the last activity was 
formed.
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7.2.7.2 Group and Sort Criteria
The In-Progress Shipment Details Report, Picked has no group criteria or 
sort criteria.

7.2.7.3 Page Break Criteria
The In-Progress Shipment Details Report, Picked has no page break 
criteria.

7.2.8 In-Progress Shipment Details Report, Packed
This report provides details for shipments that are in Packed status.

The fields, layout, group and sort criteria, and page break criteria of this 
report are similar to the In-Progress Shipment Details Report, Picked.

7.2.9 In-Progress Shipment Details Report, Manifested
This report provides details for shipments that are in Manifested status.

Note 1: The value of Status indicates whether the 
In-Progress Shipment Details Report is for shipments that 
are in Packed status.

The value of status is Packed in the In-Progress Shipment 
Summary Report for Packed.

Note 2: The value of Shipment Mode and Carrier is the 
same as that of the shipments whose status you click in 
the In-Progress Shipment Summary Report.

Note 1: The value of Status indicates whether the 
In-Progress Shipment Details Report is for shipments that 
are in manifested status.

The value of status is Manifested in the In-Progress 
Shipment Summary Report for manifested.

Note 2: The value of Shipment Mode and Carrier is the 
same as that of the shipments whose status you click in 
the In-Progress Shipment Summary Report.
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In-Progress Shipment Details Report, Shipped

The fields, layout, group and sort criteria, and page break criteria of this 
report are similar to the In-Progress Shipment Details Report, Picked.

7.2.10 In-Progress Shipment Details Report, Shipped
This report provides details for shipments that are in Shipped status.

The fields, layout, group and sort criteria, and page break criteria of this 
report are similar to the In-Progress Shipment Details Report, Picked.

Note 1: The value of Status indicates whether the 
In-Progress Shipment Details Report is for shipments that 
are in shipped status.

The value of status is Shipped in the In-Progress Shipment 
Summary Report for manifested.

Note 2: The value of Shipment Mode and Carrier is the 
same as that of the shipments whose status you click in 
the In-Progress Shipment Summary Report.
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7.3 User Productivity Daily Report
The User Productivity Daily Report provides user productivity information 
on a daily basis, for a given date range.

Intended Audience
Warehouse managers, inbound supervisors, inventory supervisors, and 
outbound supervisors use this report to calculate the efficiency of the 
users on a daily basis.

7.3.1 Generating the Report
To generate the User Productivity Daily Report:

1. Navigate to Task > User Productivity Daily Report. The User 
Productivity Daily Report criteria screen appears. For more 
information about the User Productivity Daily Report criteria screen, 
see Section 7.3.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The User Productivity Daily Report appears. For more information 
about the User Productivity Daily Report layout, see Section 7.3.3, 
"Report Layout".

7.3.2 Report Criteria
The User Productivity Daily Report criteria screen enables you to enter 
the criteria for which the User Productivity Daily Report generates.
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Figure 7–7 User Productivity Daily Report Criteria Screen

Table 7–11 User Productivity Daily Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Date Range Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes
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7.3.3 Report Layout
This section describes the layout of the User Productivity Daily Report.

User ID Enter the identifier of the 
user for whom the report 
is generated.

You can also click  to 
choose the User ID.

Click  to enter more 
User IDs. These User IDs 
are taken into 
consideration while 
generating the report.

Click  to remove a 
specific User ID.

Blank No

Average 
Working hours 
Per user Per 
day

Enter the number of 
working hours for each 
user each day for which 
the report is generated.

8 Yes

Table 7–11 User Productivity Daily Report Criteria Screen

Field Description Default Value Mandatory
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Figure 7–8 User Productivity Daily Report 
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The User Productivity Daily Report appears in portrait layout.

7.3.4 Group and Sort Criteria
The User Productivity Daily Report is grouped by User ID, User Name, 
and Date of Execution.

Table 7–12 User Productivity Daily Report, Efficiency Comparison of 
Users

Field Description

Efficiency (in%) The efficiency percentage of each user, when different 
users are considered.

Efficiency is calculated as follows:

Efficiency = (The minutes credited to 
user based on SAM for all tasks performed 
on that day) / ( Average number of hours 
per user per day provided as input to the 
report). 

The percentage of efficiency is calculated as follows:

% Efficiency = (Efficiency) / 100

Date The date for which the report is generated.

User ID (s) Each user’s identifier is represented by a particular 
color.

For example, in Figure 7–8,  indicates the 
productivity of the RF User.

Table 7–13 User Productivity Daily Report 

Field Description

User ID The identifier of the user.

User Name The name of the user.

Date The date on which the report is generated.

Credited Hrs Total number of working hours on that date.

Efficiency (in%) The efficiency percentage of each user.
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User ID, User Name, and Date of Execution are sorted in ascending 
order.

7.3.5 Page Break Criteria
The User Productivity Daily Report has no page break criteria.

7.3.6 Additional Setup Required
To obtain the data required for the User Productivity Daily Report, 
execute the MINE_PRODUCTIVITY agent.
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7.4 User Productivity Weekly Report
The User Productivity Weekly Report provides user productivity 
information on a weekly basis for a given date range.

Intended Audience
Warehouse managers, inbound supervisors, inventory supervisors, and 
outbound supervisors use this report to calculate the efficiency of the 
users on a weekly basis.

7.4.1 Generating the Report
To generate the User Productivity Weekly Report:

1. Navigate to Task > User Productivity Weekly Report. The User 
Productivity Weekly Report criteria screen appears. For more 
information about the User Productivity Weekly Report criteria screen. 
see Section 7.4.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The User Productivity Weekly Report appears. For more information 
about the User Productivity Weekly Report layout, see Section 7.4.3, 
"Report Layout".

7.4.2 Report Criteria
The User Productivity Weekly Report criteria screen enables you to enter 
the criteria for which the User Productivity Weekly Report generates.
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Figure 7–9 User Productivity Weekly Report Criteria Screen

Table 7–14 User Productivity Weekly Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Date Range Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The previous 
week’s date 
and current 
day’s date.

Yes
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7.4.3 Report Layout
This section describes the layout of the User Productivity Weekly Report.

User ID Enter the identifier of the 
user for whom the report 
is generated.

You can also click  to 
choose the User ID.

Click  to enter more 
User IDs. These User IDs 
are taken into 
consideration while 
generating the report.

Click  to remove a 
specific User ID.

Blank. No

Average 
Working hours 
Per User Per 
Day

Enter the number of 
working hours for each 
user each day for which 
the report is generated.

8 Yes

Table 7–14 User Productivity Weekly Report Criteria Screen

Field Description Default Value Mandatory
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Figure 7–10 User Productivity Weekly Report 
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The User Productivity Weekly Report appears in portrait layout.

7.4.4 Group and Sort Criteria
The User Productivity Weekly Report is grouped by User ID and User 
Name.

User ID and the User name are sorted in ascending order.

Table 7–15 User Productivity Weekly Report

Field Description

Efficiency (in%) The efficiency percentage of each user, when different 
users are considered.

The efficiency is calculated as the number of hours 
worked divided by total number of hours.

Year.Week of the Year The year, and the week in that year, for which the 
report is generated.

Table 7–16 User Productivity Weekly Report 

Field Description

User ID The user identifier of the user.

User Name The name of the user.

Week Begin The beginning of the week for which the report is 
generated.

Week End The end of the week for which the report is generated.

Credited hours Total number of working hours on that date.

Efficiency (in%) The efficiency percentage of each user, when different 
users are considered.

User ID (s) Each user’s productivity is represented by a 
particular color.

For example, in Figure 7–10,                
represents the productivity of the user dc1e1.
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7.4.5 Page Break Criteria
The User Productivity Weekly Report has no page break criteria.

7.4.6 Additional Setup Required
To obtain the data required for the User Productivity Weekly Report, 
execute the MINE_PRODUCTIVITY agent.
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7.5 User Productivity Monthly Report
The User Productivity Monthly Report provides user productivity 
information on a monthly basis for a given date range.

Intended Audience
Warehouse managers, inbound supervisors, inventory supervisors, and 
outbound supervisors use this report to calculate the efficiency of the 
users on a monthly basis.

7.5.1 Generating the Report
To generate the User Productivity Monthly Report:

1. Navigate to Task > User Productivity Monthly Report. The User 
Productivity Monthly Report criteria screen appears. For more 
information about the User Productivity Monthly Report criteria 
screen, see Section 7.5.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the 
report.The User Productivity Monthly Report appears. For more 
information about the User Productivity Monthly Report layout, see 
Section 7.5.3, "Report Layout".

7.5.2 Report Criteria
The User Productivity Monthly Report criteria screen enables you to enter 
the criteria for which the User Productivity Monthly Report generates.
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Figure 7–11 User Productivity Monthly Report Criteria Screen

Table 7–17 User Productivity Monthly Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Date Range Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The previous 
month’s date 
and current 
day’s date.

Yes
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7.5.3 Report Layout
This section describes the layout of User Productivity Monthly Report.

User ID Enter the identifier of the 
user for whom the report 
is generated.

You can also click  to 
choose the User ID.

Click  to enter more 
User IDs. These User IDs 
are taken into 
consideration while 
generating the report.

Click  to remove the 
specific User ID.

Blank. No

Average 
Working Hours 
Per User Per 
Day

Enter the number of 
working hours for each 
user day for which the 
report is generated.

8 Yes

No of Working 
Days Per Week

Enter the total number of 
working days each week 
for each user.

5 Yes

Table 7–17 User Productivity Monthly Criteria Screen

Field Description Default Value Mandatory
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Report Layout

Figure 7–12 User Productivity Monthly Report

,
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The User Productivity Monthly Report appears in portrait layout.

7.5.4 Group and Sort Criteria
The User Productivity Monthly Report is grouped by User ID and User 
Name.

The User ID and User Name are sorted by ascending order.

Table 7–18 User Productivity Monthly Report, Efficiency Comparison of 
the User

Field Description

Efficiency (in%) The efficiency percentage of each user, when different 
users are considered.

The efficiency is calculated as the number of hours 
worked divided by total number of hours.

Year.Month The year, and the month in that year for which the 
report is generated.

Table 7–19 User Productivity Monthly Report 

Field Description

User ID The user identifier of the user.

User Name The name of the user.

Month Begin Date The beginning of the month for which the report is 
generated.

Month End Date The end of the month for which the report is 
generated.

Credited hours Total number of working hours on that date.

Efficiency (in%) The efficiency percentage of each user, when different 
users are considered.

User ID (s) Each user’s productivity is represented by a 
particular color.

For example, in, Figure 7–11,                 
represents the productivity of the user dc1e1.
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7.5.5 Page Break Criteria
The User Productivity Monthly Report has no page break criteria.

7.5.6 Additional Setup Required
To obtain the data required for the User Productivity Monthly Report, 
execute the MINE_PRODUCTIVITY agent.
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7.6 Warehouse Activity Completion Report
The Warehouse Activity Completion Report provides a summary of the 
different warehouse tasks that are in "Completed" status. The numbers 
change as more tasks get completed. The user can also select only a 
specific set of task types to view the activity report.

Intended Audience
Warehouse managers, inbound supervisors, inventory supervisors, and 
outbound supervisors use this report to calculate the tasks that are 
complete. The report is generated manually.

7.6.1 Generating the Report
To generate the Warehouse Activity Completion Report:

1. Navigate to Task > Warehouse Activity Completion Report. The 
Warehouse Activity Completion Report criteria screen appears. For 
more information about the Warehouse Activity Completion Report 
criteria screen, see Section 7.6.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Warehouse Activity Completion Report appears. For more 
information about the Warehouse Activity Completion Report layout, 
see Section 7.6.3, "Report Layout".

7.6.2 Report Criteria
The Warehouse Activity Completion Report criteria screen enables you to 
enter the criteria for which the Warehouse Activity Completion Report 
generates.
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Figure 7–13 Warehouse Activity Completion Report Criteria Screen
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7.6.3 Report Layout
This section describes the layout of the Warehouse Activity Completion 
Report.

Table 7–20 Warehouse Activity Completion Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

No

Task 
Completion 
Date

Enter the start date and 
the end date for which 
the report is generated.

You can also click the  
icons to choose the date 
range.

The current 
date.

Yes

Task Type Check the appropriate 
task type.

Check Task Type to check 
all task types in the Task 
Type area.

Selected. Yes

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

On selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
user’s default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering the 
user’s primary enterprise.

Selected. No
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Figure 7–14 Warehouse Activity Completion Report
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The Warehouse Activity Completion Report appears in landscape layout.

7.6.4 Group and Sort Criteria
The Warehouse Activity Completion Report is grouped by Task Type and 
Date.

Task Type is sorted in ascending order and Date is sorted in descending 
order.

7.6.5 Page Break Criteria
The Warehouse Activity Completion Report has no page break criteria.

7.6.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 7–21 Warehouse Activity Completion Report

Field Description

Task Type The task for which the report is generated.

Note: The information that appears on this report 
depends upon the date range entered in the criteria 
screen.

If completed task types exist for any date within the date 
range specified in the criteria screen, this date, along with 
the number of task types completed on that date and the 
number of units of the item, appear in the report.

Number of Tasks The number of tasks of the specified task 
type that is completed on a particular date.

Quantity The number of units of the items for which 
the task type is complete.
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7.7 Putaway Location Override Report
The Putaway Location Override Report captures all the putaway location 
overrides that were done by operators during Putaway. The report also 
lists the alternate locations that were used to deposit.

It provides the receiving supervisors with a way to analyze the reasons 
for overrides by physically checking the suggested location.

This report also allows the supervisor to analyze the exceptions.

Intended Audience
Receiving supervisor and Warehouse managers use this report to 
measure the accuracy of Putaway. The report is generated manually.

7.7.1 Generating the Report
To generate the Putaway Location Override Report:

1. Navigate to Task > Putaway Location Override Report. The Putaway 
Location Override Report criteria screen appears. For more 
information about the Warehouse Activity Completion Report criteria 
screen, see Section 7.7.2, "Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. 
The Putaway Location Override Report appears. For more information 
about the Putaway Location Override Report layout, see 
Section 7.7.3, "Report Layout".

7.7.2 Report Criteria
The Putaway Location Override Report criteria screen enables you to 
enter the criteria for which the Putaway Location Override Report 
generates.
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Figure 7–15 Putaway Location Override Criteria Screen

Table 7–22 Putaway Location Override Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

The current 
node of the 
user.

Yes

Zone Enter the zone for which 
the report is generated.

You can also click  to 
choose the zone. 

Click  to enter more 
zones. These zones are 
taken into consideration 
while generating the 
report.

Click  to remove a 
specific zone.

Blank. No
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7.7.3 Report Layout
This section describes the layout of the Putaway Location Override 
Report.

Execution Time Enter the start date and 
time and the end date 
and time for which the 
report is generated.

You can also click the  
icons to choose the date 
range and time.

Current Date Yes

User ID Enter the identifier of the 
user for whom the report 
is generated.

Blank No

Exception Code Enter the exception code 
for which the report is 
generated.

Blank No

Table 7–22 Putaway Location Override Report Criteria Screen

Field Description Default Value Mandatory
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Figure 7–16 Putaway Location Override Report
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The Putaway Location Override Report appears in landscape layout.

7.7.4 Group and Sort Criteria
The Putaway Location Override Report is grouped by Zone and User Id 
and the zone is sorted in ascending order.

For each zone report starts in a new table, the Zone ID is printed on the 
top of the table.

7.7.5 Page Break Criteria
For each zone report starts in a new page and new table.

7.7.6 Additional Setup Required
A new Execution Exception Code “TARGET_LOCATION_OVERRIDE” has to 
be defined for the Node for which report is generated. This is required as 
currently the application allows users to deposit at a different Location 
with out mandating the Exception Code. All such overrides have a default 

Table 7–23 Putaway Location Override Report 

Field Description

User Id The identifier of the user who executed the task.

Original Deposit 
LocationId

The original deposit location suggested.

Actual Deposit 
LocationId

The actual location where the user deposited.

Execution Time Time of execution.

Task Id The identifier of the task.

Item Id The identifier of the item.

Item Description The description of the item.

LPN No The identifier of the container.

LPN Type Container type - Case or Pallet.

Exception Code A unique code of the execution exception.

Exception Description The description of the execution exception.
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Exception Code “TARGET_LOCATION_OVERRIDE”. So, if you define an 
Exception Code as mentioned above and associate it with an appropriate 
description, the same will be displayed in the report otherwise the 
Execution Description field will be empty for such overrides.
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Additional Setup Required
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8
Billing Activity Reporting Engine Reports

The following billing activity reporting engine report can be generated 
using the Sterling Warehouse Management System:

Billing Activity Report
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8.1 Billing Activity Report
The Billing Activity Report shows the billable activities performed in the 
warehouse for an Enterprise, as captured by the Billing Activity Reporting 
Engine.

Intended Audience
Warehouse managers, inbound supervisors, outbound supervisors, and 
enterprise users use this report to track the activities performed in the 
warehouse. To access this report, the user must belong to the data 
security group representing warehouse managers, inbound supervisors, 
outbound supervisors, or enterprise users.

8.1.1 Generating the Report
To generate the Billing Activity Report:

1. Navigate to ARE > Billing Activity Report. The Billing Activity Report 
criteria screen appears. For more information about the Billing 
Activity Report criteria screen, see Section 8.1.2, "Report Criteria".

2. Enter the criteria and click Generate Report. The Billing Activity 
Report appears. For more information about the Billing Activity Report 
layout, see Section 8.1.3, "Report Layout".

8.1.2 Report Criteria
The Billing Activity Report criteria screen enables you to enter the criteria 
for which the Billing Activity Report generates.
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Figure 8–1 Billing Activity Report Criteria Screen

Table 8–1 Billing Activity Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the 
report is generated.

If you are an enterprise 
user, select the 
appropriate node from 
the drop-down list. For 
other users, the current 
node of the user appears.

The current 
node of the 
user.

No

Enterprise Choose this to generate 
the report for a specific 
enterprise and select the 
enterprise name from the 
drop-down list. 

Not Selected.

Upon selecting 
this, the 
current 
enterprise of 
the user 
appears as the 
default 
enterprise.

No

Across 
Enterprises

Choose this to generate 
the report considering all 
enterprises.

Selected. No
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8.1.3 Report Layout
This section describes the layout of the Billing Activity Report.

Group ID Select the identifier of the 
billing activity group from 
the drop down menu list.

Selected. Yes

Activity Date 
Range

Enter the date range for 
which the billing activity 
report is generated.

You can also click the  
icon to choose the date.

The current 
date.

Yes

Table 8–1 Billing Activity Report Criteria Screen

Field Description Default Value Mandatory
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Figure 8–2 Billing Activity Report
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The Billing Activity Report appears in portrait layout.

8.1.4 Group and Sort Criteria
The Billing Activity Report has no group and sort criteria. 

8.1.5 Page Break Criteria
The Billing Activity Report has no page break criteria.

8.1.6 Additional Setup Required
There is no additional setup required to generate this report.

Table 8–2 Billing Activity Report

Field Description

Activity Code Indicates the unique code of the billing activity 
performed in the warehouse. 

Activity Name Indicates the name of the billing activity performed in 
the warehouse. 

Group ID Indicates the identifier of the billing activity group to 
which the billing activity belongs.

For example, Group ID can be Misc, Stor, Tran, and 
Hand.

Service Quantity Indicates the quantity for which the billing activity was 
performed.

Service UOM Indicates the unit of measure of the billing activity.

Service Charge Indicates the service charged for performing the billing 
activity.

Currency Indicates the currency in which the cost is recorded.
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A
Sterling Warehouse Management System

Report Samples

This appendix contains samples of the various reports that can be 
generated using the Sterling Warehouse Management System.

The reports provided with Sterling Warehouse Management System are 
grouped into the following four menu classifications:

Inbound Reports

Returns Reports

Inventory Reports

VAS Reports

Outbound Reports

Task Reports

Billing Activity Reporting Engine Reports

A.1 Inbound Reports
The different inbound reports provided with the Sterling Warehouse 
Management System are:

Await Material Report, Shipment Details

Await Material Report, Item Details

Dock to Stock Cycle Time KPI Report

Shipments Detail Report

Dock Schedule Report
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Inbound Reports

Inbound Labor Requirements Report

Inbound Labor Requirements Report

Item Attribute Setup Report

Receipt Discrepancy Report

Receipt Discrepancy Report

Receipt Summary Report

Shipment Billing Summary Report

Inbound Shipment Billing Detail Report

Inbound Shipment Billing Detail Report

Outbound Shipment Billing Detail Report

Outbound Shipment Lines Billing Detail Report

Vendor Non-Compliance Report, Seller

Vendor Non-Compliance Report, Carrier

For more information about inbound reports, see Chapter 2, "Inbound Reports".



Await Material Report, Shipment Details
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A.1.1 Await Material Report, Shipment Details 
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Await Material Report, Item Details

A.1.2 Await Material Report, Item Details 



Dock to Stock Cycle Time KPI Report

Sterling Warehouse Management System Report Samples   505

A.1.3 Dock to Stock Cycle Time KPI Report 
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Shipments Detail Report

A.1.4 Shipments Detail Report



Dock Schedule Report
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Figure A–1 Dock Schedule Report
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Inbound Labor Requirements Report

A.1.5  Inbound Labor Requirements Report



Item Attribute Setup Report

Sterling Warehouse Management System Report Samples   509

A.1.6 Item Attribute Setup Report



510   Reports Guide

Item Attribute Setup Report



Order Shipment Report
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Figure A–2 Order Shipment Report
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Receipt Discrepancy Report

A.1.7 Receipt Discrepancy Report



Receipt Detail Report
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Figure A–3 Receipt Detail Report
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Receipt Summary Report

A.1.8 Receipt Summary Report 



Shipment Billing Summary Report
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A.1.9 Shipment Billing Summary Report
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Inbound Shipment Billing Detail Report
Figure A–4 Inbound Shipment Billing Detail Report



Outbound Shipment Billing Detail Report
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Figure A–5 Outbound Shipment Billing Detail Report
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Outbound Shipment Lines Billing Detail Report
Figure A–6 Outbound Shipment Lines Billing Detail Report



Vendor Non-Compliance Report, Seller
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Figure A–7 Vendor Non-Compliance Report, Seller
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Vendor Non-Compliance Report, Carrier
Figure A–8 Vendor Non-Compliance Report, Carrier
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A.2 Returns Reports
The returns report provided with the Sterling Warehouse Management System is:

Returns By Reason Code Report

For more information about returns reports, see Chapter 3, "Returns Reports".
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Returns By Reason Code Report

A.2.1 Returns By Reason Code Report 
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A.3 Inventory Reports
The different inventory reports provided with the Sterling Warehouse Management 
System are:

Containers Having More Than Standard Quantity Report

Containers Having Less Than Standard Quantity Report

Cycle Count Variance Daily Report

Cycle Count Variance Monthly Report

Cycle Count Variance Weekly Report

Dedicated Locations Usage Report

Dedicated Locations Summary Report

Dedicated Locations Unused for More Than 30 Days

Dedicated Locations Activity Report

Dedicated Location Activity Detail Report

Empty Locations Report

Inventory Aging Report

Inventory Aging Detail Report, Inventory Aging Less than 1 month

Inventory Audit Report

Inventory Balance Report

Inventory Hold Report

Item Inventory Across Nodes Report

Item Inventory Report

Item Tag No. Report

Item Velocity Report

Item Velocity Detail Report

Location Inventory Detail Report

Location Inventory Summary Report

Location/SKU Velocity Mismatch Report

Location/SKU Velocity Mismatch Detail Report

Node Inventory Valuation Report

Participant List Report

Participant Detail Report, Nodes

Participant Detail Report, Buyer
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Inventory Reports

Participant Detail Report, Seller

Participant Detail Report, Carrier

Participant Detail Report, Enterprise

Space Consolidation Report

Space Utilization Report

Space Utilization Summary Report

Empty Location(s) Detail Report

Detail Report for Completely filled Location(s)

Partially Full location(s) Detail Report

For more information about inventory reports, see Chapter 4, "Inventory Reports".



Containers Having More Than Standard Quantity Report

Sterling Warehouse Management System Report Samples   525

A.3.1 Containers Having More Than Standard Quantity Report 
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Containers Having Less Than Standard Quantity Report
Figure A–9 Containers Having Less Than Standard Quantity Report



Cycle Count Variance Daily Report
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A.3.2 Cycle Count Variance Daily Report 
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Cycle Count Variance Monthly Report

A.3.3 Cycle Count Variance Monthly Report 



Cycle Count Variance Weekly Report
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A.3.4 Cycle Count Variance Weekly Report
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Dedicated Locations Usage Report

A.3.5 Dedicated Locations Usage Report



Dedicated Locations Summary Report

Sterling Warehouse Management System Report Samples   531

Figure A–10 Dedicated Locations Summary Report
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Dedicated Locations Unused for More Than 30 Days
Figure A–11 Dedicated Locations Unused for More Than 30 Days



Dedicated Locations Activity Report
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A.3.6 Dedicated Locations Activity Report
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Dedicated Location Activity Detail Report
Figure A–12 Dedicated Location Activity Detail Report



Empty Locations Report
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A.3.7 Empty Locations Report
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Inventory Aging Report

A.3.8 Inventory Aging Report



Inventory Aging Detail Report, Inventory Aging Less than 1 month
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Figure A–13 Inventory Aging Detail Report, Inventory Aging Less than 1 month
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Inventory Audit Report

A.3.9 Inventory Audit Report



Inventory Balance Report
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A.3.10 Inventory Balance Report
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Inventory Hold Report

A.3.11 Inventory Hold Report



Item Inventory Across Nodes Report
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A.3.12 Item Inventory Across Nodes Report
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Item Inventory Report

A.3.13 Item Inventory Report 



Item Tag No. Report
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A.3.14 Item Tag No. Report
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Item Velocity Report

A.3.15 Item Velocity Report 



Item Velocity Detail Report
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Figure A–14 Item Velocity Detail Report
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Location Inventory Detail Report

A.3.16 Location Inventory Detail Report



Location Inventory Summary Report
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A.3.17 Location Inventory Summary Report 
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Location/SKU Velocity Mismatch Report

A.3.18 Location/SKU Velocity Mismatch Report



Location/SKU Velocity Mismatch Report
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A.3.18.1 Location/SKU Velocity Mismatch Detail Report 
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Node Inventory Valuation Report

A.3.19 Node Inventory Valuation Report



Participant List Report

Sterling Warehouse Management System Report Samples   551

Figure A–15 Participant List Report
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Participant Detail Report, Nodes
Figure A–16 Participant Detail Report, Nodes 



Participant Detail Report, Buyer
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Figure A–17 Participant Detail Report, Buyer
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Participant Detail Report, Seller
Figure A–18 Participant Detail Report, Seller



Participant Detail Report, Carrier
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Figure A–19 Participant Detail Report, Carrier
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Participant Detail Report, Enterprise
Figure A–20 Participant Detail Report, Enterprise



Space Consolidation Report

Sterling Warehouse Management System Report Samples   557

A.3.20 Space Consolidation Report
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Space Utilization Report

A.3.21 Space Utilization Report



Space Utilization Summary Report
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Figure A–21 Space Utilization Summary Report
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Empty Location(s) Detail Report
Figure A–22 Empty Location(s) Detail Report



Detail Report for Completely filled Location(s)
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Figure A–23 Detail Report for Completely filled Location(s)
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Partially Full location(s) Detail Report
Figure A–24 Partially Full location(s) Detail Report
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A.4 VAS Reports
The VAS report provided with the Sterling Warehouse Management System is:

Work Order Report

For more information about VAS reports, see Chapter 5, "VAS Reports".
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Work Order Report

A.4.1 Work Order Report
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A.5 Outbound Reports
The different outbound reports provided with the Sterling Warehouse Management 
System are:

BOL Total Weights Report

Container Volume Monthly Report

Daily Shipment Report

Dock Schedule Report

Generic Shipper Report

Hot Inventory Report

On Time Shipment Report

Order Billing Summary Report

Inbound Order Billing Detail Report

Inbound Order Lines Billing Detail Report

Outbound Order Billing Detail Report

Outbound Order Lines Billing Detail Report

Order Cycle Time KPI Report

Order Cycle Time Detail Report

Order Shipment Report

Outbound Labor Requirements Report

Pack and Hold Shipment Report

Parcel Manifest Report

Replenishment Status Report

Same Day Pick Pack Ship Percentage Report

Shipment Billing Summary Report

Inbound Shipment Billing Detail Report

Inbound Shipment Lines Billing Detail Report

Outbound Shipment Billing Detail Report

Outbound Shipment Lines Billing Detail Report

Shipment Fill Rate Monthly Report

Shipments Near or Past Cancel Date Report

Shipment Shortage Report

Staging Locations Report, Sort By Location
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Outbound Reports

Staging Locations Report, Sort By Time

For more information about outbound reports, see Chapter 6, "  Outbound 
Reports".



BOL Total Weights Report
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A.5.1 BOL Total Weights Report



568   Reports Guide

Container Volume Monthly Report

A.5.2Container Volume Monthly Report 



Daily Shipment Report
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A.5.3 Daily Shipment Report



570   Reports Guide

Dock Schedule Report
Figure A–25 Dock Schedule Report



Generic Shipper Report
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A.5.4 Generic Shipper Report
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Hot Inventory Report

A.5.5 Hot Inventory Report



On Time Shipment Report
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A.5.6 On Time Shipment Report
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Order Billing Summary Report

A.5.7 Order Billing Summary Report



Inbound Order Billing Detail Report
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Figure A–26 Inbound Order Billing Detail Report 
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Inbound Order Lines Billing Detail Report
Figure A–27 Inbound Order Lines Billing Detail Report



Outbound Order Billing Detail Report
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Figure A–28 Outbound Order Billing Detail Report 
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Outbound Order Lines Billing Detail Report
Figure A–29 Outbound Order Lines Billing Detail Report



Order Cycle Time KPI Report
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A.5.8 Order Cycle Time KPI Report
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Order Cycle Time KPI Report

A.5.8.1 Order Cycle Time Detail Report



Order Shipment Report
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A.5.9 Order Shipment Report 
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Outbound Labor Requirements Report

A.5.10 Outbound Labor Requirements Report



Pack and Hold Shipment Report
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Figure A–30 Pack and Hold Shipment Report
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Parcel Manifest Report

A.5.11 Parcel Manifest Report



Replenishment Status Report
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A.5.12 Replenishment Status Report
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Same Day Pick Pack Ship Percentage Report

A.5.13 Same Day Pick Pack Ship Percentage Report 



Shipment Billing Summary Report

Sterling Warehouse Management System Report Samples   587

A.5.14 Shipment Billing Summary Report
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Inbound Shipment Billing Detail Report
Figure A–31 Inbound Shipment Billing Detail Report



Inbound Shipment Lines Billing Detail Report
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Figure A–32 Inbound Shipment Lines Billing Detail Report
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Outbound Shipment Billing Detail Report
Figure A–33 Outbound Shipment Billing Detail Report



Outbound Shipment Lines Billing Detail Report

Sterling Warehouse Management System Report Samples   591

Figure A–34 Outbound Shipment Lines Billing Detail Report
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Shipment Fill Rate Monthly Report

A.5.15 Shipment Fill Rate Monthly Report



Shipments Near or Past Cancel Date Report
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A.5.16 Shipments Near or Past Cancel Date Report 
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Shipment Shortage Report

A.5.17 Shipment Shortage Report



Staging Locations Report, Sort By Location
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A.5.18 Staging Locations Report, Sort By Location 
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Staging Locations Report, Sort By Time

A.5.19 Staging Locations Report, Sort By Time
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A.6 Task Reports
The task reports provided with the Sterling Warehouse Management System are:

In-Progress Container Summary Report

In-Progress Container Summary Report

In-Progress Shipment Summary Report

In-Progress Shipment Details Report

User Productivity Daily Report

User Productivity Weekly Report

User Productivity Monthly Report

Warehouse Activity Completion Report

For more information about task reports, see Chapter 7, "Task Reports".
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In-Progress Container Summary Report

A.6.1 In-Progress Container Summary Report



In-Progress Shipment Summary Report
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A.6.2 In-Progress Shipment Summary Report
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In-Progress Shipment Details Report

A.6.3 In-Progress Shipment Details Report 



User Productivity Daily Report
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A.6.4 User Productivity Daily Report
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User Productivity Weekly Report

A.6.5 User Productivity Weekly Report 



User Productivity Monthly Report
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A.6.6 User Productivity Monthly Report
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Warehouse Activity Completion Report

A.6.7 Warehouse Activity Completion Report
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A.7 Billing Activity Reporting Engine Reports
The billing activity reporting engine report provided with the Sterling Warehouse 
Management System is:

Billing Activity Report

For more information about the billing activity reporting engine report, see 
Chapter 8, "Billing Activity Reporting Engine Reports".
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Billing Activity Report
Figure A–35 Billing Activity Report
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B
Using Report Studio

Cognos 8 BI 8.4 is a Cognos application that is used as a module in the 
Selling and Fulfillment Foundation to produce and maintain user reports 
for Web-based distribution, scheduling, and maintenance. This tool 
produces reports in 25 languages and seven formats.

Cognos 8 BI 8.4 has two areas for creating reports, Report Studio and 
Query Studio. Query Studio is used for creating ad hoc reports that are 
used one time, cannot be maintained and have no shelf life. Report 
Studio is used for reports that remain in the system, is scheduled and 
routed, and are customizable and reusable. This chapter contains 
information for users of Report Studio. Query Studio is documented in 
the Cognos 8 BI 8.4 User Guide.

Selling and Fulfillment Foundation has provided fifteen reports for 
Sterling Warehouse Management System that can be used "as is". These 
reports are used as starter templates for developers fluent in creating 
and maintaining reports using Cognos 8 BI 8.4.

This chapter provides basic information for using Report Studio, utilizing 
the Sterling Warehouse Management System reports and customizing 
those reports for your application. Use the documentation set provided 
on the Cognos CD-ROM or at the Cognos Web site at www.cognos.com 
for additional information about creating and maintaining reports using 
the Cognos 8 BI 8.4 applications, including Report Studio, Query Studio, 
and Framework Manager.

B.1 Report Studio
Report Studio is used for creating, maintaining, scheduling, and routing 
reports detailing every aspect of the Warehouse Management System. 
Specifications for a report are created in Report Studio or Query Studio. 

http://www.cognos.com
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When you need to edit saved reports you must use Report Studio as 
Query Studio is not used for editing after a report has been saved.

Report specifications are viewed from the Tools menu by selecting Show 
Specifications. These specifications are an XML document. When you run 
a report, information from the report specifications, the model metadata, 
and report properties are combined. These three items define the 
content, format and appearance of the resulting report.

Data displayed in a report is defined by the built in query the report runs. 
Report Studio maintains a default query for each stored report. 
Additional data items are combined with the default query. You can 
create additional queries in single report. Calculations and Summaries 
can also be added to your report.

The authoring components of Query Studio and Report Studio, produce 
the required specifications for a report. However, additional information 
is obtained from other Cognos 8 BI 8.4 resources running in the 
background. The main content of the report is generated from several 
data sources through the published model. Additional information comes 
form calculations and background reports. Cognos 8 BI 8.4 also 
contributes a small amount of information for reports.

Report output is produced when you run a report the first time. The 
results are stored in Cognos 8 BI 8.4. This version of the report is used 
to create similar reports multiple formats. Available formats include PDF, 
XML, HTML, XHTML, XLS (Excel) or CSV. Report users with proper 
authority can create, save, and schedule their own views of a report.

B.1.1 Sterling Reports
Selling and Fulfillment Foundation provides fifteen standard reports in the 
report studio for the Sterling Warehouse Management System 
application. These reports can be used "as is" or you can customize them 
using Report Studio. The reports can also be used as templates for the 
creation of your own reports. To open a Sterling Warehouse Management 
System report in Report Studio select Open from the File menu. The 
Open dialog box displays. Select WMS. Double click on the report you 
need and the report opens Report Studio. 
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B.1.1.1 Using the Sterling Warehouse Management 
System Reports
This procedure is used start up the Cognos Report Studio and then 
display a Sterling Warehouse Management System report.

Select Report Studio from the Sterling Analytics Connection screen. 
Report Studio displays. See Figure B–1, "Welcome Dialog Box".

Select Open an Existing Report, the Open dialog box displays. See 
Figure B–2, "Open Dialog Box".

Select WMS, a list of WMS reports displays. SeeFigure B–3, "WMS 
Report List".

Double click on the report you need. The Report displays in Report 
Studio. See Figure B–4, "Report Studio".

Figure B–1 Welcome Dialog Box
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Figure B–2 Open Dialog Box

Figure B–3 WMS Report List
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Figure B–4 Report Studio

B.2 User Interface
The Report Studio user interface screen has a work area, an Explorer bar 
and two side panes:

Insert Objects Pane - This area contains objects that are used to 
create a report. They include the model tab, query items and 
calculations. 

Properties Pane - This pane contains selectable object properties.



612   Reports Guide

Creating a Report

Explorer Bar - Contains commands used to create and edit a report.

Work Area - This is where you design a report.

B.2.1 Report Structure
Reports have two components, a layout component that defines the 
report appearance and a query component that defines the data included 
in the report A layout is used to present the data in an orderly fashion 
with respect to lists, charts and crosstabs. The report should be laid out 
in a manner where the data is allowed to flow freely from one page to 
the next page. Borders, color, and images are used to enhance the 
appearance of the report but a greater importance should be placed on 
the manner in which the data is viewed by the user.

Pages contain the objects used to build a report. Pages should have, at a 
minimum, a header, a body and a footer. When the amount of data in a 
report exceeds one page, the primary page, the one you created, repeats 
for all additional data. You control the flow from page to page.

Objects are lists, charts, text blocks, and other layout items that are 
added during the creation of a page. Queries determine the data items 
that appear in the report. Most data can be obtained by using the 
SELECT statement. You can also calculate data and then display the 
calculation results, rather than the data columns used to produce the 
calculation.

B.2.2 Creating a Report
Creating a report is actually the process of creating a specification. The 
specification defines prompts and queries used to produce the data. The 
specification defines the layout and style used to present the data. 

When starting out, use the reports supplied by the Selling and Fulfillment 
Foundation as a template, then make changes required and save the 
result using a different name. This process simplifies the creation and 
saves time. Selling and Fulfillment Foundation supplies a number of 
reports that are documented in the manual.

Creating a report involves:

Specifying a Package - The package used to produce reports are the 
models that are created in Framework Manager. A model is a set of 
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related query subjects and other objects such as filters and 
calculations.

Choosing a Template - You can select a predefined template that has 
been formatted for a specific report type. You can also use one of the 
reports provided by the Selling and Fulfillment Foundation.

Adding Query Items - Adding data means selected query items that 
are required to produce the report data.

Saving a Report - A report can be save to an individual computer or 
to the Cognos 8 BI 8.4 server

Running the Report - Run a report to determine if the data you 
selected is the data that is being returned. A report can also run from 
the Cognos connection.

B.2.3 Rules for Creating New Reports
Do not modify the Sterling Analytics package standard in the Sterling 
Warehouse Management System. This allows for upgrades to be 
applied to the standard reports.

To add new reports, open the Sterling Analytics package model in 
Framework Manager. Rename the package name to something else 
like Sterling-NEWNAME-Analytics. Save this package and publish it in 
the content repository.

After publishing the package you can see a new package folder 
named Sterling-NEWNAME-Analytics along with the previous 
Sterling-Analytics on Cognos Connection. All new reports should be 
added onto this new package. Any changes to the model should also 
be made to this package. If you adds new views or modify existing 
views, this is done in the new package "Sterling-NEWNAME-Analytics" 
in Framework Manager. 

B.2.3.1 Saving a Report
Select Save from the File menu.

Select Save As to file the report under a different name, thus creating 
a second report.

Specify where you want the report to exist.

Select Save.
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B.2.3.2 Running a Report
Open the report you want to run

Select Validate Report from the Tools menu

Read the message box that details report errors.

Select Run options from the RUn menu to set the options required.

Select a format from the Run menu

The report runs in the Report Viewer window. When the report has 
finished running you can rerun it in a different format if required.

B.2.3.3 Printing a Report
Select Page Setup from the File menu. 

Set your page options.

Select Print from the File menu.

Select your print options.

Select OK.

B.2.3.4 Creating a Template
You can create your own custom template in Report Studio. Do this when 
you are going to produce a number of reports of the same type. To 
create a report template, create a new report. An existing report can also 
be used as a new template. 

A template contains the following items:

Header

Footer

Text

Images

Variables such as date, page numbers

Placeholders

Avoid using query items, calculations or filters in a template. These items 
are package dependant and should not be used globally. Errors occur in 
reports that are created with templates containing these items.
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B.2.3.5 Managing Reports
After creating a few reports you are ready to manage the reports for 
distribution. The following features are available in Cognos Connection 
for report management:

Scheduling

Distribution printing

Language changes

Set prompts

Report history maintenance

Version control

Information detailing these tasks is maintained in the Cognos 8 BI 8.4 
User Guide.
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Index

A
Across Enterprises field, 497
Activity Code field, 500
Activity Date Range field, 498
Activity Name field, 500
Activity Type field, 188
Actual Ship Date field, 318, 372
Actual Shipment Date field, 361
Appointment Date field, 46
Appointment No field, 48
Appointment Type field, 46, 48
Audit Date field, 186
Average Working Hours Per User Per Day 

field, 473, 479
Await Material Report

await material report, item details, 39
fields

Buyer, 39
item description, 39
item ID, 39
ordered quantity, 39
PC, 39
Seller, 39
Ship date, 39
Shipment No, 39
shortage quantity, 39
UOM, 39

Await Material report
await material report, shipment details, 37
definition, 34
generating, 34
intended audience, 34

Await Material Report, Item Details

additional setup required, 42
Await Material report, item details

group and sort criteria, 42
page break criteria, 42
report layout, 40

Await Material Report, Shipment Details
additional setup required, 39

Await Material Shipment report
group and sort criteria, 39
page break criteria, 39

B
Bill Of Lading (BOL), 28, 311
Billing Activity Report, 496

additional setup required, 500
generating, 496
group and sort criteria, 500
page break criteria, 500
report criteria, 496
report layout, 498

BOL No field, 48
BOL total weight report

group and search criteria, 315
page criteria, 315

BOL Total Weights Report
additional setup required, 315
fields

actual departure date, 315
BOL number, 315
Group Total For Carrier, 315
Group Total For Enterprise, 315
number of cases, 315
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number of pallets, 315
Total Weight UOM, 315
Weight, 315

report criteria, 311
report layout, 313

BOL Total weights report
definition, 311
generating, 311
intended audience, 311

Buyer field, 90, 331, 372
By Location Capacity field, 394
By Quantity field, 394

C
Carrier field, 44, 48, 90, 108, 313, 325, 332, 362, 384, 

444
Case Quantity field, 71
Cognos BI Server 8.0

benefits, 13
Cognos 8 BI 8.4

icons
View in HTML format, 19
View in PDF format, 19

integration, 2
Comma Separated Value (CSV), 14
Completely Full Location(s) Detail Report

fields
Aisle Number, 297
Bay Number, 297
Current Available Volume, 297
Level Number, 297
Location ID, 297
Net Available Volume, 297
Pend In Volume, 297

group and sort criteria, 297
layout, 295
page break criteria, 297

Container Dashboard Report
intended audience, 442, 496

Container Having field, 122
Container Type field, 122
Container Volume Monthly Report

additional setup required, 321
definition, 316

generating, 316
group and sort criteria, 321
intended audience, 316
page break criteria, 321
report criteria, 316
report layout, 319

Containers Having More Than Standard Quantity 
Report

fields
Actual Qty, 125
Container ID, 125
Container Type, 125
Description, 125
Item ID, 125
Location ID, 125
PC, 125
Standard Quantity, 125
UOM, 125
Zone, 125

Containers Not Having Standard Quantity Report
additional setup required, 127
definition, 119
generating, 119
group and sort criteria, 127
intended audience, 119
page break criteria, 127
Report Criteria, 119
Report Layout, 123

Currency field, 500
Customer field, 425
Cycle Count Variance Daily Report

additional setup required, 134
definition, 128
fields

Absolute Variance Quantity, 133
Accuracy, 133
Container No., 133
Container Type, 133
Count Quantity, 133
Date, 133
Location ID, 133
Node Key, 133
System Quantity, 133
Variance Currency, 133
Variance Quantity, 133
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Variance Value, 133
% Variance, 133

generating, 128
group and sort criteria, 134
intended audience, 128
page break criteria, 134
Report Criteria, 128
Report Layout, 131

Cycle Count Variance Monthly Report
additional setup required, 141
definition, 135
fields

, 140
Absolute Variance Quantity, 140
Accuracy, 140
Count Quantity, 140
Locations Counted, 140
Locations With Variance, 140
Month Ends On, 140
Node, 140
System Quantity, 140
Variance Currency, 140
Variance Quantity, 140
Variance Value, 140
% Variance, 140

generating, 135
group and sort criteria, 141
intended audience, 135
page break criteria, 141

Cycle count Variance Monthly Report
Report Criteria, 135
Report Layout, 138

Cycle Count Variance Weekly Report
additional setup required, 148
definition, 142
fields

Week Begins On, 147
Week Ends On, 147

generating, 142
group and sort criteria, 148
intended audience, 142
page break criteria, 148
Report Criteria, 142
Report Layout, 145

Cycle Time field, 362

D
Daily Shipment Report

additional setup required, 328
definition, 322
fields

Containers Shipped, 327
date, 327
Pending Shipments Shipped, 327
Shipments Carried Over, 327
shipments expected to be shipped, 327
Shipments Pending from Previous 

Day(s), 327
Shipments Shipped, 327
Shipments Shipped Early, 327
Shipments shipped on Time, 327
Units Shipped, 327

generating, 322
group and sort criteria, 327
intended audience, 322
page break criteria, 327
report criteria, 322
report layout, 325

Date field, 48
Date Range field, 62, 104, 444, 485
Dedicated Location Activity Detail Report, Locations 

With Replenishment 11-25, 169
Dedicated Location Activity Detail Report, Locations 

With Replenishment 1-5, 165
Report Layout, 166

Dedicated Location Activity Detail Report, Locations 
With Replenishment 6-10, 168

Dedicated Location Activity Detail Report, Locations 
With Replenishment >25, 169

Dedicated Locations Activity Report
additional setup required, 163
definition, 159
fields

No. Of Dedicated Locations, 162
No. of Locations with Replenishment 

11-25, 162
No. of Locations with Replenishment 

1-5, 162
No. of Locations with Replenishment 

6-10, 162
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No. of Locations with Replenishment > 
25, 162

generating, 159
group and sort criteria, 162, 165
intended audience, 159
page break criteria, 163, 165
Report Criteria, 159
Report Layout, 160

Dedicated Locations Activity Summary Report, 163
Report Layout, 163

Dedicated Locations Summary Report
group and sort criteria, 155
page break criteria, 155
Report Layout, 153

Dedicated Locations Unused for More Than 15 
Days, 155

Dedicated Locations Unused for More Than 30 
Days, 156

Group and Sort Criteria, 158
page break criteria, 158
Report Layout, 156

Dedicated Locations Unused For More Than 90 
Days

fields
Inventory Organization Code, 158
Last Activity Date, 158

Dedicated Locations Unused for More Than 90 
Days, 158

Dedicated Locations Usage Report
additional setup required, 153
Dedicated Locations Summary Report, 153
Dedicated Locations Unused for More Than 7 

Days, 155
definition, 149
fields

No of Dedicated Locations, 152
No. of Locations Unused For More Than 

fifteen days, 152
No. of Locations Unused For More Than thirty 

days, 153
No. of Locations Unused For More Than 7 

Days, 152
No. of Locations Unused For More Than 90 

days, 153
Zone ID, 152

generating, 149
group and sort criteria, 153
intended audience, 149
layout, 153
page break criteria, 153
Report Criteria, 149
Report Layout, 150

Delivery Dock Schedule Report, 42
additional setup required, 49
generating the report, 43
group and sort criteria, 48
intended audience, 42
page break criteria, 48
report criteria, 43
report layout, 46

Detail Report for filled Location(s), 295
Discrepancy Level field, 80, 103
Display Replenishment field, 394
Display Replenishment for Past Days field, 160
Dock field, 45
Dock Pickup Schedule Report

generating the report, 328
intended audience, 328

Dock to Stock Cycle KPI Time
criteria, 50
layout, 52

Dock to Stock Cycle Time KPI Report
additional setup required, 55
fields

Putaway Beyond 2X Hrs, 54
Putaway in X Hrs, 54
Putaway in 2X Hrs, 54
Receipt Date, 54
Total Shipments, 54

Dock to Stock Cycle Time Report
definition, 50
generating, 50
group and sort criteria, 55
intended audience, 50
page break criteria, 55

Document Type field, 35, 51, 112, 312, 337, 454
Due_to_Count_Variance field, 202
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E
Empty Location Report

additional setup required, 173
criteria, 170
definition, 170
fields

Aisle Number, 173
Bay Number, 173
Current Available Volume, 173
Level Number, 173
Location ID, 173
Location Size Code, 173
Location Type, 173
Net Available Volume, 173
Pend In Volume, 173

generating, 170
group and sort criteria, 173
intended audience, 170
layout, 171
page break criteria, 173

Empty Location(s) Detail Report, 293
fields

Aisle Number, 295
Bay Number, 295
Location ID, 295
Pend In Volume, 295

group and sort criteria, 295
layout, 293
page break criteria, 295

Enterprise field, 102, 497
environment variable

YANTRA_HOME, xxxii
YANTRA_OLD_HOME, xxxi
YFS_OLD_HOME, xxxii

Extendible Markup Language (XML), 14

F
fields

Across Enterprises, 485
case, 122
Enterprise, 485
having less quantity than case/pallet, 122
having more quantity than case/pallet, 122

Item Attributes, 71
item details, 37
pallets, 122
shipment details, 37
Show Items in Inventory, 70
Start No Earlier Than, 304

For_QC_Activities, 202

G
Generic Shipper Report

additional setup required, 335
criteria, 329
definition, 329
fields

Buyer, 334
Carrier/Service, 334
Destination, 334
Enterprise Code, 334
Expected Shipment Date, 334
Load No., 334
Mode, 334
Receiving Node, 334
Seller, 334
Shipment No, 334
Status, 334
Total Volume, 334
Volume UOM, 334
Weight, 334
Weight UOM, 334

generating, 329
group and sort criteria, 334
intended audience, 329
page break criteria, 334
Report layout, 332

Group ID field, 498, 500

H
Hazmat Class field, 71
Height field, 71
Hot Inventory Report

additional setup required, 340
criteria, 336
definition, 336
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fields
Expected Delivery Date, 340
Inbound Shipment No., 340
Item Description, 340
Item ID, 340
PC, 340
Shipment Quantity, 340
Shipment Status, 340
Shortage Quantity, 340
UOM, 340

generating, 336
group and sort criteria, 340
intended audience, 336
layout, 338
page break criteria, 340

Hypertext Markup Language (HTML), 14

I
Identify_Tag field, 225, 244
Inbound Labor Requirements Report

fields
Expected Delivery Dates, 64
No of Cases, 64
No of Order Lines, 64
No Of Shipments, 64
No Of Units, 64
Person Hours Required, 64

Inbound Labour Requirements
additional setup required, 65, 380
definition, 60
generating report, 60
group and sort criteria, 64
intended audience, 60
page break criteria, 64

Inbound Order Billing Detail Report, 350
definition, 350
fields

Buyer, 352
Order Date, 352
Order No, 352
Order Type, 352
Seller, 352

group and sort criteria, 352
layout, 350

page break criteria, 352
Inbound Order Lines Billing Detail Report, 352

fields
Buyer, 354
Order Date, 354
Order No, 354
Order Type, 354
Prime Line No, 354
Seller, 354

group and sort criteria, 354
layout, 352
page break criteria, 354

Inbound OrderLines Billing Detail Report
definition, 352

Inbound Shipment Billing Detail Report
Buyer, 410
definition, 408
group and sort criteria, 410
layout, 408
page break criteria, 410
Seller, 410
Shipment No, 410

Inbound Shipment Lines Billing Detail Report
fields

Buyer, 412
Prime Line No, 412
Seller, 412
Shipment No, 412
Sub Line No, 412

group and sort criteria, 412
layout, 410
page break criteria, 412

In-Progress Container Details Report
Packed

report layout, 449
In-Progress Container Details Report, 

Manifested, 451
In-Progress Container Details Report, Packed, 449, 

451
group and sort criteria, 451
page break criteria, 451

In-Progress Container Summary Report
additional setup required, 448
definition, 442
field
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Number of Containers, 446
fields

Carrier, 447, 450
Completed Containers, 448
Container No, 450
Document Type, 447
Enterprise Code, 447
Number of Containers, 447
Shipment Mode, 447
Status, 446, 448
Time Since Last Activity, 450

generating, 442
group and sort criteria, 448
page break criteria, 448

In-Progress Shipment Details Report
fields

Carrier, 462
Ship To, 462
Shipment No., 462
Time Since Last Activity, 462

report layout, 461
In-Progress Shipment Details Report, Packed

page break criteria, 463
group and sort criteria, 463

In-Progress Shipment Details Report, Picked, 461, 
463, 464

In-Progress Shipment Summary Report
additional setup required, 460
definition, 452
fields

Carrier, 459
Completed Shipments, 460
Document Type, 459
Enterprise Code, 459
Shipment Mode, 459
Status, 458, 460
% of Shipments, 457

generating, 452
group and sort criteria, 460
intended audience, 452
page break criteria, 460
report criteria, 452
report layout, 455

Inventory Aging Detail Report for Inventory Aging 

Less than 1 month, 180
Inventory Aging Detail Report for Inventory Aging 

More Than 1 Month, 182
Inventory Aging Detail Report for Unknown Inventory 

Age, 183
Inventory Aging Report

definition, 174
fields

Currency, 178
Product Line, 178
Quantity, 178
value, 178
# of locations, 178

generating, 174
group and sort criteria, 179
intended audience, 174
page break criteria, 180
Report Layout, 176, 180

Inventory Aging Report for Inventory Aging Less 
Than 1 Month

group and sort criteria, 182
page break criteria, 182

Inventory Aging Report for Inventory Aging Less 
than 1 Month

additional setup required, 182
fields

Receipt Date, 182
Inventory Audit Report

additional setup required, 192
criteria, 184
definition, 184
fields

Activity Type, 191
Container No, 191
Location ID, 191
Operation, 191
Quantity, 191
Reason Code, 191
Transaction Date, 191
User ID, 191

generating, 184
group and sort criteria, 191
intended audience, 184
layout, 189
page break criteria, 191
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Inventory Balance Report
additional setup required, 199
criteria, 193, 433
definition, 193
field

Item ID, 198
fields

Adjustments, 198
Closing Balance, 198
Date, 198
Node, 198
Opening Balance (Qty), 198
Receipts, 198
Returns, 198
Segment, 198
Segment Type, 198
Ship By Date, 198
Shipments, 198
Supply Type, 198
Tag No., 198

generating, 193
group and sort criteria, 199
intended audience, 193
layout, 196, 347
page break criteria, 199

Inventory Hold Report
additional setup required, 209
criteria, 200
definition, 200
fields

Inventory Status, 205
Quantity, 205

generating, 200
group and sort criteria, 209
intended audience, 200
layout, 203
page break criteria, 209

Inventory Hold Type field, 202
Inventory Status field, 202
Is Dedicated field, 71
Item Attribute Setup Report

criteria, 67
definition, 67
fields

Hazmat Class, 74

Height, 74
Is Dedicated, 74
Length, 74
Weight, 74
Width, 74

generating, 67
intended audience, 67
layout, 72

Item Attribute Setup Report, All Items, 72
additional setup required, 74
group and sort criteria, 74
page break criteria, 74

Item Attribute Setup Report, Items In Inventory and 
PO/Shipment, 75

Item Attribute Setup Report, Only Items In 
Inventory, 74

Item Attribute Setup Report, Only Items In 
PO/Shipment, 75

Item ID field, 187, 218
Item Inventory Across Nodes

fields
Currency, 215
Unit Cost, 215
Value, 215

Item Inventory Across Nodes Report
additional setup required, 216
criteria, 210
fields

Allocated Quantity, 215
Available Quantity, 215
Node, 215
On Hand Quantity, 215

layout, 213
Item Inventory across Nodes Report

definition, 210
group and sort criteria, 215
intended audience, 210
page break criteria, 216

Item Inventory across Nodes report
generating, 210

Item Inventory Report
additional setup required, 221
criteria, 217
definition, 217
fields
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Inventory Status, 221
Item Description, 221
Item ID, 221
PC, 221
Quantity, 221

generating, 217
group and sort criteria, 221
intended audience, 217
layout, 219
page break criteria, 221

Item Tag No Report
definition, 222
generating, 222
group and sort criteria, 231
intended audience, 222
page break criteria, 231

Item Tag No. Report
additional setup required, 232
criteria, 222
fields

Actual Shipment Date, 231
Expected Delivery Date, 227
Item ID, 227
Location ID, 229
Quantity, 227
Shipment No, 227, 231
Tag No., 227

layout, 225
Item Velocity Detail Report, 238

group and sort criteria, 240
layout, 238
page break criteria, 240

Item Velocity Report
additional setup required, 238
criteria, 233
fields

No of Shipment, 237
Not Setup, 237
Velocity Code, 237
Velocity Code A, 237
Velocity Code B, 237
Velocity Code C, 237

generating, 233
group and sort criteria, 237
intended audience, 233

layout, 235
page break criteria, 238

L
Length field, 71
Load No field, 48
Load No. field, 332
Location field, 187
Location Inventory Detail Report

additional setup required, 247
criteria, 241
definition, 241
fields

Container ID, 246
Container Type, 246
Inventory Status, 246
Item Description, 246
Item ID, 246
Location ID, 246
Quantity, 246
Serial No, 246
Tag Number, 246
Zone ID, 246

generating, 241
group and sort criteria, 246
intended audience, 241
layout, 244
page break criteria, 246

Location Inventory Report
definition, 248

Location Inventory Summary Report
additional setup required, 253
criteria, 248
fields

Item Description, 253
Item ID, 253
Location, 253
Quantity, 253
Zone ID, 253

generating, 248
group and sort criteria, 253
intended audience, 248
layout, 251
page break criteria, 253
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Location Size Code field, 171, 288
Locations field, 435
Location/SKU Mismatch Detail Report, 257

fields
Location, 260
Quantity, 260

Location/SKU Mismatch Report
fields

Item Velocity, 257
Location Velocity, 257
Zone, 257

group and sort criteria, 257, 260
page break criteria, 257, 260

Location/SKU Velocity Mismatch Detail Report
layout, 258

Location/SKU Velocity Mismatch Report
additional setup required, 257
criteria, 254
definition, 254
generating, 254
intended audience, 254
layout, 255

Location(s) with % Utilization, 283
Look for Cancel Dates Upto field, 425
Lot No. Discrepancy field, 80

M
Manifest Date field, 389

N
No of Working Days Per Week field, 479
Node field, 44, 102, 112, 497
Node Inventory Valuation Report

additional setup required, 265
criteria, 261
definition, 261
fields

Cost Currency, 265
Quantity, 265
Total, 265
Value, 265

generating, 261
group and sort criteria, 265

intended audience, 261
layout, 263
page break criteria, 265

O
On Time Shipment Report

additional setup required, 345
criteria, 341
definition, 341
fields

Actual Ship Date, 345
No Shipments Delayed by more than 3 

Days, 345
No Shipments Delayed by 1 Day, 345
No Shipments Delayed by 2 Days, 345
No Shipments Delayed by 3 Days, 345
No Shipments Shipped as Scheduled, 345
Node, 345
Number of Shipments, 345

generating, 341
group and sort criteria, 345
intended audience, 341
layout, 343
page break criteria, 345

On_Freeze_for_Picking field, 202
Order Billing Summary Report

additional setup required, 350
criteria, 346
definition, 346
fields

Date, 349
Grand Total, 349
No. of Inbound OrderLines, 349
No. of Inbound Orders, 349
No. of Outbound OrderLines, 349
No. of Outbound Orders, 349
Total for E1, 349

generating, 346
group and sort criteria, 349
intended audience, 346
page break criteria, 349

Order Cycle Time Detail Report, 366
group and sort criteria, 368
page break criteria, 368
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Order Cycle Time KPI Report
additional setup required, 365
criteria, 359
fields

Carrier, 364
Cycle Time, 368
No. of Shipments Shipped, 364
Node, 364
Seller, 368
Ship Date, 364
Ship Mode, 364
Shipment No, 368
Shipments Shipped beyond 2X hrs, 365
Shipments Shipped within X hrs, 364
Shipments Shipped within 2X hrs, 364

layout, 362, 366
Order Cycle Time Report

definition, 359
generating, 359
group and sort criteria, 365
intended audience, 359
page break criteria, 365

Order Cycle Time Report Beyond 2X hours, 369
Order Cycle Time Report Within X hours, 368
Order Cycle Time Report Within 2X hours, 368
Order Date field, 347
Order No field, 48, 372
Order Shipment Report

additional setup required, 374
criteria, 370
definition, 370
fields

Buyer, 374
Item Description, 374
Item ID, 374
Order No, 374
PC, 374
Quantity Ordered, 374
Quantity Shipped, 374
Seller, 374
Shipment Date, 374
Shipment No, 374
UOM, 374

generating, 370
group and sort criteria, 374

intended audience, 370
layout, 372
page break criteria, 374

Order # field, 89
Outbound Labor Requirements Report

fields
Expected Shipment Date, 379
No. of Cases, 379
No. of Order Lines, 379
No. of Shipments, 379
No. of Units, 379
Person Hours Reqd, 379

report criteria, 375
report layout, 377

Outbound Labour Requirements Report
definition, 375
generating, 375
group and sort criteria, 379
intended audience, 375
page break criteria, 379

Outbound Order Billing Detail Report, 354
definition, 354
fields

Buyer, 356
Order Date, 356
Order No, 356
Order Type, 356
Seller, 356

group and sort criteria, 356
layout, 354
page break criteria, 356

Outbound Order Lines Billing Detail Report, 356
definition, 356
fields

Buyer, 358
Order Date, 358
Order No, 358
Order Type, 358
Prime Line No, 358
Seller, 358
Sub Line No., 358

group and sort criteria, 358
layout, 356
page break criteria, 358

Outbound Shipment Billing Detail Report, 413
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definition, 413
fields

Buyer, 415
Seller, 415
Shipment No, 415

group and sort criteria, 415
layout, 413
page break criteria, 415

Outbound Shipment Line Billing Detail Report, 415
definition, 415
group and sort criteria, 417
page break criteria, 417

Outbound Shipment Lines Billing Detail Report
fields

Buyer, 417
Prime Line No, 417
Seller, 417
Shipment No, 417
Sub Line No, 417

layout, 415

P
Pack and Hold Shipment Report

fields
Buyer, 386
Expected Ship Date., 386
Number of cases, 386
Number of pallets, 386
Scheduled Dock Door, 386
Seller, 386
Shipment No., 386

Pack And Hold Shipments Report
definition, 382
generating, 382
group and sort criteria, 386
intended audience, 382
page break criteria, 386

Pack and Hold Shipments Report
additional setup required, 386
report criteria, 382
report layout, 384

Pallet Quantity field, 71
Parcel Manifest Report

additional setup required, 391

definition, 387
fields

Basic Freight Charge, 391
Carrier, 391
Charge Currency, 391
Manifest Date, 391
No of Parcels, 391
Special Service Surcharge, 391
Summary, 391
Total for FEDX Ground, 391
Weight, 391
Weight UOM, 391

generating, 387
group and sort criteria, 391
intended audience, 387
page break criteria, 391
report criteria, 387
report layout, 389

Partially Full Location(s) Detail Report, 297
fields

Aisle Number, 299
Bay Number, 299
Location ID, 299
Net Available Volume, 299
Pend In Volume, 299

group and sort criteria, 299
layout, 297
page break criteria, 299

Participant Active As On Date field, 267
Participant Buyer Detail, 272
Participant Detail Report, Buyer, 272

group and sort criteria, 274
page break criteria, 274
Report layout, 272

Participant Detail Report, Buyer fields
Organization Code, 274

Participant Detail Report, Carrier, 278
fields

Organization Code, 278, 280
group and sort criteria, 278, 280
layout, 278
page break criteria, 278, 280

Participant Detail Report, Enterprise, 270
group and sort criteria, 272
layout, 270
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page break criteria, 272
Participant Detail Report, Nodes, 276
Participant Detail Report, Seller, 274

fields
Organization Code, 276

group and sort criteria, 276
layout, 274
page break criteria, 276

Participant Enterprise Detail Report
fields

Organization Code, 272
Participant List Report

additional setup required, 270
definition, 266
fields

Buyers, 269
Carrier, 269
Enterprises, 269
Nodes, 269
Sellers, 269

generating, 266
group and sort criteria, 269
intended audience, 266
page break criteria, 269
Report Criteria, 266
Report layout, 267

Participant Node Detail Report
definition, 276

PC field, 246
PDF (Portable Document Format), 31
Portable Document Format (PDF), 14
PRO No field, 48
Product Class field, 213
Product Line field, 69, 112, 131, 213
Purchase Order (PO), 23
Putaway Cycle Time (Hrs) field, 52

Q
Quantity Discrepancy field, 80
Quantity field, 246

R
Reason Code field, 112

Receipt Date field, 52
Receipt Detail Report

additional setup required, 92
criteria, 87
definition, 87
fields

Buyer, 92
Item Description, 92
Item Id, 92
Order No, 92
PC, 92
Quantity, 92
Receipt Date, 92
Receipt No., 92
Seller, 92
Shipment No, 92
UOM, 92

generating, 87
group and sort criteria, 92
intended audience, 87
layout, 90
page break criteria, 92

Receipt Discrepancy Report
additional setup required, 86
criteria, 77
definition, 77
fields

Actual, 82
Buyer, 82, 84
Discrepancy Type, 82
Expected, 82
Expected Lot No., 84
Expected Serial No., 86
Item Description, 82
Item ID, 82
PC, 82
Receipt Date, 82
Receipt No, 82
Received Lot No., 84
Received Serial No., 86
Seller, 82, 84
UOM, 82

generating, 77
group and sort criteria, 86
intended audience, 77
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layout, 80
page break criteria, 86

Receipt Summary Report
additional setup required, 98
criteria, 93
definition, 93
fields

Buyer, 98
Carrier/Service, 98
Order No, 98
Receipt Date, 98
Receipt No., 98
Seller, 98
Shipment No, 98

generating, 93
group and sort criteria, 98
intended audience, 93
layout, 96
page break criteria, 98

Receiving Node field, 332
Replenishment Status Report

additional setup required, 397
criteria, 392
fields

Capacity Needed, 396
Demand Quantity, 396
Item Description, 396
Item ID, 396
Location Capacity (x), 396
Location ID, 396
Location Size Code, 396
PC, 396
Pend In Quantity, 396
Pend Out Quantity, 396
UOM, 396

generating, 392
group and sort criteria, 397
intended audience, 392
layout, 394
page break criteria, 397

Report creation
adding query items, 613
choosing a template, 613
running report, 613
saving report, 613

specifying package, 612
Report creation rules

adding new reports, 613
report fields

carrier, 315
cartons not having standard qty report

zone, 125
item description, 308
item ID, 308
item id, 432
manifested, 446, 458
No. of containers shipped, 321
packed, 446, 458
picked, 446, 458
product class, 432
quantity allocated, 308
quantity completed, 308
shipment date, 321
Shipment No, 58, 432
Shipment Quantity, 432
shipped, 446, 458
shortage quantity, 432
uom, 432
user name, 469
# of locations, 178
% variance, 133

Report Generation Level field, 104
report layout, 14

Cognos BI Server 8.0
icons, 19

group totals, 18
hyperlinks to drill-down reports, 19
page break criteria, 18
report data, 18
report header, 17
search parameters, 18
summary totals, 18
user information, 17

enterprise user, 17
node user, 17

Report layout component, 612
Report Level field, 37
Report query component, 612
Report Studio

standard reports, 608
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user interface, 611
reports

introduction, 1
Requested Ship Date field, 338
Requested Shipment Date field, 331
Returns By Reason Code Report

additional setup required, 116
criteria, 110
definition, 110
fields

Group Total For Enterprise, 115
Group Total For Return Reason Code, 115
Node, 115
Quantity, 115
Return Reason, 115
Ship Date, 115
Ship From, 115
Shipment No, 115

generating, 110
group and sort criteria, 115
intended audience, 110
layout, 113
page break criteria, 116

S
Same Day Pick Pack Percentage Report

additional setup required, 402
fields

Month, 402
Percentage of Shipments Shipped on Same 

Day, 402
Same Day Pick Pack Ship Percentage Report

definition, 398
generating, 398
group and sort criteria, 402
intended audience, 398
page break criteria, 402
report criteria, 398
report layout, 400

Seller field, 80, 89, 325
Serial No. field, 80
Service Charge field, 500
service item group field, 305
Service Quantity field, 500

Service UOM field, 500
Ship Date field, 112, 405, 454
Shipment Billing Summary Report

additional setup required, 408
criteria, 403
definition, 99, 403
fields

Date, 407
Grand Total, 407
No. of I/B Shipment Lines, 407
No. of I/B Shipments, 407
No of O/B Shipment Lines, 407
No. of O/B Shipments, 407
Node, 407
Total, 407

group and sort criteria, 407
Inbound

generating, 99
intended audience, 99
layout, 405
Outbound

generating, 403
page break criteria, 407

Shipment Billing summary Report
intended audience, 403

Shipment Details Report
fields

Receipt No, 58
Seller, 58
Time Taken for Putaway, 58

group and sort criteria, 58
layout, 56
page break criteria, 58

Shipment Details Report For Putaway beyond 2X 
hrs, 59

Shipment Details Report For Putaway in 2X hrs, 59
Shipment Details Report For Total Shipments, 56
Shipment Fill Rate Monthly Report

additional setup required, 422
criteria, 418
definition, 418
fields

Months Grouped By Enterprise Code, 422
Percentage Of Complete Shipment(s), 422

generating, 418
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group and sort criteria, 422
intended audience, 418
layout, 420
page break criteria, 422

Shipment Fill Rate Report
generating, 433

Shipment Mode
field, 444

Shipment Mode field, 324, 332, 455
Shipment No field, 48
Shipment Shortage Report

additional setup required, 432
definition, 428
fields

Ship Date, 432
generating, 428
group and sort criteria, 432
intended audience, 428
page break criteria, 432
report criteria, 428
report layout, 430

Shipment # field, 89
Shipments Detail Report For Putaway in X hrs, 58
Shipments Near or Past Cancel Date Report

definition, 423
fields

Buyer, 427
cancel dates, 427
Expected Shipment Date, 427
Order No., 427
Shipment No., 427
Shipment Status, 427

generating, 423
group and sort criteria, 427
intended audience, 423
page break criteria, 427
report criteria, 423
report layout, 425

Shipments Near or Past Cancel Dates
additional setup required, 427

Show All Items field, 70
Show field, 70
Show Items in Inventory and PO/Shipment field, 70
Show Items in PO/Shipment field, 70
Show Shipments with Cancel Date in the Past 

field, 425
Sort By field, 435
Space Consolidation Report

additional setup required, 285
criteria, 281
definition, 281
fields

Capacity Utilization, 285
Quantity, 285
Zone ID, 285

generating, 281
group and sort criteria, 285
intended audience, 281
layout, 283
page break criteria, 285

Space Utilization Report
additional setup required, 291
criteria, 286
definition, 286
fields

Location Size Code, 290
Non-Empty Location, 290
Total # of Locations, 290
Total # of Locations Empty, 290
Total # of Locations Full, 290
Total # of Locations Partially Full, 290
Volume Utilization, 290
Zone ID, 290

generating, 286
group and sort criteria, 290
intended audience, 286
layout, 288
page break criteria, 290

Space Utilization Summary Report, 291
fields

Location, 293
group and sort criteria, 293
layout, 291
page break criteria, 293

Staging Locations Report
definition, 433
intended audience, 433

Staging Locations Report, Sort By Location, 435
additional setup required, 437
fields
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No. Of Cases, 437
No. Of Pallets, 437
Seller, 437
Shipment No, 437
Shipment Sort Location ID, 437
Time Since Last Activity, 437
Wave No, 437
% Complete, 437

layout, 435
Staging Locations Report, Sort by Location

group and sort criteria, 437
page break criteria, 437

Staging Locations Report, Sort By Time, 437
additional setup required, 440
fields

Location ID, 440
No of Cases, 440
No of Pallets, 440
Seller, 440
Shipment No, 440
Time Since Last Activity, 440
Wave No, 440
% Complete, 440

group and sort criteria, 440
layout, 438
page break criteria, 440

Standard, 119
Start No Earlier Than field, 304
Starting up Cognos Report Studio, 609
Statistics Date field, 324
Status field, 332
Stock Keeping Unit (SKU), 25, 149
Storage Type field, 71

T
Tag Identifiers field, 225, 244
Tag No field, 224
Tag# field, 243
Task Type field, 189, 485
The Await Material Report, Shipment Details

report layout, 38
The Dedicated Locations Activity Report, Locations 

With Replenishment 1-5
group and sort criteria, 168

page break criteria, 168
The Inbound Shipment Lines Billing Report

definition, 410
The Inventory Aging Detail Report for Inventory 

Aging Less than 1 Month
definition, 180

The Participant Detail Report, Nodes
Report layout, 276

The quantity of items that are in demand
Pend In Quantity, 396

Time Since Last Activity field, 435
Time Slot field, 48
Total # of Shipments field, 106, 108
Trailer No field, 48
Transaction Type field, 188

U
UOM field, 246
User ID field, 188, 473, 479
User Productivity Daily Report

additional setup required, 470
definition, 465
fields

Credited Hrs, 469
Date, 469
Date of Execution, 469
Efficiency (in%), 469
User ID, 469
User ID (s), 469

generating, 465
group and sort criteria, 469
intended audience, 465
page break criteria, 470
report criteria, 465
report layout, 467

User Productivity Monthly Report
additional setup required, 482
definition, 477
fields

Credited hours, 481
Efficiency (in%), 481
Month Begin Date, 481
Month End Date, 481
Year.Month, 481
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generating, 477
group and sort criteria, 481
intended audience, 477
page break criteria, 482
report criteria, 477
report layout, 479

User Productivity Weekly Report
additional setup required, 476
definition, 471
fields

Credited Hours, 475
Efficiency(in%), 475
User Name, 475
Week Begin, 475
Week End, 475
Year.Week of the Year, 475

generating, 471
group and sort criteria, 475
intended audience, 471
page break criteria, 476
report criteria, 471
report layout, 473

Using Cognos 8 BI 8.4 Application, 607
Using Report Studio, 607

V
Value Added Services (VAS), 27
Velocity Code field, 71, 131
Vendor field, 106
Vendor Non-Compliance

intended audience, 100
Vendor Non-Compliance Report

additional setup required, 108
generating, 100
group and sort criteria, 108
page break criteria, 108
report criteria, 100
report layout, 104

Vendor Non-Compliance report
definition, 100

Vendor Non-Compliance Report, carrier
report layout, 106

Vendor Non-Compliance, seller
report layout, 104

W
Warehouse Activity Completion Report

additional setup required, 487, 492
criteria, 483, 488
definition, 483
fields

Number of Tasks, 487
Quantity, 487
Task Type, 487

generating, 483, 488
group and sort criteria, 487, 492
intended audience, 483, 488
layout, 485, 490
page break criteria, 487, 492

Wave No field, 435
Wave No. field, 394
Weight field, 71
Width field, 71
WMS reports, 21

inbound reports, 22
sample, 501

inventory reports, 24
sample, 523

outbound reports, 27
sample, 565

printing, 31
returns reports, 24

sample, 521
task reports, 30

sample, 597
VAS reports, 27

sample, 563
Work Order Report

additional setup required, 308
field

Quantity Completed, 308
fields

Container No., 308
Container Type, 308
Quantity Remaining, 308
Work Order Number, 308
Work Order Status, 308

report criteria, 302
report layout, 306
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Work Order Status field, 305
Work Orders Report

definition, 302
generating, 302
group and sort criteria, 308
intended audience, 302
page break criteria, 308

Y
YANTRA_HOME, xxxii
YANTRA_OLD_HOME, xxxi
YFS_OLD_HOME, xxxii

Z
Zone, 125
Zone field, 121
# of Compliant Shipments field, 106, 108
# of Non Compliant Shipments field, 106, 108
% Compliance field, 106, 108
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